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Introduction
How to Use
This
Manual

The philosophy of this manual is that the best way to learn is through examples.
Almost every chapter in this manual is designed to be used as a standalone tutorial
in its own right. If you want to do so, you can work through each chapter’s tutorial
in turn. This certainly would be the quickest way to learn all the many features of
Family Historian. However, it is not necessary to use the manual in this way. You
can also use it as a reference manual, and look up features on an ad hoc basis.

Quick Start Chapters 1, 2 and 3 are designed to jointly constitute a Quick Start Tutorial for new
Tutorial users, and it is strongly recommended that all new users should work through these
3 chapters at least. It is not necessary to complete all 3 chapters before starting to
use, or experiment with, Family Historian; however, you are strongly advised to at
least have read Chapter 1 before you do so. You will make much quicker progress
if you do.

Printed The manual is a very useful document, both for its tutorials, and for reference
Manual purposes. If you can do so, you are well-advised to print off a copy of it now, and
keep the printed copy available for easy reference.

GEDCOM Occasionally in this document you will find references to GEDCOM. This is the
name of the world-wide standard for sharing genealogical data. When you send or
receive genealogical data from other people, using a computer, the most common
way of doing this is to transfer the data in the form of a GEDCOM file – that is, a
file in the GEDCOM format. Family Historian was designed from the ground up to
be 100% GEDCOM-compatible, and 100% GEDCOM-complete – that is, it can
load all GEDCOM (5.5) fields and can save all of its data to the GEDCOM format.
In fact, Family Historian uses GEDCOM as its own ‘native’ file format. So unlike
other applications, you do not have to convert Family Historian files to the
GEDCOM format. They already are in the GEDCOM format.

Transferring Data
into Family
Historian

To transfer data into Family Historian from another program you should look for an
‘export’ facility in your other program which allows you to export your data as a
GEDCOM file (use version 5.5 if given a choice). Make a note of the name and
location of the exported file. Then start Family Historian and open this file using
the Open command on the File menu. You do not have to ‘import’ it because, as
just mentioned, Family Historian uses GEDCOM 5.5 as its own file format.
If you want to merge the data into an existing file, use the Merge/Compare
command on the File menu (see Chapter 13).

Pre-cooked
Tutorial
Files

Some readers of this document will be experienced and confident users of Windows
applications. For such users, the manual may provide more detail than they need. If
you feel that this applies to you, you should skip lightly over sections that seem
obvious, and not slavishly follow the examples. Each chapter makes use of files
created in earlier chapters. However, ‘pre-cooked’ versions of these files were
included in the installation. They can be opened from within Family Historian by
clicking on the Help menu, and then “Tutorial Files (referred to in the manual)”.
Users who don’t want to work through the examples themselves, are encouraged to
make use of these files, so they don’t have to.

The
Tutorial
Files
Folder

The “Tutorial Files” folder is the folder which stores the ‘pre-cooked’ tutorial files,
together with pictures and other multimedia files that they use. If you need to locate
this it is located within the “Shared Documents” area of your computer. The
“Shared Documents” folder is located within the “My Computer” folder. Once you
have found “Shared Documents” look within that folder for the “Calico Pie” folder,
and within that for the “Family Historian” folder. The “Tutorial Files” folder that
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you need is located within this “Family Historian” folder.

Online Do not forget to use the Online Help. Pressing F1 will usually produce help which
Help is relevant to the current context, if there isn’t a Help button available. The Online
Help is often the best place to go for detailed help – for example, if you want to
know what a particular field in a dialog box is used for. But it also contains more
general information and tips, some of which is not available in the User Manual.

The Online Help has a contents page, an index and a search facility, all of which
can be reached by clicking on Contents and Index, in Family Historian’s Help
menu. You can also browse its contents, by clicking the browse buttons (‘>>’ and
‘<<’), which are available at the top of each page of the Online Help.

Basic Although aimed primarily at the relatively inexperienced Windows user, this
Windows document does assume a working knowledge of Windows, such as how to how to
move and resize a window, how to use menus, what a dialog box is, etc.
Skills
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Dialog
This step presupposes that you have...
Read the Introduction

You will learn how to...
Create a new Family Historian file
Create new records for individuals and enter details about them
Identify the Records Window
Use the Property Dialog to create family relationships
Use the Property Dialog to ‘navigate’ from one Individual to another

Figure 1 – Relatives of Cameron Peabody

Preamble Throughout this manual, techniques are illustrated by use of examples. The
examples all involve a fictitious person, Cameron Peabody, and his equally
fictitious relatives. A description of Cameron Peabody and his relations can be
found in Appendix A at the end of this document. The Individuals and relationships
that we will enter in this chapter, are shown in Figure 1 above.
There are usually several ways of doing the same thing in Family Historian, and
later you will learn different and sometimes better ways of doing many of the things
you will do in this chapter. But they build on, and require an understanding of the
techniques you will learn in this chapter.
We will start by entering details for Cameron Peabody, and work outwards to his
various relatives. However, that is only because you have to start somewhere. We
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could equally well start from any of the individuals shown above, and work
outwards from them. The results would be no different.

Start a new
Family
Historian
File

Usually you will start each Family Historian session by loading an existing file. But
we are starting from scratch, so we will start this session by creating a brand new
one. If you are not already in a New state (the empty-file state that you start each
Family Historian session in), you should switch to the New state now.
Steps
1.

From the File menu, click on New.

If you had made unsaved changes to another file, you will be asked if you want to
save them.

Maximize
the Family
Historian
Window

You don’t have to do this of course; but it will help you to see what is going on if
you make the main Family Historian window as large as possible before you start
doing anything else. If the Family Historian window is not already maximised, do
the following:
Steps
1.
2.

Locate the caption for the main Family Historian window. The text in the
caption should begin “Family Historian…”.
Click on the Maximize button
- the middle button of 3 at the right-hand end
of the title bar. The middle button will look like this
already maximized.

Create a
New
Individual
Record

if the window is

We will now create a record for Cameron Peabody.
When entering names genealogists traditionally enter surnames in CAPITALS. You
can do this if you wish, but our recommendation would be that you enter them in
Mixed Case. That way you will have recorded not only the letters of the surname,
but also how it is capitalised, which may not always be obvious (e.g. McCracken).
However you have entered them, you can always opt to display surnames in capitals
in reports and diagrams (this is an option on the Preferences dialog). In any case,
we would strongly recommend that names other than surnames should be entered in
Mixed Case.
Steps
1.

2.

From the Insert menu, click on New Individual. When you do this, a new
Individual record is created and the Property Dialog appears, to allow you to
fill in details for it. The Property Dialog caption reads: “Individual: <no
name> [1]”. The Property Dialog always appears in front of other Family
Historian windows.
Type “Cameron Peabody” in the Name field of the Property Dialog, and press
the Tab key. The text changes to “Cameron /Peabody/”. The slashes indicate
that Family Historian has identified ‘Peabody’ as the surname. The Property
Dialog should now look like Figure 2 below.

You might think that you will use the New Individual command whenever you
create a new record. That is not the case. You will usually only use this method to
create a new record, if the record is for someone who doesn’t already have any
relations in the file. Ordinarily, when you create new records for individuals, you
will do so by adding them as parents, children or spouses of individuals for whom
you already have records.
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Figure 2 – The Property
Dialog after typing
Cameron Peabody’s
name.

The
Property
Dialog

Notice that the Property Dialog has multiple tabs1. The current tab in the Property
Dialog is the Main tab. The appearance of the Property Dialog will vary
depending on the record type that it is displaying. At present it is displaying details
of Cameron Peabody’s record, which is an Individual type of record. This is why
the caption reads “Individual: Cameron Peabody” [1].

How To
Open the
Property
Dialog

You can close the Property Dialog at any time by clicking on its Close button in the
top-right hand corner. If you do that, you can re-open it again at any time, to show
the details of Cameron Peabody’s record, by double-clicking on the name “Cameron
Peabody” in the main application window. This text is right next to a little icon
which looks like this: . Alternatively, you can click on the name once and then
click on the Property Dialog button
does the same thing.

The
Records
Window

on the main application toolbar. This

For interest, the window behind the Property Dialog – the one you double-clicked in
(if you did) – is the Records Window. It contains one entry for each record in your
file. We will be looking in more detail at the Records Window in chapter 2. For
now, you may like to keep an eye on it as you follow the instructions in this chapter.
Every time you create a new record (and you will create 10 in this chapter alone),
you should see a new entry appearing in the Records Window.
Tip: If you wish to move the Property Dialog at any time to view the Records
Window, click-and-drag on the Property Dialog’s title bar.
Tip: If you accidentally make the Property Dialog smaller, and want to know how

1

The term 'tab' is used throughout this tutorial for 2 quite different things. You will frequently see it
used to refer to Tab key – a key on the keyboard, usually positioned just above the Caps Lock key. In
this usage, Tab is written with a Capital and emphasized in bold. The other use of the term is to refer
to a tab in a tabbed dialog box, or tabbed window – such as the Records Window. When used in the
latter sense, tab is spelled in lower-case, and is not in bold.
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to get it back the way it was, see the section Small & Large Mode, later in this
chapter.

Sex and We will now enter a few details about Cameron Peabody.
Birth
Steps
1.
2.

3.

4.

Select Male for Sex, or tab onto the Sex field and press the M key (lower-case
is fine) followed by the Tab key
Leave Occupation blank. A general rule is: if you don’t know what to put in a
field, or if it doesn’t seem appropriate, just leave it blank. There are no
mandatory fields in Family Historian records (except that if you want someone
to be a spouse or a parent, you will be required to specify their sex).
In the Born field, enter the date as “3 jan 1901”. Press Tab. You should see
that whichever case you used for ‘jan’ (upper, lower or a mixture), it will now
display as “3 Jan 1901” (without the quotes). This shows that Family Historian
has recognised the date. See the panel below “How to Enter Simple Dates” for
tips on entering dates.
The In field next to the Born field stores the birth place. Enter “Sevenoaks,
England” in this field and press Tab.

How to Enter Simple Dates
To enter a date into a date field, type the day, followed by at least 3 characters of the month name,
followed by the year. For example:
3 jul 1989
Always use 4 digits for years. “3 jul 89”, for Family Historian, would be a date in the year 0089 A.D.
In the U.S. (if your PC is set up to use standard U.S. date settings) you could alternatively enter this as:
7/3/1989
In the U.K., (assuming you have standard U.K. date settings) you could enter it as:
3/7/1989
When you press the Tab key, the text should change to 3 Jul 1989. If it doesn’t, the regional settings in
the Windows Control Panel for your PC are probably incorrectly set. In that case, you could either
correct them or, if you don’t wish to do that, you might prefer to stick to the “3 jul 1989” style - as this
works everywhere in the world.
Try entering a date as “3 jult 1989”. If Family Historian doesn’t recognise a date, it will put double
quotation marks around it, but otherwise leave the text exactly as it is. If this happens, you should reenter the date correctly. Family Historian can do many things with dates - such as sorting lists using
them, or calculating ages based on them; but it can only do these things if it recognises the date.

Add In the bottom half of the Property Dialog, in the left margin, there are 3 labels on
Spouse their side: ‘Children’ , ‘Marr.’ And ‘Spouse’. The fields opposite the ‘Spouse’ label
are called the Spouse fields. The fields opposite the ‘Marr.’ label are the Marriage
fields. The Children fields of course hold information about children. Initially all of
these fields are grey because Cameron, as yet, has no spouses and no children. You
will enter details for them now.
Maiden names should always be used for women. Married names can be recorded
later, if desired (see Chapter 6).
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Steps
1.

2.

The Spouse Name field shows the text <click here to add spouse> in dark grey
text on a light grey background. Click on the text. From the menu that
appears, click on Create New Record as Spouse. You should now have 2 tabs
in the spouse area of the Property Dialog, the first of which is labelled “<no
name>”.
In the Spouse Name field (no longer grey) enter “Sarah Marie Watts” and press
Tab (the text changes to “Sarah Marie /Watts/” and the first tab is now labelled
‘Sarah’).

If you look at the Records Window, you will see that a second record has been
added to the list of Individual records. This record was created when you clicked on
Create New Record as Spouse. When you set the Spouse Name field to “Sarah
Marie Watts” you were setting the name of the Individual in this new record.
The fields displayed in the Property Dialog do not necessarily come from just one
record. Although it does in the first instance show details of a given record, it can
and does also show details of linked records too – such as the details of a person’s
spouses or children, all of which will have records of their own.
Notice that you could perfectly well have created the record for Sarah Marie Watts
first, and then added Cameron Peabody as her spouse, rather than vice versa. It
doesn’t matter which order you do things in.

Spouse If you look back to Figure 2, you will see that previously there was only one tab in
Tabs the spouse area of the Property Dialog, and it had no label. Now there are two. The
first has label ‘Sarah’, and the second is blank.

There is always one Spouse tab for each spouse and/or family of the Individual
displayed in the Property Dialog, plus one blank one. The blank one is there so
that you can always create more spouses/families whenever you want to.

More
Spouse
and
Marriage
Details

Now enter more details for Sarah Watts and her marriage to Cameron.
Steps
1.
2.
3.
4.

In the Spouse Born field enter “12 dec 1907” and press Tab.
In the Spouse in field enter “Durban, South Africa” and press Tab.
In the Spouse Died field enter “1935”. In the Marr. Married field enter “4 jul
1926” and press Tab.
In the Marr. in box enter “Cape Town, South Africa”.

Two Note If you look carefully you will find that there are two Note fields in the Property
Fields Dialog. The first Note field is used to store a note that is about Cameron Peabody.
The second Note field is a Marriage field. Any note entered here applies not to
either Cameron or Sarah as such – rather it is the place to enter a note about their
marriage.

If you wish, you can optionally have a 3rd Note field displayed, instead of the
Spouse’s Place of Death. See the relevant option in the “Property Dialog” section
of Preferences, on the Tools menu.

Add Cameron and Sarah had 2 children, Amanda and Ian. We will enter details for them
Children now.
Steps
1.

The first child field has <Click here to add child> in dark grey text on a light
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2.

3.
4.

grey background. Click on the text. From the menu that appears, click on
Create New Record as Child.
The first child Name field should now have “/Peabody/” in it. This is because
the father’s surname has been added by default (unless you switched this option
off). Add “Amanda” before the surname and press Tab. Don’t worry about
adding a space before the slash character. Family Historian will do that.
Type F in the Sex field and press Tab.
In the next row down, create another new record as child. Set the name to “Ian
/Peabody/” and type M in the Sex field.

You should now see 4 records listed in the Records Window.

Add 2nd So far Cameron Peabody only has one spouse. And yet there are 2 tabs in the
Spouse spouse area of the dialog. This is because there is always one spare, a blank one,
which is available for you to use to create another spouse.
and Child
Steps
1.
2.
3.
4.
5.
6.
7.

Click on the blank spouse tab now. The Spouse, Marr. and Children fields
should now all turn grey.
Click on <click here to add spouse> in the Spouse Name field, and select
Create New Record as Spouse from the menu.
Enter “Jean Clare Anderson”. Press Tab. There should by now be 3 spouse
tabs, the second of which (the current tab) is labelled ‘Jean’.
Enter “June 1917” in the Spouse Born field (or “Jun 1917” if you prefer).
Press Tab.
Click on <click here to add child> in the first child Name field, and select
Create New Record as Child from the menu.
Set the first child Name field to “Daniel Anderson /Peabody/”.
Type M in the first child Sex field.

You should now see 6 Individual records listed in the Records Window. The
Property Dialog should look like Figure 3 below. Click on each of the Spouse tabs
in turn, and confirm for yourself that the Property Dialog not only shows which
spouses Cameron had and which children, but which children he had by which
spouse, as well as other marriage details. Remember that the 3rd blank spouse tab is
there in case you ever wanted to add another spouse or family for Cameron.

Go To
Buttons in
the
Property
Dialog

To the right of Cameron Peabody’s name in the Property Dialog is the Go To
Parents button
. If Cameron had a father or a mother, pressing this
button would switch the Property Dialog to showing their details.
To the right of the Spouse Name field is a Go To Spouse button
. Clicking on
this button switches the Property Dialog to showing the record details for the
person currently displayed as spouse. If you did this when showing Jean Clare
Anderson as the spouse, as in Figure 3 below, the Property Dialog would switch to
showing her record details instead of Cameron Peabody’s. However, given that
Cameron Peabody is the spouse of Jean Clare Anderson (the only spouse that we
have recorded for her), if the Property Dialog is showing her details, he will appear
as spouse in the spouse area. Effectively, then, the Go To Spouse button can be
used as a simple toggle, to switch the spouses. If you press it twice, you will always
return to where you were when you started. Try this now.
As well as Go To Parents and Go To Spouse buttons, there are also Go To Child
buttons. These look exactly like the Go To Spouse button (i.e. like this:
).
Make sure that the Property Dialog is displaying Cameron Peabody’s record details,
and click on his first Spouse tab (labelled ‘Sarah’). Notice that at the end of each of
the children rows there is a Go To Child button. Click now on the Go To Child
button at the end of Ian Peabody’s row. The Property Dialog switches to show Ian
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Peabody’s record details. Its caption now reads: “Individual: Ian Peabody”. Now
click on the Go To Parents button
and confirm that this returns you to
showing Cameron Peabody’s record details. Finally, click once again on Ian
Peabody’s Go To Child button.

Figure 3
The Property Dialog after
adding Cameron’s
spouses and children. At
this point we are viewing
Cameron’s family (one
child) by his second
spouse, Jean Clare
Anderson.

Add In Family Historian, in common with almost all other genealogy programs, there is
Grandchild no facility to add grandchildren as such. There is no need for it. All relationships

effectively reduce to combinations of parent-child and spouse-spouse relationships.
So you don’t enter a grandchild for Cameron as such. You enter a child for one of
his children.
Cameron’s son Ian had a girlfriend (who he never married, but who we will treat as
a ‘spouse’), Fiona Andrews. Ian and Fiona had one son, Thomas. To enter this
information, we just need to view Ian Peabody’s record details in the Property
Dialog. We already know how to add spouses and children in the Property Dialog.

We already know how to view Ian Peabody’s record in the Property Dialog. You
could, for example, select Ian Peabody’s record in the Records Window, and click
on the Property Dialog button
on the main application toolbar. In Family
Historian there are usually several different ways of doing the same thing.

Add
Spouse &
Child

You should now be looking at Ian Peabody’s record in the Property Dialog.
Steps
1.

Click on ‘<click here to add spouse>‘ in the Spouse Name field, and then select
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2.

Create New Record As Spouse. Enter the spouse’s name as ‘Fiona Andrews’.
In the first Child Name field, click on ‘<click here to add child>‘ and select
Create New Record As Child from the menu that appears. Enter the child’s
name as ‘Thomas Peabody. Press Tab. Enter his sex as Male (type ‘M’ in the
Sex field and press Tab).

Unmarried In Family Historian, where you see 2 people listed as Husband and Wife, you should
Couples not interpret this to mean that they are necessarily married. It means either that they
are or were in some sense a couple (they may be married, but they don’t have to be);
or that they have had a child together – and this, of course, can happen without the
parents ever having had a ‘relationship’ as such. There is no single term that covers
these cases; so we use Husband and Wife as a convenient short-hand.
You can indicate that a couple are not married (or are divorced or separated) by
setting the appropriate value in the Status field of the Main tab of the Property
Dialog. If a couple are married (the default) this field should be left blank.

Add Parent We will now add Cameron’s mother: Naomi Prentice Salt (the surname being
‘Prentice Salt’).
Steps
1.

Select Cameron Peabody in the Records Window and click on the Property
Dialog button

2.

3.

4.

on the main application toolbar.

To the right of the main Name field is the Go To Parents button
.
Click it now. The whole dialog becomes grey, except that the first child field
now shows “Cameron Peabody” and his sex and date of birth. If Cameron had
had any parents they would be displayed in the top area of the dialog, and in the
spouse area. As he doesn’t, these areas are both grey.
The main Name field now shows <click here to add parent>. Click on the
text and select Create New Record as Parent from the menu. A dialog box
appears asking you to indicate the sex of the new parent. Click on the ‘Female’
button.
Enter “Naomi /Prentice Salt/” in the main Name field at the top of the dialog.
Notice the slash characters. If not specified, Family Historian will put them in
automatically, but will always assume that the last word is the surname. As that
is not the case here, you must put the slashes in the right place yourself.

Add Finally, we will add Adam Wiley who is the son of Amanda Peabody – Cameron’s
Spouse daughter by Sarah Watts.
and Child Steps
(again)
1.
2.
3.

Cameron Peabody should be listed as a child in the Property Dialog. Click on
the Go To Child button next to his entry.
Amanda Peabody should be listed as a child under the ‘Sarah’ spouse tab.
Click on the Go To Child button next to her entry.
The Spouse and Child areas of the Property Dialog should be grey at this
point. In the first Child Name field, click on ‘<click here to add child>‘ and
select Create New Record As Child from the menu that appears. Enter the
child’s name as ‘Adam Wiley’. Press Tab. Enter his sex as Male (type ‘M’ in
the Sex field and press Tab).
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Save Although Family Historian has by now created 10 records for you, it has not yet
Changes saved the details of any of these new records to a file on your hard disk. If there

was a power failure now, and your computer crashed, your new data would be lost.
Changes are not automatically saved to your hard disk as you make them. You save
them when you save the file, by clicking on Save or Save As on the File menu, or

by clicking on the Save toolbar button
. Up to now, nothing you have done has
been saved to your hard disk. We will save it all now as a new file.
Steps
1.
2.

From the File menu, click on Save (or click on the Save button on the toolbar).
In the File Save As dialog, find a good place to save your work (it would be
good practice to create a new folder somewhere to keep your tutorial work),
give your file the name “Tutorial – Chapter 1” and press OK.

The file you have saved is a GEDCOM file. If your PC is configured to show file
extensions, you will find that its full name is “Tutorial – Chapter 1.ged”.
Tip: If you would like Family Historian to automatically save changes for you every
few minutes, use the Auto-save feature in Preferences.

More
Features of
the
Property
Dialog
Use the
Tab Key
When
Entering
Text

We have now covered the basic features of the Property Dialog, but there are a few
more issues to do with the Property Dialog that are worth getting clear before we
move on to the next chapter. One question people sometimes ask when they
encounter the Property Dialog for the first time is: where is the OK button?

When you enter or change information in the Property Dialog, you don’t need to
click on an OK button to ‘register’ the data you have entered. With Family
Historian, the new data is accepted and the appropriate record is updated, as soon as
the cursor leaves the field in which you typed the data. The recommended
technique is to press the Tab key when you have finished with a given field, to
move the cursor to the next field. You don’t have to. If you click anywhere else,
your changes will still be recorded. However, if you press the Tab key, Family
Historian will validate the data you enter and warn you if it appears to contain
invalid or unlikely data. It won’t do this if you just click elsewhere. So there is an
advantage in pressing the Tab key and it is worth getting into the habit of doing it
that way.
Remember that the changes you make are not stored on your hard disk, until you
save them (see Save Changes above).

You never
have to
close the
Property
Dialog

You may be used to dialog boxes where you have to close the dialog box (usually by
pressing OK or Cancel) before you can do anything else. Family Historian has
many dialog boxes which are like that. The Property Dialog however is not one of
them. You never have to close the Property Dialog. You can leave it open all the
time if you want to. It is designed to be used in conjunction with, and in cooperation with, the other windows of the application. Anything you can do when the
Property Dialog is closed, can also be done when it is open. If it is in the way, you
can switch it to Small Mode (see below), or move it out of the way. Of course, if it’s
in the way and you’re not actually using it, at any given moment, there’s no reason
not to close it.
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View
Record in
the
Property
Dialog

How do you get the Property Dialog back if you close it? To see this, close the
Property Dialog now by clicking on the Close button
at the right-hand end of
its title bar.
Steps
1.

2.

3.

At this point, you should be looking at the Records Window. If you weren’t,
however, you could just follow the instructions in The Records Window section
above, to bring it into view. Make sure that the correct tab is selected
(Individuals in this case).
Now locate the record you wish to view. Any one will do. The way you select
a record in the Records Window is by clicking on the actual text of the record
name, in the first column, so that it shows in inverse video. This text is right
next to a little icon which looks like this: . Each type of record has its own
distinctive icon. This icon represents the Individual record type. It’s supposed
to look a bit like an identity card.
Now click on the Property Dialog button
The Property Dialog opens again.

on the main application toolbar.

Small & The Property Dialog can be compacted to a small size, so that it takes up less space.
Large To switch it to Small Mode, click on the Small/Large Mode button
(it’s
Mode supposed to look like a blind). The dialog becomes smaller and the Small/Large
Property Dialog
Toolbar

Mode button now looks like this
. Click this button a few times and observe the
results. The Property Dialog switches back and forth between Small Mode and
Large Mode. Finish by leaving it in Large Mode.

Pinned & As well as Large and Small Mode, the Property Dialog also can also be Pinned or
Unpinned Unpinned. The second button from the right on the Property Dialog toolbar is
Mode called the Pin. If the Property Dialog is Pinned, the Pin looks like this: . In this
state, the Property Dialog always displays whichever record is currently selected in
the Records Window (or, as we will see later, in other Family Historian windows ).
Property Dialog
Toolbar

In Unpinned Mode the pin looks like this:
, and the Property Dialog is not
governed by the selection elsewhere. Some actions (such as pressing a Go To
button) will automatically cause the Property Dialog to become unpinned.
What would you expect to happen if there was no selection when you clicked on the
pin to switch the Property Dialog to Pinned Mode? Try it. You should see that it
clears itself immediately and displays the “No record selection” message. This can
sometimes come as a surprise to new users.

Online
Help for
the
Property
Dialog

At any time when viewing the Property Dialog, press the F1 key to get Help relating
to the particular tab you are currently viewing. Alternatively, you can also click on
the ? button on the title bar. When you do this, the cursor changes to show a
question mark next to the pointer. When this happens, click anywhere on the
current tab of the Property Dialog to open a window showing online help about it.
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the Records Window
This step presupposes that you have...
Read the Introduction and Chapter 1

You will learn how to...
Sort records in the Records Window
Manage windows within Family Historian
Use the Navigation Bar
Browse records by ‘expanding branches’ in the Records Window
View an entire record at a glance
View linked records nested within other records
Find records in the Records Window
Select and Delete records
Record that a child is adopted, step or fostered
Use low-level editing techniques to Edit, Add and Delete fields
Remove incorrect relationships by ‘unlinking’
Use many of the above techniques in the All tab of the Property Dialog

Preamble This chapter introduces new features of the Records Window, and shows you how
to browse and search the file you created in the last chapter. It also introduces some
low-level techniques for editing records in the Records Window. These techniques
are also applicable to the All tab of the Property Dialog.

Open a File This chapter uses, but does not alter, the file saved at the end of chapter 1. If you

skipped chapter 1, or read it but didn’t create your own file, use the ‘pre-cooked’
version (see “Tutorial Files (referred to in the manual)” on the Help menu).
Steps
1.

From the File menu, click on Open (or click on the Open button on the
toolbar). Locate the appropriate file. Press OK.

The We briefly encountered the Records Window in Chapter 1. This time we need to
Records identify it more precisely.
Window If the Property Dialog is in front of the main application window, move it to one
side (by clicking-and-dragging on its title bar) or close it (by clicking on its Close
button in its top right hand corner).
The application window should look roughly like either Figure 4 or Figure 5 below.
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Figure 4 – The Records Window not maximized

“MDI Child
Window”:
a windowwithin-awindow

The Records Window is what Microsoft calls an MDI Child Window. An MDI
child window is a kind of ‘window-within-a-window’. It has (when not maximized)
a title bar of its own, just like an ordinary window. If you click-and-drag on its title
bar you can move it around within the outer (or ‘frame’) window; but you can never
drag it outside the frame window2.
In this particular case, the Records Window’s caption is “Records”, and it contains 3
tabs: Individuals, Notes and Sources.
The frame window is the window for the program as a whole. It also has a title bar.
Its caption is “Family Historian - Tutorial - Chapter 1.GED”.

Maximize
the
Records
Window

Notice that both the frame window and the Records Window have Minimize,
Maximize and Close buttons
at the right end of their respective title bars.
If you click the Maximize button (the middle one) for the frame window it will
maximize the frame window within the screen. If you click the Maximize button
for an MDI child window, it will maximize the child window within the frame
window. If you do this with the Records Window it will look like Figure 5 below.
If your Records Window is not already maximized, click its Maximize button to
maximize it now.
Tip: A quick alternative way to maximize a window is to double-click on its title bar.
This only works for windows that have a maximize button though.

2

This is not true of the Property Dialog, incidentally, which is not an MDI child window. You can
drag that anywhere.

14

Chapter 2 – Browsing, Searching & Editing with the Records Window

Figure 5 – the Records Window again, this time maximized to fill the outer frame

Restore
the
Records
Window

At first glance it might appear that the Records Window has disappeared in Figure
5. But actually it hasn’t. It has temporarily become fused with the frame window.
When an MDI child window is maximized within its frame window, its title bar
disappears and the title of the MDI child window is merged with the title of the
frame window. Its 3 title bar buttons (Minimize, Maximize and Close) have not
disappeared. The Maximize button has become a Restore button looking like this:
(that always happens when any window is maximized); and all 3 buttons have
become smaller though, and are now tucked in just below the Minimize, Maximize
and Close buttons for the frame window. The 2 sets of buttons look like this:

The top row of 3 buttons in this image are the Minimize, Maximize and Close
button for the frame window. The bottom row of 3 smaller buttons are the
Minimize, Restore and Close buttons for the MDI child window – in this case the
Records Window.
If you click the Restore button on a maximized window it will restore the window to
its previous ‘un-maximized’ state. Do this now with the Records Window so that it
looks once again as it appears in Figure 4. Remember that it is the middle button on
the 2nd row that you need to click on.
Now practice maximizing and restoring the Records Window a few times, so that
you remember how to do it. Understanding how to do this will come in handy when
we introduce more MDI Child Windows later on.
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Records
Window
Navigation
Bar Icon

Family Historian has 5 different types of MDI child windows, and with most of
them (but not the Records Window) you can have several different instances of the
same window type open at the same time. You can see which MDI Child Windows
you have open at any given time because each window has an icon in the
Navigation Bar – the grey strip down the left hand side of the outer window.
Each type of MDI child window has its own distinctive icon. The Record Window
icon is shown here, on the left. To access it, just click on its icon in the Navigation
Bar (or click on the Records Window button

on the main application toolbar).

Tip: If you can’t see the Navigation Bar, clicking on the Navigation Bar button
on the application toolbar will alternately show or hide it.

You Can’t
Close the
Records
Window

Unlike all other MDI Child Windows you can never close the Records Window.
You never need to close it. Try clicking on its close button - you will be told that
you cannot close the Records Window. But it can become hidden behind other MDI
child windows (especially if another MDI child window has been maximized). If
you want to bring the Records Window to the front, click on its icon in the
Navigation bar, or click on the Records Window button on the toolbar.

The
Individuals
Tab

Make sure that you are viewing the Individuals tab of the Records Window now.
Within the Individuals tab, the Record Window displays all the records for
individuals in the file. Each Individual record has a little picture (called an icon)
next to it: . This icon was mentioned in Chapter 1. It is supposed to resemble an
identity card. Wherever you see this icon, it always represents an Individual record.

Columns in
the
Individuals
Tab

There should be 10 records in the Individuals tab of the Records Window (there
should be a pane with the text ‘Individuals: 10’ in the status bar). The rows are
divided into 5 columns: Individual Record, Record Id, Dates, Birth Place and
Updated. As you will see later, different record types (in different tabs of the
Records Window) will have different columns. But they all have Record Id and
Updated.
Each record is assigned a unique id by Family Historian. Dates shows the dates of
birth and death, if known, or possibly other dates if not. Updated shows the date
and time at which the record was last updated.
Tip: You can configure the columns in the Records Window to show whatever you
want. Right-click on any column heading and select Configure Columns from the
menu that appears.

Sort Click on any column heading to sort the records in the order of that column. If you
Records click on the first column, records will be sorted alphabetically. If you click on Birth
Place, they will be sorted by place of birth (records with no place of birth will come
first; so you may need to scroll down, if you are working with a large file, to see the
effect of this). If you click on Updated, records will be sorted in update order –
with the most recently-updated records first.

If you press the Alt key while clicking on a column heading, the records will be
sorted in reverse order.
Clicking on Dates will sort the records by date-of-birth. If a date-of-death has been
supplied, but no date-of-birth, Family Historian will estimate the date-of-birth as 50
years earlier than the date-of-death; however, this value can be changed in the
Preferences dialog (available from the Tools menu) if you wish.
Tip: Enter all or part of a name (surname, first name) in the Name field at the top of
the Record Window as a fast way of searching for the first record that matches the
entered data. Press F3 to find other matches. Alternatively, if you know the record
id, enter that in the Record Id field.
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Browse
Records by
Expanding
Branches

When you enter data in the Property Dialog, the data is actually stored by Family
Historian in a hierarchical field structure. You can browse this field structure in the
Records Window in the same kind of way that you browse files and folders using
Windows Explorer3.
If the records are not sorted alphabetically, sort them now by clicking on the
Individual Records column heading. The first record entry should read: “Anderson,
Jean Clare”. The next should be “Andrews, Fiona”. Each record has an expansion
, similar to those in Windows Explorer, which you can click on
button next to it
to show or hide details. Click on the expansion button for Cameron Peabody’s
record now. You should be able to see 6 rows of record details for Cameron
Peabody. The 3rd line of Cameron Peabody’s record should say “Born 3 January,
1901 in Sevenoaks, England”, and it too should have an expansion button. Click on
this now. You should see 2 further lines, showing the date and place (of his birth)
as separate items.
You can expand an entire ‘branch’ in one go by double-clicking on the text.
Double-click again to hide the branch. The significant advantage of this is that it
means you can see at a glance, all the information you have in a given record.

Individual
Records
and Family
Records

Now expand Amanda Peabody’s record. Her record shows that her parent’s family
is the family ‘... of Cameron Peabody and Sarah Marie Watts’. There is a little icon
next to the text:
(its supposed to look a bit like a family tree diagram). This
represents a Family record, just as the identity card icon
represents an Individual
record. You may be a bit confused by this. Where did these family records come
from? And where are they kept?
The answer to the first question is that the Family records were created for you by
Family Historian. Family records are used to record family relationships between
Individuals (primarily).
The question about where a record is, is always a moot one in any computer
program. Suffice it to say that they can be displayed in the Records Window
exactly like Individual records, in a separate Family tab of their own. But right now
the Family tab is hidden (unless you have already changed your Records Window
options to show it).
In general, you rarely have to do anything very much with family records. If they
are needed, they will be created for you. It doesn’t hurt to understand that they are
there though.

View Back to Amanda’s record. Next to the family record icon for the family ‘...of
Linked Cameron Peabody and Sarah Marie Watts’ is an empty white box called the
Records View Linked Record box. Click in the View Linked Record box now.
When you do this, the View Linked Record box becomes checked, and the Records
Window expands to show you the details of Amanda’s parents’ Family record,
‘nested’ within the context of her own Individual record, as though her parents’
Family record were part of her own Individual record. Amanda’s father, mother and
brother are listed, as well as Amanda herself. Notice that they all have the
Individual icon
next to their names to show that they represent Individual
records. Amanda’s entry is in grey, both as a reminder that it is her parents’ family
that you are looking at, and to make it easy to see where she fits in.
To look at Amanda’s father’s (i.e. Cameron’s) Individual record, click on the View
3

Windows Explorer is a standard accessory program that comes with all versions of Windows. It is a
powerful and very useful tool for exploring, and working with, all the files and folders on your
computer.
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Linked Record box next to his name. Now the Records Window expands again.
This time it shows Amanda’s father nested in the context of his Family record
(which, in turn, is nested within the context of Amanda’s Individual record). Click
the box again to hide Cameron’s details.
You can keep on expanding records within records in this way, indefinitely.

Go To Although it is useful to be able to see one record nested within another, it gets
Record confusing if you nest them too deeply. Rather than viewing Cameron’s record in

the context of Amanda’s record, you might prefer to view it on its own. Almost
always, when you can see a reference to a record, you can jump straight to that
record’s main entry in the Records Window – each record has one. For example:
Steps
1.

Within Amanda’s parents family record, click on the text ‘Cameron
PEABODY’, next to the Individual Record icon
now.

2.

Click on the Go to Record button
on the toolbar. The record for
Cameron Peabody is located and selected.

When the list of records is short, there is little benefit in this. However, with a long
list it becomes a much more useful feature.
If you select a record in its ‘main entry’ location (i.e. not nested within another
record) and click on Go to Record, don’t be surprised that nothing happens. You
are trying to get to the place you have already reached!

Find In the previous example, you had already found a link to a record and wanted to go
Record straight to it. But frequently you will want to find a record without having

previously found any references to it. If you know the name of the record, one
option is to sort the records in alphabetical order (if they aren’t already in
alphabetical order) and scroll to find it – or type the name into the Name field at the
top of the window (surname first). If you know the record id, you could enter that
in the Record Id field. However, you may not know the record id, and may only
know part of the name. In this example, we will search for the record for Naomi
Prentice Salt:
Steps
1.
2.
3.
4.

Click on the Find Record button on the toolbar:
. The Find Dialog
appears.
Confirm that the Record Type is the default value: ‘Individuals’, and that the
Search Type is the default value: ‘Name/Title Search’.
In the Search For field, type ‘Naomi Prentice Salt’. Press Find First. The
record for Naomi Prentice Salt is located and selected.
Now press Find Next. The message ‘End of file reached’ is displayed to show
that there aren’t any other matches.

You don’t have to type a full name. If you typed ‘Naomi’ on its own, this would
have worked equally well, because there is only one record containing the name
Naomi. If you typed ‘Sal’ on its own, this would find any record that contained
‘Sal’ as part of the name; so all the Prentice Salts would have been found.
The order of the names does not matter. ‘Pren Salt’ and ‘Salt Pren’ will both match
all the Prentice Salts.
Tip: If you want to search for a particular surname, put it between slash characters.
For example, the search text “/Anderson/” will match Jean Clare Anderson’s
record, but not Daniel Anderson Peabody’s record. This has to be an exact match.
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“/And/”, for example, will not match anything. However, “/And”, will match any
record where the surname begins with the letters ‘And’ – i.e. it will match Jean
Clare Anderson and Fiona Andrews – and ‘son/’ will match any record where the
surname ends with the letters ‘son’.

Delete Deleting a record in the Records Window is easy. Simply select the record and
Record press the Delete key or (click on Delete on the Edit menu). A warning dialog will
ask you to confirm that you definitely want to delete the record.

Experiment with this now if you wish to, but remember not to save your changes
when we finish the chapter!

Select Many of the menu and toolbar commands in Family Historian require a record to be
Record selected. The behaviour of the Property Dialog too can depend on the current
record selection (see Pinned & Unpinned Mode in Chapter 1). It is worth being
clear about what it means to “select a record” in the Records Window.

So far, you have encountered 2 types of records: Individual Records (with the
identity card icon: ); and Family records (with the family tree diagram icon: ).
Later you will encounter more record types. There are 9 in total (several of them
are not used much) and they each have their own distinctive record icon.
At its simplest, wherever you see a record icon (of whatever type) in the Records
Window, you can select a record by clicking on the text next to the icon. Clicking
on the text ‘Cameron Peabody’ in the first column, where it appears next to the
record icon, , is an example of one way to select Cameron Peabody’s record.
However, we saw earlier that when you expand a record, you may see links to other
records too. By clicking on the text next to the record icon in the right-hand column
(the number of columns effectively reduces to 2 in the expanded portion of an
expanded record) you can select these records too. This was how we selected
Cameron Peabody’s record in the Go To Record section above, while viewing
linked records.

Cells Type
and Field
Icons

As we have seen, when you expand a record in the Records Window by clicking on
its expansion button, the record is displayed in 2 columns. What would normally be
the second and subsequent columns are all collapsed into one single column
effectively at this level. These 2 columns divide each row into 2 areas called cells.
Only unindented cells in the left column represent records. All other left-column
cells represent fields (or tags as they are called in GEDCOM). Remember that in
GEDCOM, fields are hierarchical and can contain sub-fields. Just as records are
always represented by a record icon, fields are always represented by a field icon.
Field icons are always little coloured circles. Individual fields (fields in Individual
records) have a blue circle: . Family fields (fields in Family records) have a red
circle: .
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Edit Field Where the left column cell contains a field, the right column cell contains the value

of that field. For example, the left column cell might contain the label ‘Sex’ and the
right column might contain the value ‘Male’. If you click in the right-cell you will
find that, in most cases, it is editable. For example, if you click on the text ‘Male’,
you will find that a drop-down list appears and you can select a different sex if you
want to. Family Historian will prevent you from doing anything ‘invalid’ at this
point. For example, if you try to change the sex of an individual who is a parent or
a spouse, you will not be allowed to do so.
Where a field stores a link to another record, you can edit the link by right-clicking
on the text in the right cell. A menu will appear to show you what options are
available to you.
Although you can edit fields in the Records Window, you rarely need to. Ordinarily,
you will do all editing in the Property Dialog, which is much easier to work with.

Add Field Not only can you edit cells in the Records Window, if you want to, you can also
add them. This is an advanced topic, and you will rarely want to do it, but
exceptionally you can add fields to a record directly within the Records Window if
you want to. To do this, click on any left-hand cell with the right mouse button. A
context menu appears listing all the ‘sub-fields’ that can be added to the chosen
field. For example, if you right-click on the word ‘Name’ in the left cell, you will
find a list of sub-fields that can be added, to qualify a Name field.
Again, it should be emphasised that you will rarely need to add fields directly in the
Records Window. Instead, you should simply enter data into the Property Dialog
which will automatically create any fields that you need for you.

Delete Whereas you rarely need or want to add or edit fields in the Records Window, you
Field are more likely to occasionally want to delete fields in the Records Window (or in
the All tab of the Property Dialog – see below).

We have already seen how you can delete records in the Records Window. The
technique for deleting a field is the same, except that instead of selecting a record,
you select a field, and then press the Delete key (or click on the Delete on the Edit
menu). You select a field by clicking in the left-hand column (remember that
indented rows represent fields, and unindented rows represent records). Family
Historian will always warn you of what you are about to do, and give you a chance
to cancel, before it will let you delete any data.
When you delete a field, any sub-fields in the same record are also deleted.

The All Tab
of the
Properties
Dialog

Do you remember the All tab of the Properties Dialog? Select Cameron Peabody
now and view his record details in the Property Dialog (see the section How To
Open the the Property Dialog in Chapter 1 if you can’t remember how to do this).
The All tab is the last tab. Click on it now. As you can see, the record is laid out in
the All tab in exactly the same way that it is laid out in the Records Window. So
here too, you can see at a glance, all the information you have stored in a given
record.
You can browse a record in the All tab, exactly as you can in the Records Window,
and you can view linked records in exactly the same way. You can even edit fields,
add fields, delete fields and unlink records in the All tab – in exactly the same way
that, as we have seen, you can in the Records Window.
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Unlink
From
Parents or
Spouse

The easy way to unlink any child from its parents, or to unlink a parent from his
family or one spouse from another is to select the record in the Records Window
and use the Unlink From command on the Edit menu. This is easy and convenient
but only works for unlinking family relationships. You cannot use this technique to
remove other kinds of links between records.

Remove You can remove any record links in the All tab of the Property Dialog if you wish
Any Links to. When a record is linked to another record, it has a field which stores this link.

So to unlink 2 records you merely need to delete the field that links them together.
For example, to unlink Cameron Peabody from his marriage to Jean Clare
Anderson, you could simply select the second occurrence of Spouse family in the
left-hand column of his record, and press the Delete key. Then press OK when
warned that ‘The selected field will be deleted’.
You can use the same technique, of course, in the Records Window.

Child is
Adopted,
Step or
Fostered

If you want to show that a child is adopted, step or fostered, you should switch to
the All tab of the Property Dialog for the child in question. Right-click on the
Parents Family field (you have to establish the child as a child before you can
establish him or her as having been adopted). Click on Add Relationship in the
context menu that appears. This will add a Relationship sub-field that qualifies the
Parents Family field. Click in the right column, opposite Relationship, and select
either Adopted, Step or Fostered as appropriate.
Notice that you can add more than one relationship if you wish to use different
values for the different parents. For example, a child might be adopted by the father
while being the natural child of the mother. The value de facto is a catch-all and is
useful for exceptional cases which don’t fit any of the other categories – such as the
case where a father believes that a child is his own, and always treats him as such,
but in fact the child is the natural child of someone else.
By default, adopted, step or fostered children are labelled as such, in the Records
Window, when listed in the context of their parent families. You can uncheck this
option in the Record Windows Options dialog if you wish to.

Low-level Ultimately there is very little in the way of editing, that cannot be done in either the
Editing Records Window or in the All tab of the Property Dialog. If you experiment, you

will find that there are even ways of creating records directly in the Records
Window (one way to do this is simply to right-click on an unused area of the
Records Window – a menu will appear that will give you the option to create a
record of the current record type). However, editing in the Records Window (and in
the All tab of the Property Dialog) is mainly ‘low-level’ and not appropriate for
most purposes. If you want to unlink records, or show that a child is adopted, it is
appropriate to do this in the Records Window, or in the All tab of the Property
Dialog – using the techniques described. But these are exceptions. In general you
should think of editing in the Records Window, and in the All tab of the Property
Dialog, as a fallback – only to be used if what you want to do cannot be done any
other way.
This is not to say that all editing must be done in the other tabs of the Property
Dialog. On the contrary, as we will see later, Family Historian supports diagrambased editing, as well as other editing techniques.

Close the There is no ‘Close File’ option as such in Family Historian, but entering the ‘New’
Current state effectively does the same thing.
File Steps
1.

Click on New from the File menu (or click on the New button on the toolbar).
If you are asked if you want save changes, click on No.
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This step presupposes that you have...
Read the Introduction and Chapters 1 & 2

You will learn how to...
Use the 4 default diagram types, including the All Relatives diagram
Restore the Diagram Window’s installation settings
Zoom and scroll within the Diagram Window
Hide or show branches of diagrams, using expansion buttons
Interpret and understand diagrams
Use the Property Dialog in conjunction with the Diagram Window
Use diagrams for browsing
Control aspects of diagram display
Manage windows within Family Historian

Preamble In chapter 2, we saw that the Records Window is a special kind of window within-awindow called an MDI child window. This chapter introduces another MDI child
window: The Diagram Window. We will start this chapter by looking at
techniques for managing MDI child windows. Although we will use the Records
Window and the Diagram Window as examples, the techniques are equally
applicable to all MDI child windows, and we will not repeat them when we later
come to look at other MDI child windows. Simple window management is a basic
and common task when using Family Historian. So it is well worth taking the
trouble to master these techniques now.
The terms ancestor, descendant and relative will be used frequently. Your
ancestors are your parents, grandparents, great grandparents, and so on. Uncles and
aunts are not ancestors. Nor are cousins. All and only the people from whom you
are directly descended, are your ancestors.
Your descendants are all the people who are directly descended from you - i.e. your
children, grandchildren, great grandchildren, etc. Your nephews and nieces are not
your descendants.
A relative is anyone who is either an ancestor or a descendant of an ancestor. We
might add: ‘or a descendant of you’. The last clause isn’t really necessary, however,
because, of course, no-one can be your descendant without also being a descendant
of all of your ancestors. So your parents, grandparents, grandparents’ siblings,
nephews, nieces, great-nephews, great-nieces, and your 4th cousins 3 times
removed, are all examples of your relatives.
A relative by marriage is anyone who is married to a relative; or is a relative of your
spouse.
This chapter uses, but does not alter, the file saved at the end of chapter 1. If you
skipped chapter 1, or read it but didn’t create your own file, use the ‘pre-cooked’
version (see “Tutorial Files (referred to in the manual)” on the Help menu).
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View We will start by displaying a diagram showing Thomas Peabody’s ancestors.
Ancestors
Steps
1.

Locate and select Thomas Peabody’s record in the Records Window.

2.

Click on the View Ancestors button
on the toolbar. The Diagrams
Window appears, showing a diagram of Thomas Peabody’s ancestors.

It doesn’t matter whether the Property Dialog is open at this point, or not. But if its
in the way, you could either move it out of the way and/or switch it to Small Mode,
or just close it. Its up to you. At this point, Family Historian should look something
like either Figure 6 or Figure 7 below.

Figure 6 – the Diagram Window not maximized

Maximizing
an MDI
Child
Window

Figure 6, shows what the Diagram Window looks like when not maximized. Its title
varies depending on the diagram being displayed. In this case it is “Ancestors of
Thomas PEABODY”. When working with diagrams, you may want to make the
Diagram Window as large as possible. If your Diagram Window is not already
maximized, maximize it now. By now you should know how to do this. The
technique is the same as the one used to maximize the Records Window (see
Maximize the Records Window in Chapter 2), or any other window for that matter:
simply click on its maximize button. The maximize button is the middle button of
the 3 buttons at the right end of the Diagram Window’s title bar:
Make
sure when you do this that you choose the correct Maximize button. In Figure 6
there are 3: the one for the Diagram Window, the one for the Records Window and
the one for the frame window.
Tip: A quick alternative way to maximize a window is to double-click on its title bar.
When you maximize the Diagram Window it will look something like Figure 7
below. The Diagram Window has become fused with the frame window. Its title
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bar has disappeared, and its title has become merged with the title of the frame
window.

Figure 7 – the Diagram Window maximized within the frame window

Restoring
a
Maximized
MDI Child
Window

You may be wondering at this point where the Record Window has gone. Well it
hasn’t gone anywhere. It’s still where it was. It’s just hidden behind the Diagram
Window so you can’t see it at the moment. To prove this to yourself, restore the
Diagram Window now to its un-maximized state (i.e. as in Figure 6).
To restore (that is, ‘un-maximize’) a window you have to click on its Restore button
again. As we saw in Chapter 2, when an MDI child window is maximized, its 3 title
bar buttons become smaller, and are tucked up beneath the Minimize, Maximize and
Close buttons for the frame window. At the same time, the Maximize button is
replaced with a Restore button.

There are 6 buttons here, in two rows of three. The Restore button for the Diagram
Window is the middle button on the second row – i.e. this one:
. Practice now,
maximizing and restoring the Diagram Window a few times, until you are familiar
with the process, and familiar with the different states of the Diagram Window.

Switching If one MDI child window is hidden by another, you can bring it to the front at any
Between time, by just clicking on its icon on the Navigation bar.
MDI Child
Windows
Click now on the Records Window Navigation Bar Icon:

25

When you do that,

Chapter 3 – Introduction to Diagrams

the Records Window comes to the front. If the Diagram Window had been
maximized, the Records Window will be maximized now.

Diagram
Window
Navigation
Bar Icon

We saw earlier that each different kind of MDI child window in Family Historian
has its own icon on the Navigation bar. The icon for the Diagram Window is shown
on the left. Click on that icon on the Navigation bar now to bring the Diagram
Window back to the front again.
Notice that the active MDI child window (the one that is in front of the other MDI
child windows if any) always has a box round its icon in the Navigation bar.

You Never
Need to
Close MDI
Child
Windows

A common mistake is to think you have to close one window before you can ‘go
back’ to another window. You never have to do that with MDI child windows –
you can switch between them easily whenever you want, by just clicking on icons
on the Navigation bar.

How To
Close MDI
Child
Windows

Although you don’t need to close MDI child windows, you will want to sometimes.
You won’t want your application to become unnecessarily cluttered with windows
when you are no longer using them.

Tip: If the windows are not maximized so that you can see more than one at the
same time (as in Figure 6) a simple way to make a window the active window is just
to click on it (anywhere on it).

We didn’t properly cover closing MDI child windows in Chapter 2 because you’re
not allowed to close the Records Window. But you can close all other MDI child
windows. You probably already know one way to close the Diagram Window (or
any MDI child window): you just click on its Close button.
The only trick about this is to make sure you are clicking on the correct close
button. In Figure 6 there are 3 close buttons: one for the Diagram Window, one for
the Records Window and one for the frame window. And they all look like this4:
. If you click on the frame window’s close button by mistake, Family Historian
will think you are trying to close the application. But that’s not a disaster. You will
always be prompted to save any unsaved changes, and given the opportunity to
cancel at that point. So no harm would be done.
If the Diagram Window is maximized as in Figure 7, it still has a Close button; but
it’s a little harder to find. As we have seen, when an MDI child window is
maximized, its Minimize, Maximize and Close buttons become smaller (and the
Maximize button becomes a Restore button), and are tucked up beneath the
Minimize, Maximize and Close buttons for the frame window, like this:

There are 6 buttons here, in two rows of three. The Close button for the Diagram
Window is the last button on the second row – i.e. this one:

4

.

Depending on your version of Windows and other factors, the Close button (and the Minimize and
Maximize buttons) may not look exactly as shown here; but you should be able to work out which is
which.
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Closing
MDI Child
Windows
Using the
Navigation
Bar

A quick and easy way of closing an MDI child window (even one you can’t see at
the moment you want to close it) is this: right-click on its icon on the Navigation
bar. A dropdown menu appears, with 2 menu commands. The second one is ‘Close
Window’. Click on the ‘Close Window’ command and the window will close.
Practice now closing and re-opening the Diagram Window using different
techniques. Notice that when the Diagram Window is closed, its icon disappears
from the Navigation bar. To re-open it, repeat the instructions in the View Ancestors
above. When you feel you are confident in managing, opening, closing, maximizing
and restoring MDI child windows (you rarely need to bother with Minimizing) move
on to the next section.

Restore Before continuing, to ensure consistency with this manual you should use default
Installation options in your diagrams, for now – i.e. the ‘installation settings’.
Settings Steps
1.
2.

The
Diagram
Menu and
Toolbar

Click on Restore Installation Settings on the Diagram menu.
If for some reason you wish to preserve your default settings, click ‘No’ when
asked if you wish to use the installation settings as default settings in the future.
Otherwise, click ‘Yes’.

You may have noticed that when the Diagram Window appears, a new toolbar also
appears. This is the Diagram Toolbar – see Figure 8 below. It is automatically
positioned for you in a convenient place. As well as the toolbar, you may also
notice that there is a new menu, Diagram, that has appeared just to the right of the
Tools menu.
Both the Diagram Menu and the Diagram Toolbar are only displayed when the
active window is a Diagram Window.

Figure 8 – the Diagram Toolbar

Zooming In Locate the Zoom In
and Zoom Out
buttons on the Diagram Toolbar.
and Out Click on each of them in turn a few times to familiarise yourself with them.

(or Num +,
Num –
or Ctrl-K,
Ctrl-L )

If you want to zoom a long way quickly, in or out, clicking these buttons repeatedly
is a very slow way to do it. A better alternative is to use the – (minus) and + (plus)
keys on the numeric keypad. The advantage of these keys over the buttons is that
you can press and hold the key, and the diagram will zoom in or out, until you
release the key, so you can do the entire zoom in one action. The Diagram
Window must be the active window when you do this.
If you are using a laptop, you may find it more convenient to use Ctrl-K and Ctrl-L
instead of Num+ and Num-.
There are various techniques for zooming in and out, and we shall look at all of
them. None of them affect the size of the diagram when printed. Various techniques
for setting the size of a diagram when printed are discussed in Chapter8.

View At any time, you can jump to a view of the whole diagram, by clicking on the View
Whole Whole Diagram button:
(its supposed to look like the globe). Click on this
Diagram button now. You should be able to see the whole diagram without having to scroll.
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Specify You can specify the number of generations that you wish to see in your diagram.
Number of
Steps
Generations 1. Click on the Options command on the Diagram menu. The Diagram Options
2.

3.
4.

Dialog appears.
Set Generations Up to 2. Press OK. You should now be able to see 2
generations. Click on the View Whole Diagram button
to get the best
view of the diagram.
Click on Diagram > Options again, and set Generations Up to 3. Press OK.
Notice that the diagram now shows 3 generations. Click View Whole
Diagram again to see all 3 generations without having to scroll.

Tip: When you want to see all of an individual’s ancestors, set the Generations Up
value to All.

Select You can select the exact part of the diagram that you wish to view. In this example,
View we will zoom in on the boxes for Cameron Peabody and Sarah Watts.
Steps
1.
2.

3.

4.

Click on the Select View button
on the diagram toolbar.
The button stays depressed. Now move the mouse over the Diagram Window.
Notice that the cursor’s shape has changed and now looks similar to the Select
View button (it’s supposed to look like a magnifying glass).
Click just above and to the left of Cameron Peabody’s box on the diagram.
Keeping the mouse button depressed, drag down and to the right. A stretchy
box should appear. Drag in such a way that the stretchy box surrounds the
diagram boxes for both Cameron Peabody and Sarah Watts; then release the
mouse button.
The Diagram Window view changes to show a close-up view of the selected
area. The Select View button is no longer depressed.

Tip: Select View works well in conjunction with View Whole Diagram. Use the
latter to get an overall view. Then use the former to pick the precise area you want
to look at.

Centre The Centre Diagram command does not zoom in or out. It re-centres the diagram
Diagram on the individual or individuals who are the root, or roots, of the diagram (as we will
see later, diagrams can be based around a couple, as well as on a single individual).

When showing ancestors (at least in top-down orientation) the root individual or
couple will be centred at the bottom of the Diagram Window. When showing
descendants, they will be centred at the top of the Diagram Window. For other
diagrams they will be moved to the horizontal and vertical centre of the window.
Try this now. Click on the scrollbars to move around the diagram and then click on
the button to re-centre.
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The The Grabber also does not zoom in or out. Rather it is a convenient alternative to
Grabber clicking on scrollbars, if you want to reposition the diagram.
Steps
1.
2.

3.

4.

Click on the Grabber button
on the diagram toolbar. The button stays
depressed.
Move the mouse over the Diagram Window. Notice that the cursor’s shape
has changed and now looks similar to the Grabber button (it’s supposed to
look like a hand).
Click anywhere on the diagram and, keeping the mouse button depressed, move
the mouse up and down, left and right. Notice that when you do this, you
reposition the whole diagram.
Click once again on the Grabber button, to end this mode.

Tip: A quick way to switch temporarily to ‘grabbing’ mode is to simply press-andhold the spacebar. You can then click-and-drag anywhere on the diagram to move
it. When you release the space bar, the diagram will revert to its previous mode.
This is a very useful technique which is well worth remembering.
Tip: A quick way to end ‘grabbing’ mode is to click with the Right Mouse button.
Another way to end it (which also works with the Select View mode) is to press the
Escape key (Esc).

Expansion You should at this point be viewing Thomas Peabody’s ancestors. 3 generations
Buttons should be visible (if not, see Specify Number of Generations above). Locate the
Expansion Buttons button
on the diagram toolbar. Click it a few times and
observe the effect on the diagram. When pressed in, some of the lines should have
circles in them. When pressed out, the circles disappear. These circles are
expansion buttons. They work exactly like the expansion buttons that we
encountered in the Records Window in Chapter 2 (which in turn are exactly like
the expansion buttons in Windows Explorer).
Ensuring that the Expansion Buttons button is pressed in, click on the expansion
button above Ian Peabody. Observe that his ancestors disappear (in this case, just
his parents), and that the expansion button now has a cross over it. Click on the
same button again. The ‘ancestors’ re-appear.
The expansion button above Cameron Peabody has a cross over it. This shows that
Cameron Peabody has at least one ancestor, but the diagram isn’t showing it. The
reason that his ancestors are not being shown is because we set the number of
generations to 3. Nevertheless, click on his expansion button. Notice that his
mother (Naomi Prentice Salt) now appears. When you specify the number of
generations, you only specify the initial number of generations to display. It does
not prevent you exploring further generations, using the expansion buttons.
Tip: An alternative to clicking on an expansion button is to press the Enter key
when the relevant box is selected. If you move the arrow keys, the selection will
change appropriately from one box to another. Using the arrow keys to move, in
combination with the Enter key to expand or hide boxes, is a convenient and easy
way to move around a diagram.
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The
Property
Dialog &
the
Diagram
Window

In Family Historian, diagrams are not just for printing. They are also for editing and
for online browsing. In both of these latter roles, the Diagram Window is designed
to be used in conjunction with the Property Dialog. If the Property Dialog is open
at present, close it. You should be viewing a diagram showing ancestors of Thomas
Peabody at this point.
Steps
1.
2.

3.

4.

5.

Double-click on the box for Thomas Peabody. The Property Dialog appears
showing the details for Thomas Peabody.
Now single click on other boxes in turn. Notice that the Property Dialog
updates itself to show details for each one (because it is in Pinned Mode – see
Chapter 1).
Unselect all boxes in the diagram, by clicking on the background of the
Diagram Window. The Property Dialog displays the text ‘No record
selection’.
Now repeat steps 1-3, but choose the Events tab. Notice that you can easily see
all the events and attributes for each Individual in turn (although at present the
3 youngest Individuals have no events). If you had had pictures for each of
them, you could have seen a picture of each of them in the Pictures tab.
Now switch to Small Mode (see Small & Large Mode in Chapter 1 for how to
do this) and repeat 1-4. Notice that the Property Dialog still displays details
for the selected box. If you would prefer to use Small Mode by default in the
Diagram Window, you can specify this in the Preferences Dialog (available
from the Tools menu).

Diagrams
are
Dynamic

Diagrams in Family Historian are dynamic. That is, they keep themselves up-todate, and always reflect the latest changes. To illustrate this, select Thomas
Peabody. The Property Dialog shows his details. Change the Name field to ‘Simon
Peabody’. Press Tab. Notice that the diagram updates immediately to use the new
name. Change the name back to ‘Thomas Peabody’ and press Tab again. The
name reverts back to ‘Thomas Peabody’.

View
Descendants

You should be viewing the ancestors of Thomas Peabody. Locate his great
grandmother, Naomi Prentice Salt. Click on Naomi’s box to select it. We are going
to view her descendants. Notice that you don’t have to select her record in the
Records Window. Any selection in any window is just as good as any other, for
any command which requires a selected record.
Steps
1.

Spouse
Display
Options

Click on the View Descendants button
on the toolbar. The Diagram
Window changes to display a diagram of Naomi Prentice Salt’s descendants
(confirm that the window title either is, or ends with, “Descendants of Naomi
Prentice Salt”).

When viewing a person’s descendants, how do you display information about the
spouses of descendants? Family Historian provides 4 different ways of handling
spouses. When working through the examples, don’t forget that you can click on
View Whole Diagram at any time, to get the best view of the diagram.
Steps
1.

Click on the No Spouse Info button
on the Diagram menu. Notice that
the diagram displays 1 child for Naomi, 3 grandchildren, and 2 great
grandchildren. Including her own box, there should be 7 boxes in all. So far,
there is no information about spouses. We can see from the diagram that
Amanda, Ian and Daniel are all children of Cameron Peabody, but there is
nothing to show that Daniel has a different mother to the other two.
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2.

Now click on One Box Per Marriage
. An extra box appears. Unlike the
others it is pink, and displays 2 lines of text ‘Cameron Peabody’ and ‘Spouse:
Jean Anderson’. It is linked to Cameron’s original box by a zigzag line (called
a stretchy line). This box is a remarriage box for Cameron Peabody. When
One Box Per Marriage is selected any descendant that is married more than
once will get one extra box for each extra marriage. At this point, each box
contains the name of the descendant’s spouse, if any. We can now see that
Cameron had 2 wives: Sarah Watts and Jean Anderson. Amanda and Ian are the
children of Cameron and Sarah. Daniel is the child of Cameron and Jean.

3.

. This time, 3 new brown boxes have
Click on Spouses in Own Box
appeared, and the pink remarriage box has gone, making a net increase of 2
boxes. The brown boxes represent spouses – one for each of Naomi’s
descendants who have a spouse.
The 4th option is rarely used. If you want you can have both spouses and
remarriage boxes. This can only be set from the Spouse display options
section of the Diagram Options dialog. Do not set this option now.

4.

Box Types This example shows that the Descendants diagram is a little more complicated than
the Ancestors diagram. Whereas the boxes in the Ancestors diagram are all of the
same type, and all display the same information, the Descendants diagram can
contain up to 3 different types of box: normal descendant boxes, remarriage boxes,
and spouse boxes. These boxes can, and usually will, display slightly different
information. You may have noticed that Cameron’s date-of-birth is not repeated in
his remarriage box, for example.
Although the root box is coloured differently from other boxes (white, in this
diagram), it shouldn’t be thought of as another type of box. In descendant diagrams
the root box will always display the same information as normal descendant boxes,
and is therefore referred to as a descendant box. In an ancestor diagram it is treated
like an ancestor box.
Pause a while to make sure you have a good understanding of the Descendants
diagram, before moving on. Switch backwards and forwards between all 3 spouse
options, until you are clear about what they do. Notice that a given box type may
display different information in different circumstances. Descendant boxes only
display spouse information if spouse boxes are not being displayed, for example.
Notice that you can switch spouse option at any time, even if you have expanded
and hidden branches, and made other changes to the diagram.

Text The text that is displayed in a box is determined by the Text Scheme. Up to now
Schemes you have only used one text scheme: Birth, Marr, Death. However, there are
numerous standard ones, and later we will look at how you can change text
schemes, and create your own.
Steps
1.
2.
3.
4.

Bring up the Diagram Options Dialog (click on Diagram > Options).
Select the Text tab.
Select the text scheme “Name Only” from the list. Press OK.
Notice how the text has changed. Repeat this exercise selecting in turn: “Name
Only (Compact)”, “Name, Dates, How Related” and any other text scheme you
wish to try. Try pressing the Apply button instead of the OK button. Notice
that the diagram changes behind the Diagram Options dialog when you do this.
Apply applies changes to the current diagram exactly as OK does, but the
Diagram Options dialog doesn’t close, which can be more convenient if you are
experimenting.

Some text schemes may appear identical because the differences between them are
only manifested when you have more data.
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The Box Types scheme is a useful one if you are at all unclear about which type a
given box belongs to. With this scheme, each box displays its own box type in
capital letters (Ancestor, Descendant, Spouse, Remarriage or Proxy5). Try using it,
while changing the Spouse Display Options (see previous). It should help to clarify
what they do.

View
Ancestors
and
Descendants

The Ancestors and Descendants diagram is sometimes referred to as an Hourglass
Diagram, for obvious reasons.
Steps
1.

Locate Cameron Peabody. If he is not visible in the current diagram he should
be an ancestor or descendant of someone who is; so you should be able to
switch easily to a diagram that contains him. Select his box and click on the
View Ancestors and Descendants button
. The Ancestors and
Descendants Diagram is displayed. Click on View Whole Diagram to see it
all. This is the diagram shown in Figure 1, in Chapter 1.

The Ancestors and Descendants diagram is not hard to understand, but it is worth
pausing to get a good grasp of it before moving on, if only because it will help to
make sense of the All Relatives diagram.
You should be able to see that the Ancestors and Descendants diagram is simply the
grafting of an Ancestors diagram on top of a Descendants diagram. The window is
split into 2 parts. Ancestors are displayed in the top part, descendants in the bottom.
The Spouse Display Option buttons all work with this diagram, but only affect the
lower, descendant portion of the diagram. They have no effect on the display of
ancestors (in this case, there is of course only one ‘ancestor’ – Cameron’s mother,
Naomi – so the diagram does not illustrate this very well).
Try selecting Box Types as the text scheme. Depending on which Spouse Display
Options you use, you should be able to see 4 different types of boxes: Ancestor,
Descendant, Spouse and Remarriage.
If you look at the Diagram Options Dialog’s General tab, you will see that you
specify both the number of Generations Up and Generations Down separately, for
this diagram.

View All We will now use the All Relatives diagram to show all the relatives of Adam Wiley.
Relatives
Steps
1.

Select Adam Wiley and click on the View All Relatives button
to display
the All Relatives Diagram. The Diagram Window’s title reads ‘Relatives of
Adam Wiley’. See Figure 9 below.

Adam Wiley’s direct ancestors are all coloured in green. This is just the style of the
default diagram. You can use other colouring schemes (see the Box tab of the
Diagram Options dialog)
Notice that Jean Clare Anderson has a little ‘2’ next to her box. This is to indicate
that she is the 2nd spouse of Cameron Peabody. If there was no number, the
positioning of her box would imply that she was his first wife. So a number is
necessary to correct that impression.

5

We haven’t encountered ‘Proxy’ boxes yet. They are a special type of box, only used in All Relatives
trees.
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Figure 9 – An All Relatives Diagram showing relatives of Adam Wiley

Interpreting All Relatives Trees
Large All Relatives trees can be complex. If you zoom in on a small part of an All Relatives tree,
containing a large number of boxes, you may wonder if you click on an expansion button, which part
will disappear: the area above the expansion button or the area below it? It is easy to get confused
about what you are looking at.
A few key points may help. Remember that all trees, including the All Relatives trees ‘extend out’
from a root. It is true that trees can have a couple (i.e. of individuals) as their root, but the couple will
always be side-by-side. So it remains the case, even then, that all trees are anchored in a starting point,
and that all lines extend out from there. In a tree with top-down orientation, Descendant trees extend
out downwards. Ancestor trees extend out upwards. Ancestor and Descendant trees extend out both
upwards and downwards. And All Relatives trees extend out both downwards, and upwards-and-thendownwards. But they don’t extend out downwards-and-then-upwards (this is because your
descendants’ ancestors are not per se your relatives, but your ancestors’ descendants are). Trees show
you how individuals are related to the root. Clicking on expansion branches hides outermost branches
of the tree. The branch area leading back to the root is not hidden. When, as with the All Relatives
tree, you get lines crossing over themselves and ‘outer’ branches that fold back on themselves so that
the tips are physically close to the root, it’s easy to get confused.
Tip: Large All Relatives diagrams are often easier to follow when printed.
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Open the
Diagram
Options
Dialog
Basic
Diagram
Options

We have already seen that one way to open the Diagram Options Dialog is to click
on Options... on the Diagram menu. However, another slightly quicker way to do
it, is to right click on the background of the Diagram Window, and select Diagram
Options... from the context menu that appears. Try that now.
You should be looking at the General tab of the Diagram Options Dialog. The
Diagram Type field takes 4 values: Ancestors, Descendants, Ancestors and
Descendants or All Relatives. Click on each of these in turn and observe the effect
on the diagram options. The values for Generations Up and Generations Down
may differ depending on the diagram type, but none of the other fields do.
However, not all fields are applicable to each diagram type. Fields that are not
applicable for a given diagram type are hidden.
The initial size of an Ancestors diagram is determined by Generations Up. For a
Descendants diagram, the equivalent field is Generations Down. For an Ancestors
and Descendants diagram, both fields must be specified. For an All Relatives
diagram, the Generations Down field either specifies the number of generations
down from each ancestor (the diagram root isn’t his own ancestor, but counts as one
for this purpose), or specifies the number of generations down from the diagram
root, depending on the value of the ...counting down from field.

Generation You will have noticed that by default the All Relatives diagram has a striped
Stripes background. Each stripe corresponds to a generation. Belonging to a generation

has nothing to do with age. You can have an uncle who is younger than you; but he
is still a member of the previous generation. A person’s generation is relative to a
relationship, and is determined by how many generations back you have to go to
find either them or a common ancestor; and then (if they aren’t an ancestor) how
many steps back down you have to go to reach them from the common ancestor.
Your uncle is 2 steps back to a common ancestor (either of the grandparents) and
one step down from them (he is their child). So, in terms of generations, he is one
step back from you.
The All Relatives diagram in Figure 9 is showing 4 generations.

Relation- Any diagram can have labels for each row describing the relationship of individuals
ship in that row to the diagram root.
Descrip- Steps
tions
1.
2.

Re-display an All Relatives diagram for Adam Wiley.
Open the Diagram Options Dialog. Confirm that the Background field is set
to Generation Stripes. Set Relationship Descriptions to On Both Sides. Press
OK. Relationship descriptions appear on either side of the diagram.

Tip: You can change the font (including font style and colour) for Relationship
Descriptions by clicking the Font button to the right of the Relationships
Descriptions field in the Diagram Options dialog.
Tip: By default, the row in which the root appears is labelled ‘root & siblings’. You
can change this to something else if you wish. This is set in the Diagrams tab of the
Preferences dialog, which is available from the Tools menu.

Use the
Online
Help

So far we have barely scratched the surface of the features that are available when
working with diagrams. More information is available later in this manual. But
another good source of information is the Online Help. Click on the Help button
within the Diagram Options dialog to get detailed context sensitive Help.
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Dialog
This step presupposes that you have...
Read the Introduction and Chapter 1.

You will learn how to...
Open an existing Family Historian file
Create parents and grandparents for existing individuals using the Property Dialog
Re-order spouses and siblings using the Property Dialog
Handle some special cases
Use more features of the Property Dialog

Preamble This chapter continues from where chapter 1 left off. We will add some more
relatives to Cameron Peabody. By the end of this chapter, we will have added all
the relatives shown in the All Relatives diagram in Figure 10 below. In the process,
we will introduce some new features of the Property Dialog.
Notice that Cameron’s second wife, Jean Clare Anderson, is also his first cousin, so
she appears twice – once as his wife and once as his cousin. In the same way,
Cameron Peabody also appears twice too. These duplicate occurrences are linked
together using a curved ribbon.

Figure 10 – An All Relatives Diagram, showing relatives of Cameron Peabody
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Open a File Start by opening the file from Chapter 1.
Steps
1.

From the File menu, click on Open (or click on the Open button on the
toolbar). Locate the file you saved at the end of Chapter 1. It should be called
“Tutorial – Chapter 1” (it will have a “.ged” suffix, if you are displaying them).
Press OK.

If you didn’t create your own file in chapter 1, use the ‘pre-cooked’ version (see
“Tutorial Files (referred to in the manual)” on the Help menu).

Save As We recommend that you don’t make any further changes to the file you created in
Chapter 1. Instead we suggest that you save the work of each chapter in a new file,
specific to that chapter. The advantage of this is that it means that you can re-use
each chapter’s file if you want to repeat a chapter.
To ensure that you don’t absent-mindedly click on the Save button, and thereby
change the file from Chapter 1 (or in case you have Auto-save enabled) you should
save the current file now under its new name for this chapter.
Steps
1.

From the File menu, click on Save As. Choose an appropriate folder and save
the current file as “Tutorial – Chapter 4”. Press OK.

Having done this, you can now click on the Save button whenever you want to. The
file will be saved under its new name for this chapter.

Add 2nd Find Cameron Peabody’s record in the Records Window and open the Property
Parent Dialog to view his record details. We will now add Cameron Peabody’s father,
Philip Peabody.
Steps
1.

2.

3.
4.

To the right of the main Name field is the Go To Parents button
.
Click it now. The dialog now shows the details for Cameron’s mother, Naomi
Prentice Salt, with Cameron displayed as her child.
Cameron’s father is Naomi’s spouse, and must be entered as such. In the
Spouse Name field, click on <click here to add spouse> and select Create
New Record as Spouse.
In the Spouse Name field enter “Philip Peabody” and press Tab.
In the Marr. Married field, enter “1897” and press Tab.

At the start of this chapter there should have been 10 Individual records listed in the
Records Window. There should now be 11. If you look at the application’s status
bar (at the bottom of the main application window) you should see a pane which
contains the text “Individuals: 11
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Re-order Now enter Cameron’s sister, Mary. As she was an older sister; she should be listed
Siblings before Cameron in their parents’ list of children. We need to move Cameron down
one row, and leave a gap for Mary.
Steps
1.

2.
3.

4.
5.
6.

Notice the ‘1.’ to the left of Cameron’s name field, indicating that this is the
first child. Also notice that there are 2 arrow buttons immediately above the
children’s scrollbar. They are greyed now. When ungreyed they look like this:
. These are the Move Sibling Buttons, so-called because they are used to
re-order siblings. Do not confuse them with the Move Spouse Buttons, further
up the dialog box, which look the same, but are used to re-order spouses. Now
click on Cameron’s Name field. When you do this, a chevron (>) appears to
the left of the numeral 1 and the right (Move Sibling Down) button becomes
ungreyed. The chevron indicates which row will be moved if you click on a
Move Sibling Button.
Click on the Move Sibling Down Button. The row for Cameron Peabody
moves down.
The first child field now shows <Click here to add child> again. Click on the
text. From the menu that appears, click on Create New Record as Child. We
are creating another child for Naomi and Philip.
Enter “Mary Peabody” in the first child Name field and press Tab.
Type F in the Sex field and press Tab.
Enter her date of birth as 14th February, 1898. You should know how to do this
by now, but if double quotes appear round the date when you press Tab, you
did it incorrectly. See the box “How to Enter Simple Dates” in Chapter 1 for
help if you need it.

Of course we could have entered Mary as a child below Cameron, and then moved
her up. As always, the order in which you do things doesn’t matter. Notice,
however, that it is up to you to ensure that siblings (and spouses – see below) are
ordered correctly. Even if their birth dates are known, Family Historian does not
re-order siblings automatically.

Enter
Grandparent
Details

Of course there is no facility to enter a grandparent, as such, any more than there is
a facility to enter a grandchild. To enter Cameron’s grandfather, Richard Peabody,
you simply enter him as the father of Cameron’s father – Philip Peabody.
You should by now know how to do this. Try to do it without help. If you aren’t
sure, the steps are given below. These steps are not the ‘right’ way of doing it.
They are just one way.
Steps
1.

2.
3.
4.

Assuming that at this point, you are viewing Naomi Prentice Salt’s record,
Philip should be listed as her spouse. Click on the Go To Spouse button, next
to Philip’s name, to make Philips the ‘current’ record.
Click on the Go To Parents button.
Click on ‘<Click here to add parent>’ in the first Name field, and then select
Create New Record as Parent from the menu that appears.
Select ‘Male’ as the sex of the new parent, and enter his name as ‘Richard
Peabody’
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HalfSibling
with
Missing
Mother

As can be seen in Figure 10 above, Cameron had a half-brother, Nigel Peabody,
through an earlier marriage of his father. Nothing is known about his father’s first
wife. We will now enter this data. As Cameron’s half-brother is a child of his
father, Philip, the first thing to do is to switch the Property Dialog to view Philip’s
record details. You should by now know how to do this.
Steps
1.

2.

3.

4.

With the Property Dialog showing Philip Peabody’s record details, you should
have 2 spouse tabs: one labelled ‘Naomi’ and one blank one. You don’t know
anything about Nigel Peabody’s mother, except that she wasn’t Naomi Prentice
Salt; so you mustn’t add Nigel as a brother, next to Mary and Cameron as this
would wrongly imply that Naomi was his mother. Instead click on the blank
tab. Both Spouse and Children fields should now be grey.
Click on <click here to add child> in the first child Name field, and select
Create New Record as Child from the menu. Notice that there are now 3
spouse tabs and that the current one is labelled ‘<No Spouse>‘.
Enter “Nigel Peabody” in the first child Name field. Notice that as well as the
Child fields, the Marr. fields are no longer grey. We have not created a record
for Nigel’s mother, but we can still store marriage details if we want to.
Enter M in the first child Sex field.

Suppose Cameron had had 2 same-father half-siblings, would you enter them both
together, or give them a separate spouse tab each? The answer, of course, is that it
depends on whether they shared the same mother or not. If they definitely did, they
must share the same spouse tab. If they definitely didn’t, they mustn’t. If you’re not
sure if they did or they didn’t, you just have to decide which you think is most likely,
and add a note to show that the issue is uncertain.

Re-order Philips marriage to Nigel’s mother preceded his marriage to Naomi, so we must reSpouses order the marriages. The ‘<No Spouse>’ tab should still be current at this point.
Steps
1.

Click on the Move Spouse Up Button to move this marriage ahead of the
marriage to Naomi.

Unknown The next thing is to enter Cameron’s maternal grandparents – that is, the parents of
Surname Naomi Prentice Salt. The steps given below show one way of doing this. They

assume that at this point you are looking at Philip Peabody’s record (check the title
if in doubt).

Steps
1.
2.
3.
4.

5.

Click on the spouse tab labelled ‘Naomi’.
Click on the Go To Spouse Button. The Property Dialog switches to showing
Naomi’s record details.
Click the Go To Parents Button. Naomi is now in the child position.
Add Norman Prentice Salt as Naomi’s father. You should know how to do this
by now, but if you want help, look back at Enter Parent Family Details above,
in this chapter. Don’t forget to put slash characters round ‘Prentice Salt’.
When you do this, a record is created for Norman Prentice Salt and the
Property Dialog caption changes to “Individual: Norman Prentice Salt”.
Now enter details of Naomi’s mother in the spouse position. That is, click on
<click here to add spouse> in the Spouse Name field, and select Create New
Record as Spouse from the menu. Naomi’s mother was named Eliza. Her
maiden name is not known. If you simply entered Eliza and pressed Tab,
Family Historian would convert it to /Eliza/ - meaning that it would treat Eliza
as the surname. This is not what you want. You must enter the surname as
“Eliza //” to show that the surname is not known.
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Add Child Norman and Eliza had 2 children: Naomi and Sally. The next thing is to add Sally.
and Go To We will then ‘go’ to her record, in anticipation of the next step, which is to link her
as the mother of Jean Clare Anderson – Cameron’s second wife.
Child
Steps
1.

2.

Add Sally as a child of Norman and Eliza, and as a sister of Naomi. You
should by now know how to do this. Sally was the younger sister so she should
be entered below Naomi.
Now make Sally’s the current record by clicking on the Go To Child button
at the right end of Sally’s row in the Children section. The title of the
Property Dialog should now read “Individual: Sally Prentice Salt”.

Link to We are now in a position to add Jean Clare Anderson as child of Sally. This differs
Existing from all the cases we have looked at up to now in that we already have a record for
Jean Clare Anderson, so we don’t want to create a new one.
Relative
At this point we are looking at Sally Prentice Salt’s record. There should only be
one spouse tab, and it should have grey fields and a blank label.
Steps
1.

2.

Click on <click here to add child> in the first child Name field, and select
Link Existing Record as Child from the menu. A dialog box appears with a
list of Individuals, previously entered.
Select Jean Clare Anderson from the list, and click on OK. The first child
Name field should show “Jean Clare /Anderson/”, the Sex field should be ‘F’,
and the Birth Date field should show “June 1917”.

You will by now have realised that you can also link an existing record as a parent,
when adding parents, or link an existing record as spouse, when adding spouses.
This tutorial doesn’t walk you through those scenarios. They work exactly the same
way. A point to be aware of, though, is that you always need to know whether you
already have a record for someone or not. If in doubt, you should always check first
before accidentally creating a duplicate record. One way to do this would be to
select the “Link Existing Record...” option, and see if you can find the record in the
list that then appears. If you can’t, you can then press Cancel with no harm done.

The We will complete this chapter by looking at the Property Dialog toolbar. There are
Property 6 buttons on the toolbar, but you may already have noticed that some of these
buttons are only available in Large Mode.
Dialog
Toolbar
In chapter 1, we looked at 2 of the 6 buttons: the Pin (which looks like this
like this

) and the Small/Large Mode button which looks like this

or

or like this

). We will now look at the remaining 4 buttons.

Go To The Go To Record button will locate and select the Records Window entry for the
Record record you are currently looking at in the Property Dialog. The steps below
illustrate this.

Property Dialog
Toolbar

Note: There is also a Go To Record button on the main application toolbar. Do not
confuse this button with the one on the Property Dialog toolbar.
Steps
1.
2.

Find Cameron Peabody’s record in the Records Window and select it.
If the Property Dialog is not already open in Pinned and Large Mode, open it
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and switch it to Pinned and Large Mode now. It displays details for Cameron
Peabody.
3.

Click on the Go To Parents button
. The Property Dialog displays
record details for Cameron’s father, Philip Peabody and switches to Unpinned
Mode.

4.

Click on the Go To Record button
on Property Dialog toolbar. The
record entry for Philip Peabody in the Records Window is scrolled into the
visible portion of the window (if not already there) and selected. You may need
to move the Property Dialog to see it.

Go Back & If you are not already in Large Mode in the Property Dialog, switch to Large Mode
Go now.
Forward The Go Back button is this one: . The Go Forward button is this one: . The
following example illustrates their use:
Property Dialog
Toolbar

Steps
1.
2.

3.
4.

Select Cameron Peabody’s record in the Records Window.
Click on the Go To Parents button The Property Dialog displays record
details for Philip Peabody (and switches to Unpinned mode, if it had been
pinned).
Click on the Go Back button. The Property Dialog displays record details for
Cameron Peabody.
Click on the Go Forward button. The Property Dialog displays details for
Philip Peabody.

This behaviour should be familiar from any Internet browser. Like all navigation
buttons, the Go Back and Go Forward buttons always switch the Property Dialog
to Unpinned Mode, if it wasn’t already unpinned.

Show The Show Sources toolbar button
is discussed in Chapter 10. If you are curious,
Sources click on it now. Then click on it again to return the Property Dialog to its previous
state.
Property Dialog
Toolbar

Save To end the chapter, save the work that you have done.
Changes
Steps
1.

From the File menu, click on Save (or click on the Save button on the toolbar).
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This step presupposes that you have...
Read the Introduction and Chapters 1-3.

You will learn how to...
Add relatives by click-and-dragging in the Diagram Window
Re-order spouses and re-order siblings in the Diagram Window
Cancel click-and-drag actions.
Delete records when working in the Diagram Window

Preamble In Chapters 1 and 4 we added several relatives of Cameron Peabody, using the
Property Dialog. An alternative and, in practice, often better technique, is to add
relatives by clicking-and-dragging in the Diagram Window. This is called
Diagram-based Editing. The advantage of doing it this way is that you can see
visually what you have done, and you can, literally, see a bigger picture. In the
Main tab of the Property Dialog, at any given time, you can see one person, their
spouses, and their children by one of their spouses. In the Diagram Window, at
any given time, you can see as many relatives as you can comfortably fit onto the
screen. This makes it easier to spot gaps and mistakes.
The reason that we did not start first with Diagram-based Editing is that, although it
is not at all difficult to add relatives by clicking-and-dragging in a diagram, you do
need first to understand the diagrams, and what they are showing you. Also,
Diagram-based Editing makes use of the Property Dialog too, and can be combined
in any way you like with the techniques we have already learned.
In this chapter we will add some new relatives using Diagram-based Editing. We
will add 2 spouses for Daniel Peabody: Pamela Jean Winters and Isabel Thompson.
We will add 3 children for Daniel and Pamela (Michael, Anthony and Robin
Peabody), and a 4th for Daniel and Isabel (Charles Peabody). We will re-order
Daniel’s spouses. We will make Sally Prentice Salt the older sister of Naomi
Prentice Salt. We will add a father, Thomas Andrews, for Fiona Andrews.

Automatic
Source
Citations

It is a good idea to record the sources for all your data. Sources and source citations
will not be covered till Chapter 10; but it is worth mentioning automatic source
citations now as this is an important feature which works well with Diagram-based
Editing. The idea of automatic source citations is that you can specify a source and
citation details, and all new data will get that citation until you cancel it. For now,
the important thing to realise is that this works just as well with Diagram-based
Editing as it does with any other kind of editing. So you can use Diagram-based
Editing and still fully document your sources effortlessly.
See “Set Automatic Source Citations” in Chapter 10 for more details.

Open a File Start by opening the file from Chapter 4.
Steps
1.

From the File menu, click on Open (or click on the Open button on the
toolbar). Locate the file you saved at the end of Chapter 4. It should be called
“Tutorial – Chapter 4” (it will have a “.ged” suffix, if you are displaying them).
Press OK.

If you skipped chapter 4, or read it but didn’t create your own file, use the ‘pre-
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cooked’ version (see “Tutorial Files (referred to in the manual)” on the Help
menu).

Save As You should save the file now under a new name. See the discussion in the Save As
section in Chapter 4, for the reasons for this.
Steps
1.

From the File menu, click on Save As. Use the same folder as before and save
the current file as “Tutorial – Chapter 5”. Press OK.

Trees vs. Up to now, we have not clearly distinguished diagrams from trees. But henceforth
Diagrams they will need to be distinguished properly.
In Family Historian, a diagram is everything that can be displayed in the Diagram
Window. A tree however has a more specific meaning. A tree is an arrangement of
lines and boxes within a diagram. There are 4 types of tree, corresponding to the 4
types of diagram: Ancestor, Descendant, Ancestor & Descendant, and All Relatives.
When you first create a new Ancestor diagram it contains a single Ancestor tree.
When you first create a new Descendant diagram it contains a single Descendant
tree. And so on. But you can insert additional trees of any type, into any diagram as many as you like.

If the Tree
Will Show
It, You Can
Add It

You can use any Family Historian diagram for Diagram-based Editing – not just the
4 default diagram types but also all pre-configured standard and custom diagrams.
You can also use any type of tree for Diagram-Based Editing. However, there is
one golden rule: you can only add a relative to a tree if, when added, that relative
would be displayed in that tree. For example, suppose you are viewing an Ancestor
tree, you cannot add a child or a spouse to the tree root because the Ancestor tree
does not display children or spouses of the root. But you can add parents (if not
already there), or add parents to the parents, etc, because these will be displayed.
Note that this rule applies to trees, and not to diagrams.
You might be tempted to think that in the All Relatives tree, you must be able to add
anything, but that is not correct: even an All Relatives tree only shows relatives of
the tree root – it doesn’t show everyone. Fiona Andrews is Cameron Peabody’s
daughter-in-law. By our definition of relative (see Preamble at the start of Chapter
3) Fiona Andrews is Cameron Peabody’s relative by marriage. But her father isn’t a
relative of Cameron Peabody’s – not even a relative by marriage. So although you
may be able to see Fiona Andrews in an All Relatives diagram for Cameron
Peabody, you still can’t add a parent for her by clicking-and-dragging on her box. 6

Installation We will start by adding 2 spouses for Daniel Peabody: Pamela Jean Winters and
Settings Amanda Thompson. As we have seen, any diagram will do which displays all

spouses for Daniel Peabody – i.e. any diagram type, except Ancestor diagrams. We
will use the All Relatives diagram with Cameron Peabody as the root. Open such a
diagram now.
There is no particular set of diagram options that you need for Diagram-based
Editing, but for the purposes of this tutorial, it is useful to be able to specify a welldefined set. The easiest set of options to specify is the installation settings.
Steps
1.

Click on Restore Installation Settings on the Diagram menu.

6

See Click-and-Drag to Add Parent below, for suggestions as to how you can add a parent for Fiona
Andrews.
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2.

If for some reason you wish to preserve your default settings, click ‘No’ when
asked if you want to update your default settings. Otherwise, click ‘Yes’.

Tip: It is not required, but it’s usually a good idea to use Spouses in Own Box as
the Spouse Display Option, when doing Diagram-based Editing, especially if you’re
planning to add children.

Status Bar If you don’t know what the status bar is, find it now. In the bottom left corner of
the main application window (also known as the frame window) you should see the
text ‘For Help, press F1’. The area occupied by that text, and stretching beyond it
the full length of the window, is the status bar. It doesn’t hurt to look at it from time
to time. Sometimes (as when doing Diagram-based Editing) it displays useful
information.

Click-and- Arrange the diagram so that you can see Daniel Peabody with space to spare around
Drag to his box.
Add
Spouse Steps
1.

2.

Click-andDrag to
Add 2nd
Spouse

Click on the box, and, keeping the button pressed, drag the mouse to the right,
until the mouse is roughly in the area that a spouse of Daniel Peabody’s would
be displayed if he had one. If you did this correctly, a dotted box should appear
to the right of Daniel Peabody’s box. You may just be able to see 2 dotted
marriage lines connecting the dotted box to his box. The status bar should
display the text “Add Spouse”. Release the mouse button.
A context menu appears with 3 options: Add Spouse (new record), Link
Existing Record as Spouse, and Cancel. Select Add Spouse (new record). An
empty spouse box appear to the right of each instance of Daniel Peabody’s box
and the Property Dialog appears (in Small mode unless you changed
Preferences). Its title reads “Individual: <no name>“. Enter the name ‘Pamela
Jean Winters’ for the new spouse and press Tab. The spouse boxes, next to
Daniel’s box in the diagram, now show the text ‘Pamela Jean Winters’.

Make sure that you can see both Daniel Peabody and Pamela Winters clearly, and
that you can see the area to the right of Pamela Winters’ box. We are going to add a
2nd spouse for Daniel Peabody – 2nd not just in the sense that it’s the 2nd one we add,
but also in the sense that she was the 2nd person that Daniel Peabody married.
Steps
1.

Click on either of the Daniel Peabody boxes, and, keeping the button pressed,
drag the mouse to the right again. This time you must drag further than before,
until the mouse is roughly to the right of Pamela Winters’ spouse box. When
you can see the dotted box to the right of Pamela Winter’s box, and the text
“Add Spouse” in the status bar, release the mouse button and create a new
record for Daniel’s 2nd wife (i.e. Click on Add Spouse (new record), etc). Her
name is ‘Isabel Thompson’.

If Isabel Thompson had been Daniel Peabody’s first spouse, you could have added
her as such by clicking on Daniel Peabody’s box, and dragging to the left.

Click-andDrag to
Add
Children

We will now add 3 children for Daniel and Pamela. You could click-and-drag on
Daniel’s box to add a child for him and Pamela – but only because Pamela is his
first wife. Its probably better to get into the habit of clicking and dragging on
spouses to add children, because this produces the results you want for all
marriages, and not just the first.
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Steps
1.

2.

3.
4.

5.

Cancel
Click-andDrag

Click-and-drag on Pamela Winters’ box – dragging downwards. A dotted box
should appear below and between her and Daniel’s box. A dotted line should
go up from it, to meet the double (‘marriage’) lines connecting Daniel and
Pamela. The status bar should display the text “Add Child”. Release the
button.
The context menu this time should show 5 options:
 Add Son (new record)
 Add Daughter (new record)
 Add Child (new record)
 Link Existing Record as Child
 Cancel
Click on Add Son (new record) and enter the new child’s name as “Michael
Peabody” in the Property Dialog.
Repeat steps 1 and 2 to add another son, Anthony. Add Anthony as the
younger brother of Michael – that is, make sure you drag both downwards and
slightly to the right, so that the dotted box overlaps the right half of Michael
Peabody’s box. When you release the button, the new box should be created to
the right of Michael Peabody’s box (younger children always display to the
right of older children).
Finally, repeat steps 1 and 2 again, to add another son, Robin. Although you’re
adding him last, let us assume that he was actually the middle child of the 3. To
add him as such, you should drag downwards and roughly between Michael and
Anthony’s boxes.

If you want to cancel a click-and-drag, while doing it, you can either press the Esc
key, or press the right mouse button, before releasing the left mouse button. Or you
could simply release the mouse button, at a time when no dotted box was displayed.
Or, you could just release the mouse button. If a context menu appears, you can
cancel it by clicking anywhere other than the menu, or by clicking on the Cancel
menu command. You will only get a context menu if there had been a dotted box
(indicating a relative that could be validly added) at the point where you released the
mouse button.
So do not be afraid to experiment. Clicking-and-dragging on boxes will not result
in new records accidentally being created. Nothing will happen unless you
explicitly click on a menu to indicate that you want a record to be created or linked.

The Dotted With that in mind, click-and-drag again on Pamela’s box. Don’t release the mouse
Box button, but drag out of her box, and then move the mouse in a complete circle round
her box. You should find, if you draw a wide enough circle, that there are 4
possible positions that you can drag to which will result in dotted boxes appearing –
all different positions for a new child for Pamela and Daniel. When you drag above
Pamela’s box or to the side of it, you see a dotted line connecting her box to the
mouse position, but no dotted box. If you look at the status bar at these points, you
will see a message explaining why you cannot add a relative at these points.
You will have gathered by now that a dotted box indicates that Family Historian
will create a relative for you if you want it to – and the position of the box indicates
what kind of relative it will be, and where it will fit in relative to other relatives.
Cancel the drag round Pamela’s box without creating any new relatives. Try the
same with Daniel’s box. There are 8 possible positions where you could create
relatives for him (4 spouse positions and 4 child positions). Can you find them all?
Why couldn’t you add a parent for Pamela? Why couldn’t you add a parent for
Daniel? (hint: keep your eye on the status bar while dragging).
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Add Child
for 2nd
Spouse

You should by now know how to add a child for Daniel and Isabel. The only
significant point is to remember to click and drag on Isabel’s box, and not on
Daniel’s box. Do it now, and create a son for the 2 of them called ‘Charles
Peabody’.
Hint: drag downwards, make sure you can see a dotted box before you release the
mouse button, and look at the status bar if you want confirmation that you’re doing
the right thing (or an explanation if no dotted box appears). Don’t worry if the box
isn’t aligned with other children that Daniel has.

Re-order Re-ordering spouses if very simple. We will now make Isabel Thompson Daniel’s
Spouses first spouse to illustrate this.
Steps
1.

Click on Isabel Thompson’s box.

2.

Click on the Move Up button
now displayed as

on the main toolbar. Isabel Thompson is

Daniel’s first wife.

Re-order The same buttons are used for re-ordering siblings. We will now make Sally
Siblings Prentice Salt the older sister of Naomi Prentice Salt. Arrange the diagram so that

you can see Naomi Prentice Salt, and her sister Sally. Ordinarily when you re-order
a pair of siblings, you could click on either of the siblings and move that. But in this
All Relatives diagram, Naomi only appears in an Ancestor box. So in this case, we
must use Sally’s box.
Steps
1.

Click on the box for Sally Prentice Salt.

2.

Click on the Move Up button
older sister.

on the main toolbar. Sally is now Naomi’s

Crossed Unlike other trees, you can get lines crossing over each other within All Relatives
Lines trees, as you do now with this one. This only occurs with horizontal dotted line
connections to ancestors.

Click-andDrag to
Add Parent

Lastly, we will add a father, Thomas Andrews, for Fiona Andrews. Fiona should be
visible in the current diagram. Try adding a father to her now by clicking-anddragging upwards. You should find that the status bar says “Can’t add parent – this
diagram does not display parents of spouses”.
So how can we add her father? Of the various ways you could do it, here are 4:





You could change the diagram to one in which Fiona Andrews’ father would be
displayed (such as an All Relatives diagram for Fiona Andrews), and click-anddrag.
You could open a second Diagram Window alongside the current one, and add
him in that (see Lock Current Window and Working with Multiple Diagram
Windows in Chapter 7).
You could insert an All Relatives tree for Fiona into the current diagram, and
click-and-drag on her box in that, to add a parent.
You could use the Property Dialog (in Large Mode) to add a father for her.

All 4 are quite reasonable options. Certainly there is no problem about using a
combination of Diagram-based Editing and Property Dialog-based editing. The
results will be the same, and the diagram will update itself to show the correct
information, irrespective of where the change occurred (if you have multiple
Diagram Windows open, you will find that if you edit one, they will all update
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themselves to show the latest information). However, as the focus in this chapter is
on Diagram-based Editing, and as we won’t cover using multiple diagram windows
until Chapter 7, we will use the first option.
Steps
1.

2.
3.

4.

Select
Multiple
Boxes in a
Diagram

Display an All Relatives diagram for Fiona Andrews (e.g. click on her box
within the current diagram and then click on the All Relatives button
on the
toolbar).
Click-and-drag upwards on her box. When the dotted box appears, release the
mouse button.
A context menu appears with four options: Add Father (new record), Add
Mother (new record), Link Existing Record as Parent, and Cancel. Select Add
Father (new record).
A new box is created and the Property Dialog appears. Enter the name of the
new parent as ‘Thomas Andrews’.

The Diagram Window allows you to select as many boxes at a time, as you want.
One technique to do this is to click in the background of the diagram and holding
the mouse button down drag the mouse to form a stretchy box, to surround all the
boxes you want to select. If you zoom far enough out, you can easily select all the
boxes in a diagram using this technique.
Alternatively (or additionally – because these two techniques can be combined) you
can add or remove individual boxes to, or from, an existing selection by pressing the
Ctrl key, while clicking on a box. So if you press the Ctrl key and click on 5
unselected boxes in turn, all 5 boxes will be selected.
Selecting multiple boxes is useful for a number of purposes. You can select records
for deletion, or records that you want to set Records Flags for (see Record Flags on
the Edit menu). You can mark boxes or hide them (see chapters 7 and 9
respectively). All of the Box States (Diagram menu) can be set or cleared using a
multiple selection. If you have a multiple selection when you click on View
Multimedia
, the Multimedia Window will show all multimedia objects for all
selected records.
The Multimedia Window is discussed in Chapter 9.

Deleting
Relatives
in a
Diagram

You can delete one or more of the Individual records displayed in a diagram, by
selecting them and pressing the Del key (or clicking on Edit > Delete). A
confirmation dialog will appear, asking you if you want to delete selected diagram
items, or if you wish to delete actual data records. When you delete a diagram item,
no change is made to the data in your records. It is just your diagram that you are
changing. But if you choose to delete data records – you are not just altering the
current diagram. You are deleting actual records. Consequently, if you take the
latter option, a second confirmation dialog will be displayed and you will have to
tick a box in that to confirm that you know what you are doing.

Make
Regular
Backups

Effectively then, before you can delete any records from a diagram, you have 3
levels of confirmation to get through (that is, two dialogs and a tick box) before the
records are actually deleted. Consequently there should be no way that anyone
could accidentally delete any records while working on a diagram. Nevertheless, if
your data is of value to you, you should take regular backups anyway!
Remember that backups protect you not only from hardware and software
errors, but probably most importantly of all, against your own mistakes!
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Save Finally, save the work that you have done.
Changes
Steps
1.

From the File menu, click on Save (or click on the Save button on the toolbar).
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This step presupposes that you have...
Read the Introduction and Chapters 1 & 2.

You will learn how to...
Use the Details tab of the Property Dialog
Handle more special cases - e.g. where a person is not known by their first name
Add events and attributes to an Individual
Specify age information
Create custom attributes and custom events
Use advanced date types, and the Date Entry Assistant Dialog
Re-order fields
Sort the event/attribute list
Work with child events
Add Local Notes and Family Notes
Create Note records
Link to existing Note records

Preamble In previous chapters, you created a file containing 24 individuals – nearly all of
them relatives of Cameron Peabody. In this chapter, you will add more details
about Cameron Peabody and his relatives. The new data will illustrate how to use
all but one of the as yet unexplored tabs on the Property Dialog.
You will begin by changing the details about Jean Clare Anderson (Cameron’s 2nd
wife) to record the fact that she was always known not as ‘Jean’ but as ‘Jean Clare’.
You will record the fact that Richard Peabody was Sir Richard Peabody, and that
Norman Prentice Salt was Lord Dalhousie.
You will then record the following facts about Cameron Peabody: Cameron
Peabody was always known as ‘Ron’ to his friends. He was tall and slim. He lived
in Lewisham, London from 1906 to 1922, and then in Durban, South Africa from
1922 to 1926. He and Sarah Watts took up residence in Cape Town after their
marriage and lived there until they divorced in 1935, when Cameron was 34. The
divorce was an amicable one, and no third parties were involved. Between 1907
and 1911 Cameron attended a boy’s school, Clarence House, in Lewisham, London.
He worked as a printer for 3 years, between 1923 and 1926 in Durban. His hobby
was watch-repairing. Cameron Peabody died sometime in the 1970s (exact date not
known) of a stroke.
You will add the following note about Cameron: “A quiet, introverted individual, he
read widely, and struggled hard to make up for the fact that he had had little formal
education as a child”.
You will add the following note about Cameron’s marriage to Jean Clare: “Jean
Clare and Cameron were a devoted couple who, from the day of their marriage,
never spent a night apart”.
You will also create the following note “The Prentice Salt family may be related to
the Salts of Cornwall.”, and link this note to all Prentice Salts.

Open a File Start by opening the file from Chapter 5.

49

Chapter 6 – Events, Attributes and Notes

Steps
1.

From the File menu, click on Open (or click on the Open button on the toolbar).
Locate the file you saved at the end of Chapter 5. It should be called “Tutorial
– Chapter 5” (it will have a “.ged” suffix, if you are displaying them). Press
OK.

If you skipped chapter 5, or read it but didn’t create your own file, use the ‘precooked’ version (see “Tutorial Files (referred to in the manual)” on the Help menu).

Save As You should save the file now under a new name. See the discussion in the Save As
section in Chapter 4, for the reasons for this.
Steps
1.

From the File menu, click on Save As. Use the same folder as before and save
the current file as “Tutorial – Chapter 6”. Press OK.

Name Used Locate Jean Clare Anderson’s record and display it in the Property Dialog (e.g.
double-click on her record in the Records Window). Now record the fact that she
was always known as ‘Jean Clare’.
Steps
1.
2.

Click on the Details tab.
Enter ‘Jean Clare’ in the Name Used field

‘Name Used’ really means ‘Given Name Used’. Sometimes people are known by
their middle names. Had Jean Clare Anderson been known as ‘Clare’, for example,
you would enter ‘Clare’ as Name Used. Where a person is known by his or her first
name, you should leave Name Used blank.
Figure 11
The Detail tab of the Property
Dialog. Jean Clare Anderson’s
Given Name Used has been set to
‘Jean Clare’
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The Details Now navigate to Cameron Peabody’s record. Switch to Large Mode if you aren’t
Tab already in Large Mode (see Chapter 1 if you’re not sure how to do that). Notice, on
the Main tab, that the spouse tab for Jean Clare Anderson is now labelled ‘Jean
Clare’. Switch to the Details tab and enter further details about Cameron Peabody.

Steps
1.
2.
3.

Enter “Ron” in the Nickname field.
Enter “Tall, slim” in the Description field.
Enter “Stroke” in the Cause of Death field.

The Main tab displays key facts about an Individual. The Details tab displays a few
more key facts, for which there wasn’t room in the Main tab.

Titles, Now add titles for Richard Peabody and Norman Prentice Salt.
Name
Steps
Prefixes,
Name 1. Navigate to Richard Peabody’s record (he was Cameron’s paternal grandfather)
Suffixes
and select the Details tab.
2.
3.
4.

In the Name Prefix field, enter “Sir”.
Navigate to Norman Prentice Salt’s record and select the Details tab.
In the Title field, enter “Lord Dalhousie”.

Do not enter name prefixes such as ‘Sir’, ‘Mr’, ‘Dr’, ‘Lt. Cmndr.’ etc. in the Title
field. They should all go in the Name Prefix field. The Title field should be used
to store complete titles of nobility or royalty, such as “Lord Dalhousie”.
The Name Suffix field is used for any text that should be appended to a person’s
name. For example, ‘Jr.’ could be a name suffix, as in ‘Sammy Davis Jr.’

The Events Navigate back to Cameron Peabody’s record, and click on the Events tab of the
Tab Property Dialog.
The first and most important thing to know about the Events tab is that it doesn’t
just deal with events! In fact, the Events tab covers both events and attributes
(events and attributes are sometimes called facts in Family Historian).
Everyone should know what an event is: Birth, Death, Christening ... are examples
of events.
An attribute is anything that is associated with a value. For example, Occupation is
an attribute, the value for which would be ‘printer’ in Cameron Peabody’s case.
Another example is Count of marriages. In Cameron’s case, the value for this
attribute would be ‘2’.
In a sense, Name and Sex are both attributes too; but in Family Historian (and
GEDCOM), you will not see name and sex information listed under ‘Attributes’. If
you like you can think of them as attributes which are too important to be listed with
the other attributes.
You will notice that the top half of the Events tab (the Events/Attributes List)
already shows some events and attributes. Some events and attributes can be
displayed (or entered) on more than one tab of the Property Dialog.
You may be wondering why there is the ‘Died’ event. This is because you entered
Cameron Peabody’s Cause of Death as a stroke. Cause of Death is always
associated with the Death event; so Family Historian created one for you. Select
the ‘Died’ row now (click on the line in left-hand column). You will see that the
details of the Death event are all blank, except that the Cause value is ‘stroke’ (see
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Figure 12 below).
Figure 12
The Events tab of the Property
Dialog. The fields in the bottom half
of the dialog show details about the
fact selected in the list. In this case
they are showing details of
Cameron’s death.

Date We will now set Cameron’s date of death as being some time in the 1970s
Ranges
Steps
1.
2.
3.

Click on the button with 3 dots next to the Date field. The Date Entry
Assistant Dialog appears.
Click on the Range tab and select Between as Specifier (see left hand side of
dialog)
Leave the Calendar values as ‘Gregorian’ (this is the calendar used in the
Western world today). Enter ‘1970’ in the top row Year field, and ‘1979’ in
the bottom row Year field. The dialog should look like Figure 13 below.
Leave other rows as they are and press OK. The Date field displays “btw
1970 and 1979” (you could of course perfectly well just have typed that in – but
the intention was to illustrate use of the Date Entry Assistant Dialog).

For more information on date ranges, and other types of date, see the box Advanced
Date Types and the Date Entry Assistant Dialog below.

Add Event We will now enter details of the divorce between Cameron and Sarah Watts.
Steps
1.
2.
3.

Click on the Add Event/Attribute button
on the toolbar below the list.
A dialog appears with a list of types of event or attribute. The title says
“Event/Attribute List”. Find Divorce in the events list and select it. Click Add.
Another dialog appears titled “Select Family”. Select the Family Record “…of
Cameron PEABODY and Sarah Marie Watts” and press OK. The dialog closes
and the event is added to the events list.

52

Chapter 6 – Events, Attributes and Notes

4.
5.
6.

In the Date field, type ‘1935’ and press Tab.
In the Age field, type ‘34’ (Cameron’s age at the time) and press Tab.
In the Notes field, type “The divorce was an amicable one, and no third parties
were involved” (double-click on the Notes field to open a separate Note
window to type the note into, if you prefer).

Tip: The Event/Attribute List may contain events or attributes that you never use. If
so, you can hide them to make it easier to find the ones you do use. Click on the
More >> button when viewing the Event/Attribute List; then select the events or
attributes you are not likely to need and click the Hide button. You can always
unhide them again later if you change your mind. Click the Help button for more
help on how to do this.
Tip: A quick way to scroll down to the ‘Ds’ in the list is to click on any item in the
list, and then press the D key. This technique works for most lists in Family
Historian if sorted in alphabetical order.

Figure 13 – the Range tab of the Date Entry Assistant Dialog

2 Types:
Individual
& Family

There are fundamentally 2 kinds of events in Family Historian: Individual events
and Family events. In Individual events, one individual only is the principal
participant (examples would be Birth, Christening, Death, etc). In Family events,
it is a couple who are the joint primary participants (examples would be Marriage
and Divorce). Family events are effectively shared between the 2 primary
participants.
Exactly the same distinction applies to attributes. All of the standard attributes that
Family Historian provides are Individual attributes, but as we shall see later, when
you create custom attributes, you can create custom attributes for families too.
You can tell at a glance whether a listed event or attribute is an Individual one or a
Family one. Individual events or attributes have a blue circle next to them: .
Family events and attributes have a red circle next to them:
.
As we saw, Divorce is a family event. This means that both Cameron Peabody and
Sarah share this event equally. To confirm this, navigate to Sarah Watts record7,

7

Here are 3 different techniques for doing this: (1) Click on the Main tab now, click on Sarah's spouse
tab, and then click on Go To Spouse. Here you are using the Property Dialog 'standalone'. (2) You
could use any technique you like to locate Sarah in the Records Window, then either double-click on
her record or select her record and click on the Properties button on the main toolbar. (3) You could
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and then click on the Events tab to view her events. Notice that she too now has a
Divorce event (‘Divorce from Cameron’). Select it (by clicking on the date in the
first column). Notice that the Date for this event is ‘1935’ and that the Note is as
you entered it. If you had specified a Place and a Cause, they too would have
appeared, as you had entered them. The only field for this event which does not
appear as you entered it, is Age.

Age Even with Family events, when you specify a value for Age, you are always
specifying the age of the Individual whose record you are looking at, at the time of
the event. Cameron was 34 when he was divorced. Sarah’s age at the time is not
known. In the Events/Attributes List, her age (right-most column) is given as “(2728)”. The brackets are there to show that this is data that Family Historian has
computed for you – which it will only do if no actual age has been entered.
If your sources of information do not include the age of a participant in an event,
you should not enter anything in the age field – even if you think you can work out
what it must have been. Family Historian, after all, does that for you anyway.
If you do enter an Age value, Family Historian will display it as entered. However,
it will add “(!)” after the value, if it thinks that this value cannot be correct (or at
least, that the Age value, the event date and the individual’s recorded Birth date
cannot all be correct). Try this now. Enter the values of 27, 28 and 29, in turn, for
Sarah’s age at the time of the divorce (press Tab or click elsewhere, between
entering each number, to get Family Historian to ‘register’ each value). Notice that
‘27’ and ‘28’ display as entered (because both are possibly correct), but when you
enter ‘29’, the listing actually displays ‘29 (!)’.
Now clear the Age field, and navigate back to Cameron Peabody’s record (hint:
click on the Go Back button).

Add Cameron lived in Lewisham, London from 1906 to 1922, and then in Durban, South
Attribute Africa from 1922 to 1926. Add that information now. You should be looking at the
Event tab for his record at this point.

Steps
1.
2.
3.
4.
5.

Click on the Add Event/Attribute button
on the toolbar.
Select Residence and click Add (or just double-click on Residence).
In the Date field, enter “From 1906 to 1922” and press Tab.
The ‘value’ of a Residence attribute is a place. So enter the value “Lewisham,
London” in the Place field now and press Tab.
Repeat Steps 1-4, only this time enter “From 1922 to 1926” as the Date, and
enter “Durban, South Africa” in the Place field.

Tip: When you started typing “Durban, South Africa” did you notice that Family
Historian guessed that this was what you were going to type after the first ‘D’? This
is because there is already a “Durban, South Africa” as a place in the current file. If
Family Historian guesses correctly, just click tab to accept its suggestion. If Family
Historian’s guess is wrong, just ignore it and keep typing.
Tip: Double-click on any place field (or click on the little button with 3 dots
at
the end of the place field) to view a complete list of all places that have been entered
into the program. You can click on an item in the list and press Select to select one.
Or, if you click on the More >> button, you can find more options. Using this
powerful dialog you can even spot and correct misspellings and inconsistencies in
place names throughout the file. Click the Help button for more details.
select her record in the Records Window and click on the Pin on the Property Dialog toolbar, to switch
the Property Dialog into Pinned Mode (if it isn't already in Pinned Mode).
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Custom Cameron and his first wife Sarah were both resident in Cape Town between 1926
Attributes and 1935.
In GEDCOM, Residence is always an Individual attribute. Obviously one could
enter the same attribute for Sarah and Cameron, to show that they both lived in Cape
Town during this period. But that would be consistent with them living in separate
houses. What we really want is a similar attribute that applies to couples.
GEDCOM doesn’t provide one, but it lets you make up your own custom attributes;
so that is what we shall do.
You should still be looking at the Event tab for Cameron Peabody’s record at this
point.
Steps
1.
2.
3.
4.

5.

Click on the Add Event/Attribute button
on the toolbar.
Click on the More >> button in the Event/Attribute List dialog
Click on the New… button.
Enter “Co-residence” as the Fact Name. Change the Fact Type to “Attribute”.
Change the Record Type to “Family”. Leave the Fact Set name as “Custom”.
Click on the Create button.
The Fact Definition dialog box appears. Leave the Label as ‘Co-residence’.
Add ‘Resident’ as the Abbreviation. Change the Template to read as follows:
{date}{couple} lived {place}

6.

7.

8.
9.

The template determines how facts about Co-residence will appear in Narrative
reports.
Press OK. You should now be viewing the Event/Attribute List dialog.
Confirm that there is a new attribute, Co-residence, in the list (with a red dot to
show that it is a family attribute). Select it and click on the Add button.
Another dialog appears titled “Select Family”. Select the Family Record “…of
Cameron PEABODY and Sarah Marie Watts” and press OK. The dialog closes
and the event is added to the events list.
Enter “Cape Town, South Africa” in the Co-residence field. Press Tab.
In the Date field, enter “From 1926 to 1935” and press Tab.

For every event and attribute, Family Historian allows you to enter a date and a
place. In some cases, these fields may not be appropriate (e.g. Place is not useful
with Co-resident, as you have already specified the place effectively). You should
use the Date and Place fields if appropriate, and ignore them if not.

Married Family Historian does not provide a standard attribute for married names. If you
Names wish to store married names for women, you should create a Custom Attribute (for
an Individual), called “Married Name”, and use that. This is not illustrated in this
tutorial.

Custom The procedure for entering custom events is not significantly different from the
Events procedure for entering custom attributes - see Custom Attributes above.
Occasionally it may happen that you want to enter some data about something that
isn’t really quite an event or an attribute. For example, suppose you wanted to
record the fact that a person X was alive in 1986. Being alive is not an event, in any
usual sense of the term (it is really a state), but you shouldn’t let that put you off
entering it as an event (a custom event8). As with most labels in Family Historian,
do not feel obliged to interpret them too literally.
8

If you’re not averse to Latin, some genealogists use ‘Floruit’ as a kind of event, to mean ‘was alive
at…’, or (more literally) ‘flourished at …’.
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More Between 1907 and 1911 Cameron attended a boy’s school, Clarence House, in
Attributes Lewisham, London. He worked as a printer for 3 years, between 1923 and 1926 in
Durban. His hobby was watch-repairing. Education and Occupation are both
standard attributes for Individuals.

Hobby: Hobby is not a standard attribute. We shall first enter it as a custom attribute.
Another
Steps
Custom
Attribute
1.
2.
3.
4.

5.

Click on the Add Event/Attribute button
on the toolbar.
Click on the More >> button in the Event/Attribute List dialog
Click on the New… button.
Enter “Hobby” as the Fact Name. Change the Fact Type to “Attribute”.
Leave the Record Type as “Individual”. Leave the Fact Set name as
“Custom”. Click on the Create button.
The Fact Definition dialog box appears. Leave everything as it is except
change the Template to read as follows:

{individual's} hobby was {value} {date} {place}
Enter this exactly as specified here. If you forget the apostrophe in the first
word, or add extra spaces, it won’t work! You can use the << Insert Code
button if you wish to help you build up this sentence. To get the first code
“{individual’s}” select “Name of Individual (or His/Her)” from the menu that
appears when you click on << Insert Code.
6. Press OK. You should now be viewing the Event/Attribute List dialog.
Confirm that there is a new attribute, Hobby, in the list (with a blue dot to
show that it is an individual attribute).

Quick
Ways to
Enter
Multiple
Events and
Attribute

Adding events and attributes to records is something you should expect to do often;
so it is well worth taking the time to learn some techniques for making it easier and
quicker. If you know that you are going to add several events and/or attributes to
add, it makes sense to save time by adding them all in one go. Here’s how you can
do this.
Steps
1.
2.
3.
4.

Click on Education.
Press-and-hold the Ctrl key, and click on Occupation (you may have to
scroll to find it).
Press-and-hold the Ctrl key, and click on Hobby (our new custom attribute
– again you may have to scroll to find it).
Click Add. All 3 attributes are added in one go.

Tip: An alternative technique which you may prefer is to uncheck Close Dialog
After Adding at the bottom of the Event/Attribute List dialog. Then you can browse
through the list double-clicking on each item to add it. You may wish to move the
Event/Attribute List dialog to one side so that you can see the events and attributes
being added to the Events list in the Property Dialog when you do this.
Tip: Like many dialogs in Family Historian, the Event/Attribute List dialog is
resizable. Click-and-drag on any corner to make it the best size and shape for your
needs. It will remember its size and position throughout the session.

Supply We have now added 3 attributes to Cameron’s list. We will now supply more
Missing details about each of them. You should still be in the Event tab of the Property
Dialog.
Details
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Steps
1.

2.
3.
4.
5.

6.
7.

8.
9.

Click in the left column, on the horizontal bar where a date would be if
there was one, for the Educ. attribute. The fields below the list change to
show education details.
Enter “Clarence House” into the Education field.
Enter “from 1907 to 1911” into the Date field.
Enter “Lewisham, London” into the Place field.
Click in the left column, on the horizontal bar where a date would be if
there was one, for the Hobby attribute. The fields below the list change to
show hobby details.
Enter “Watch-repairing” in the Hobby field. Press Tab.
Click in the left column, on the horizontal bar where a date would be if
there was one, for the Occupation attribute. The fields below the list
change to show occupation details.
Enter “Printer” into the Occupation field.
Enter “from 1923 to 1926” into the Date field.

Advanced Date Types and the Date Entry Assistant Dialog
You will probably have noticed that every date field has a button at the end of it: . Find a sample
date field (e.g. the one in the Events tab of the Property Dialog) and click on the dotted button. The
dialog that appears is the Date Entry Assistant Dialog. Figure 13 above shows the Range tab of this
dialog. If you click on the various tabs of this dialog, you will see that Family Historian (and
GEDCOM) supports multiple calendars, simple dates, date ranges, date phrases (interpreted or not),
periods and quarter dates. The Date Entry Assistant Dialog makes it easy to specify all these different
kinds of date values. Simply choose the date type that you want, enter the details into the dialog, and
press OK. The Date Entry Assistant Dialog will then put the appropriate text into the Date field.
The difference between a period and a range is this: a date period is used for something that occurred
over a period of time (e.g. Residence). A date range is used for something that occurred on a specific
date, but you are not sure what it is. For example, we know that Cameron Peabody died some time in
the 1970s. This is a date range, between 1970 and 1979. Don’t use date ranges if all you know is that
an event occurred in a particular year. Just enter the year without specifying the month or day.
Equally you if you know the year and month but not the day, just omit the day.
The Date Phrase option is very useful for cases where you don’t know the date but you have a textual
clue as to when it occurred (e.g. “5 weeks after his wife died”). You should enter the text as a Date
Phrase. If you think you know what the corresponding date is, you can specify that too.
If you enter a date in a date field in a format that Family Historian does not recognise, it will always
assume that you have entered a Date Phrase, and put double-quotes round the text to show this.
There is no need to stick too literally to the intended role of this date type. If you want to include a
note with a date, you could use a Date Phrase and add the date as the ‘interpretation’.
Tip: Double-click on a date field as an alternative way of opening the Date Entry Assistant Dialog.

Dateless It will frequently happen that events and attributes have no date. Wherever an event
Attributes or attribute has no associated date, the Date column of the Event/Attribute listing

will contain a line. You should not interpret this line as implying that your data is in
any sense incomplete! In the case of some attributes, a date may not even be
meaningful or relevant.
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Multiple You can have as many instances as you like of any attribute or event - custom or
Instances standard. If, for example, Cameron had been educated in 2 schools and a university,
you should enter 3 Education attributes: one for each. Likewise with Occupation.
You should be aware, however, that whereas the Events tab will show all instances
of all the attributes (and events) that you enter, the Main tab, by contrast will only
show one Occupation attribute, and the Details tab will only show one instance of
Education and other attributes.

The Occupation attribute displayed in the Main tab is actually the first instance of
an Occupation attribute for the given record. This is not necessarily the occupation
which has the earliest date – it is first in the order in which the attributes are stored
in the record. You can see this order by looking at the attributes in the All tab of the
Property Dialog. Attributes are initially stored in the order that they are created,
but as you will see in a moment, you can change this ordering.
Does it matter which occupation is listed first? Not necessarily. The main reason
that the Occupation attribute is included on the Main tab of the Property Dialog, is
to make it easier for you, the user, to recall, at a glance, who this person is. If you
had 15 Cameron Peabody’s in your file (not at all unusual to have many individuals
with the same name), it may help you to mentally categorise one as the printer
Cameron Peabody, and another as the judge Cameron Peabody (say). So, if you
have multiple instances of an attribute, you should probably choose the one that you
associate most closely with the Individual, to be the first instance. This applies to
attributes displayed in the Details tab too.
Having said the above, many individuals will only have one Occupation attribute or
one Religion attribute, and none should have more than one value for Count of
Children or Count of Marriages. The other reason why some of these attributes
are included on the Main and Detail tabs is just convenience. You can enter and
edit their values there, rather than having to switch to another tab (although, of
course, if you want to include further details of dates, places, addresses and notes
with the attribute, you can only do that on the Events tab).

Automatic
Ordering of
Events and
Attributes

Family Historian will, by default, store all events and attributes in date order – but
only if you enter them or edit them using the Property Dialog (All tab excepted). If
you use ‘low-level editing’ (see Chapter 2) in the Records Window (or use the All
tab of the Property Dialog) to enter or edit event or attribute dates, Family Historian
will not automatically re-order them for you.
If you want to check that an Individual’s events and attributes (and spouses and
children) are in correct date order, select that Individual in the Records Window or
elsewhere and click on “Re-order Events by Date” on the Edit menu. If any items
are not in date order, Family Historian will offer to re-order them for you.
You can also do this from the Events tab of the Property Dialog. Click on the Menu
button
on the toolbar and select “Re-order Events by Date” from the
dropdown menu that appears.

Manual
Ordering of
Events and
Attributes

The Events and Attributes displayed in the Events tab are displayed by default in
date order, which (thanks to automatic ordering) is usually also the order in which
they are stored. But it might not be. If you opened a GEDCOM file created
elsewhere, or if you have used low-level editing, the events and attributes could be
out of sequence. Even if you have used automatic ordering, some events and
attributes have no dates to order them by. You can manually order events in Events
tab of the Property Dialog. Before doing so, however, you must first ensure that
they are displayed in the order that they are stored. To do this, click on the List in
Order button

. The order of the items listed changes to be the order in which

they are stored. Thereafter the Move Up
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toolbar will be ungreyed and you can click on them to change the order as you wish.
Family events/attributes can only be re-ordered relative to other family events/
attributes.

Manual The technique just described only applies to Events and Attributes. There is another
Ordering of technique that can be used to manually order any fields that you wish to be reordered (as long as this is permitted – not all fields can be re-ordered).
All Fields
Click on the All tab. You should be looking at the record for Cameron Peabody.
There should be a row “Residence from 1906 to 1922 in Lewisham, London”. This
should be followed by another row “Residence from 1922 to 1926 in Durban, South
Africa”. Click on the first of these rows.
. Click the right
There are 2 little buttons near the top-right of the dialog:
button (the Move Field Down button) now. Notice that the Residence fields swap
position. Now click the left (Move Field Up) button to return them to their original
position.
You can use these buttons to re-order any fields that are instances of a similar type –
for example, you can re-order any 2 events or attributes or any 2 name fields. But
you cannot move a name field after an event or attribute field.

Sorting By default, events and attributes are listed in date order in the Event tab of the
Property Dialog. When you add events or attributes, however, they will appear at
the bottom of the list. Click on the Date column heading to sort the list by date.
Click on the other 2 headings to sort alphabetically or by age.
You may be wondering what the difference is between Sorting and Ordering (or Reordering). In Family Historian, when you sort, you affect the order in which items
are displayed; but you do not affect the underlying order in which the items are
stored. When you order (or re-order) items, by contrast, you are changing the order
in which they are stored.

Re-order
Out-ofSequence
Data

If you want to be sure that all events and attributes in a file are ordered sequentially,
you can use the Re-order Out-of-Sequence Data command on the Tools menu, to
re-order an entire file in one go. As well as Events and Attributes, you can also use
this command to re-order Spouses, Children and LDS Ordinances (religious
ordinances associated with the LDS Church).

The Significance of Field Order
For many fields, the order of instances of those fields is not significant. For others, however, it is very
significant. The order of an individual’s Spouse Families, for example, is, or should be, chronological.
The order of children within a Family record should also be chronological. If an individual has more
than one set of parents (and as we shall see later, they can) the order of the Parent Families within the
Individual’s record is also significant – although in this case, it isn’t the chronological order that
matters as much as which Parent Family is listed first. For many purposes, such as producing diagrams
of ancestors, all but the first parent family will be ignored.
We saw in Chapter 2 how you can maintain spouse and child order in the Main tab of the Property
Dialog. You could equally order them in the All tab of the Property Dialog, if you wanted to (which
means, of course, that you could also do it in the Records Window, if you preferred).

Child In addition to Individual and Family events, there is one extra category of events:
Events Child events. Actually Child events are really Individual events. You can only edit

or view Child events for individuals who are already linked to you as your children.
The only 2 Child events that you can edit or view are Birth and Adoption events.
If you see a Birth of Child event, for a given child, you will find that same event in
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their own listing as a Birth event. Likewise for Adoption of Child events.
If you don’t wish to include these events in the listing, click on the Menu button
on the toolbar and uncheck “Show Birth/Adoption of Children” in the
dropdown menu that appears.

Copy and Before leaving the Events tab, one final thing to notice is that you can copy events
Paste and attributes by clicking on the Copy Events/Attributes button
on the Events
Events & tab toolbar, and you can paste them using the Paste Events/Attributes button:
Attributes
. You can select multiple events and attributes (by clicking on the first, and then
pressing-and-holding the Ctrl key while clicking on others) and copy them all, and
then paste them all, in one go. This can be a useful technique if you have repetitive
data. When you do this, all details relating to each event or attribute (even including
source citations if any – see Chapter 11) are included in the copy. The only
restriction is that you can only copy events or attributes that are local to the record
you are looking at. So, for example, you cannot copy family events and attributes if
you are viewing them in the context of an Individual record. If you try to, you will
be told that you can’t.

Copy and
Paste Any
Field

In Chapter 11, we will see how as well as being able to copy and paste events and
attributes, you can also copy and paste source citations. In fact, if you are using
low-level editing (see Chapter 2) and looking at a record in the Records Window or
in the All tab of the Property Dialog, you can copy and paste any field.
You can only paste data into contexts in which that date is valid. You can’t paste a
date field into a place field context, or vice versa, for example.

Copy and Wherever you can see any editable text (in any field where you can type characters)
Paste Text you can copy and paste text. To copy it, select it and press Ctrl-C (press-and-hold
the Ctrl key while pressing the C key on your keyboard). To paste previously
copied text, press Ctrl-V.

Copy and
Paste
Records
As Text

If you select a record in the Records Window, you can even copy the entire record.
But when you do this, you only copy it as text. You can paste the text into a wordprocessor, or some other text context. But whereas you can paste a field as a field –
e.g. an event is still an event when you’ve pasted it in the Events tab, say – you
cannot paste a record as a record. You can only paste it as text, in a context which
accepts text.

The Notes You should still be in Large Mode, viewing the record for Cameron Peabody (check
Tab the title of the Property Dialog if in doubt – it should say “Individual: Cameron
Peabody”). Click on the Notes tab now. You should see a large white box
occupying the top third of the tab. In the bottom two-thirds there should be a large
grey box. The top box is the Notes Listing. The grey box shows the contents of the
selected note in the Notes Listing (none at present). We will call this the Note
Contents Box.

We have already seen that notes can be associated with events or attributes.
However, frequently you will want to associate a note with a person as a whole.

Add Local First, enter a note about Cameron, as an Individual.
Note
Steps
1.
2.
3.

Click on the Add Note button
on the toolbar.
In the dialog that appears, confirm that Create local note is checked, and press
OK.
The dialog disappears. A row has been added to the Notes Listing. The first
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4.

column should be selected and should say “<No text>“. The second column
should say ‘Local’.
In the Notes Contents Box, type the following: “A quiet, introverted individual,
he read widely, and struggled hard to make up for the fact that he had had little
formal education as a child”. Press Tab.

A Local Note is an Individual Note if you are entering it into an Individual record.
If you were entering data into a Family record directly (not covered in this tutorial,
but you can do it if you want to), a Local Note would be a Family Note. It just
means: a Note that will be stored in the current record.
There is no limit to the number of notes you can enter (of whatever kind).

Figure 14
The Notes tab of the Property
Dialog for Cameron after adding a
Local Note and a Family Note.

Add Family It often happens, once a person is married, that you will want to enter notes that are
Note just as applicable to their spouse as to them. Rather than having to make the

difficult decision about which of them to enter the note for (or worse, make 2 copies
- one for each of them), it is much better to allow them to share a note. We have
seen how couples can share family events and family attributes. They can just as
easily share notes.
Steps

1.
2.

3.

Click on the Add Note button
on the toolbar.
In the dialog that appears, check Create family note. In the Family field
which becomes ungreyed when you do this, select “Jean Clare Anderson”. Then
click on the OK button.
The dialog disappears. A second row has been added to the Notes Listing. The
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4.

first column should be selected and should say “<No text>“. The second
column should say ‘Marr. to Jean Clare ANDERSON’. 9
In the Notes Contents Box, type the following: “Jean Clare and Cameron were
a devoted couple who, from the day of their marriage, never spent a night
apart”. Press Tab.

You will remember from earlier that in the Events tab listing, Individual attributes
or events have a blue circle next to them:
. Family attributes or events have a red
circle next to them: . The same is true here. Individual notes have a blue circle
next to them. Family notes have a red circle next to them.
Navigate to Jean Clare Anderson’s record in the Property Dialog and confirm that
she too now has a red-dotted note: “Jean Clare and Cameron were a devoted couple
who, from the day of their marriage, never spent a night apart “
Tip: the first Local Note for an Individual is displayed in the Main tab. The first
Family Note for a couple is also visible in the Main tab (it is one of the Marr.
fields). It may be often more convenient to enter these notes there. If you need a
larger window to enter details into, you can click on the 3-dots button
to the
right of the Note field, or double-click on the Note field itself, to open a larger
window to work in.

Add Note Sometimes you will want to enter a note that is relevant not just to one individual, or
Record even to a couple, but to many individuals. To do this, you must create a Note
Record and link it to all the individuals, to whom it is applicable.
Steps
1.

Navigate to Naomi Prentice Salt’s record and display the Notes tab for her, in
Large Mode. Her Notes List should be empty.

2.
3.
4.

Click on the Add Note button
on the toolbar.
In the dialog that appears, check Add link to Note Record... and press OK.
Another dialog will appear showing an empty list of Note Records. Click on
New...
The dialog disappears. An entry has been added to the Notes Listing. The first
column should be selected and should say “<No text>“. The second column
should say ‘Note Record (1 link)’.
In the Notes Contents Box, type the following: “The Prentice Salt family may
be related to the Salts of Cornwall.”. Press Tab.

5.

6.

Link to
Existing
Note
Record

Ensure that the Record Window is sorted alphabetically (click on the first column
heading to sort it if it isn’t). Click on the record for Norman Prentice Salt. If the
Property Dialog is in the way, move it to a position where it doesn’t obscure the
record names in the Records Window. It should still be open at the Notes tab, in
Large Mode. If it is not already pinned, switch it to Pinned Mode now (i.e. the Pin
should look like this:
) so that it shows details for the currently selected person
(i.e. Norman). At this point, you should be viewing the Notes tab. The Notes List
for Norman should be empty.
Steps
1.
2.
3.

Click on the Add Note button
on the toolbar.
In the dialog that appears, check Add link to Note Record... and press OK.
Another dialog will appear showing a single Note Record – the one you
created in the previous section. Select it now and press OK.

9

You probably won't be able to see all of the text of the second column. To see it all, click and drag
the left edge of the column heading to the left. Then click and drag the right edge of the same column
heading to the right.
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4.

5.

The dialog disappears. An entry has been added to the Notes Listing. The first
column should be selected and should say “The Prentice Salt family may be
related to the...”. The second column should say ‘Note Record (2 links)’.
Now click on Sally Prentice Salts record in the Records Window (you should
be able to do this without having to move the Property Dialog, if you positioned
it suitably earlier). The Property Dialog updates to show her (empty) list of
notes. Repeat steps 1-4. Notice that in step 4, the second column now says
‘Note Record (3 links).

Do not, of course, attach any special significance to the fact that you started by
putting the Property Dialog into Pinned Mode. If the list of Prentice Salts had been
long, this would have been a fast way of switching from one individual to the next
(one click in the Records Window takes you to each person in turn). But any
technique for locating each person’s record would have served equally well.

Save Now save the work that you have done.
Changes
Steps
1.

From the File menu, click on Save (or click on the Save button on the toolbar).

Fact Sets We saw in this chapter how easy it is to create custom events and custom attributes.
When we did this we had to specify a ‘fact set’ name. We set this to ‘custom’. In
fact we could have used any name we like as the fact set name, except ‘Standard’
which is reserved. Fact Sets are simply convenient groupings of related fact types.
For example, suppose you have an interest in medical history. You could create
custom events and attributes relating to medical history and give them all the same
fact set name: ‘Medical History’.

Importing
and
Exporting
Fact Sets

Now suppose that somebody else decides that they also are interested in medical
history. They would like to use the same set of events and attributes (the same fact
set) that you have created. All you have to do is click on File > Import/Export >
Export > Fact Set, and then pick the fact set you wish to export. This fact set will
then be saved as a file (you will specify where to save it). Then you just give the
file to your friend (email is fine). They can then install the fact set by importing the
fact set file into their version of Family Historian. They click on File >
Import/Export > Import > Fact Set and choose the file you sent them.

Examples
of Possible
Fact Sets

If you are constructing a fact set, especially if you think that it might be of interest
to others, give it a meaningful name that clearly evokes what it is about, and try to
only include events and attributes that are relevant to its intended function. Here are
some possible examples of fact sets that people might want to create:





The
Benefits of
Installable
Fact Sets

Medical history
Military History
A fact set for a given occupation (e.g. sailor, farmer) storing events and
attributes that are relevant to that occupation.
A fact set for each of the major religions

One obvious benefit of installable fact sets is that it saves effort for the recipient.
They don’t have to reinvent the wheel. But the benefit is potentially wider than that.
When you define an installable fact set you potentially are creating a new standard
for how data of that type can be stored.
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Learn More
About
Creating
Fact Sets

To learn more about fact sets, and how to create them, click on Work with Fact
Sets on the Tools menu. This opens the Event/Attribute List Dialog. Click on the
Help button and in the page that appears, follow the link entitled ‘Work with Fact
Sets’.
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This step presupposes that you have...
Read the Introduction and Chapters 1, 3, & 5.

You will learn how to...
Make On-the-Fly Changes to Diagrams
Specify what text is displayed in diagram boxes
Change Name, Date and Place Formats
Show Pictures in Diagrams
Change the Appearance of Boxes
Understand and Manage Proxy Boxes in All Relative Diagrams
Change the Dimensions that Control the Layout of Diagrams
Specify the Background for Diagrams
Understand and Manage the Display of Duplicates in Diagrams
Find Boxes in Diagrams
Mark Boxes
Change the Orientation of Diagrams
Display Diagrams for Couples
Create Custom Diagram Types
Work with Multiple Diagram Windows at the Same Time

Preamble Diagrams were introduced in Chapter 3 and we looked at some of their basic
features. Chapter 5 was devoted to using diagrams for diagram-based editing. In
this chapter we will continue where we left off, and look at some more features of
diagrams.
This chapter uses, but does not alter, the file saved at the end of chapter 6. If you
skipped chapter 6, or read it but didn’t create your own file, use the ‘pre-cooked’
version (see “Tutorial Files (referred to in the manual)” on the Help menu).
You should open the file you plan to use now. Then locate Cameron Peabody in
this file, and open the All Relatives diagram for him. Make sure that the Spouse
Display Option is Spouse in Own Box.

Restore Before continuing, to ensure consistency with this manual you should use default
Installation options in your diagrams, for now – i.e. the ‘installation settings’.
Settings Steps
1.
2.

‘On-theFly’
Changes to
Diagram
Options

Click on Restore Installation Settings on the Diagram menu.
If for some reason you wish to preserve your default settings, click ‘No’ when
asked if you wish to use the installation settings as default settings in the future.
Otherwise, click ‘Yes’.

In most genealogy programs when you generate a diagram, you specify your options
and the program builds a diagram using those options. If you then decide that you
want to change an option, you can’t change it for that diagram. You have to create
another one. This process does not fit well with the way human beings work. A
better process is this:



Build the diagram with the current default options
Look at it and decide if you like it.
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Make changes and/or modify diagram options and see what the effect is
Repeat this process until you are happy with the results

That is what Family Historian lets you do. In most cases, if you change a diagram
option (e.g. from the Diagram Options dialog), Family Historian will simply update
the existing diagram to reflect the change. If you have expanded branches, resized
or moved boxes, or made other changes, it doesn’t matter. The diagram will be kept
the same (or as near the same as is consistent with the options you have chosen) and
will be dynamically updated to reflect the new options.
This makes it easy for you to experiment and try things out until you are happy with
the results. We will see how you can use this approach to change diagrams in this
chapter.
There are, however, a small number of diagram options (marked in red in the
Diagram Options Dialog) which cannot be handled in this way, and which require
the diagram to be rebuilt if they are changed (see Figure 15 below). If the diagram
is rebuilt, all existing diagram elements will be discarded, and the diagram will be
re-created.

Figure 15
The General tab of the Diagram
Options dialog. Items coloured red
cannot be changed ‘on-the-fly’. If
you change them, the diagram will
have to be rebuilt.

Charts vs. Family Historian diagrams are classed as either Working Diagrams or Saved
Working Diagrams. Saved Diagrams are also called Charts, as they are diagrams that have
been saved in the Family Historian Chart format.
Diagrams
With charts you will always be warned and given the chance to cancel, if you make
a change to diagram options that would require a rebuild. Also if you close a chart
(or take some other action that would force the chart to be closed), you will always
be given the chance to save any unsaved changes you have made to the chart.
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With working diagrams, you can choose how much warning you wish to be given in
both scenarios. By default, you will always be warned with working diagrams too,
if you have made significant changes to the diagram since it was created. You can
configure this in the Diagrams tab of the Preferences dialog.

Text:
Content,
Font and
Style

Family Historian gives you complete control over the content of boxes. It can
display any and all text in an Individual’s record. Not only that, it can display any
text in any record that is even linked, in whatever way, however indirectly, to the
Individual’s record. The contents of boxes are specified by Text Schemes.

Figure 16
The Text tab of the Diagram Options
dialog. The current text scheme is
“Birth, Marr, Death”.

The Text Text Schemes can be simple or complex. They specify not only what text appears
Tab in boxes, but also the fonts used, styles, text colours, indentation, text-alignment and
Diagram Options
Dialog

more. Family Historian comes with a number of standard text schemes. We will
now view the effects of some of them.
Steps
1.

2.
3.
4.

Arrange your diagram so that you can comfortably read the text. It doesn’t
matter if you can’t see all boxes. Try to arrange things so that you can see
Sarah Watts and Cameron Peabody at least.
Open the Diagram Options Dialog and choose the Text tab (see Figure 16
above).
The Current Text Scheme field shows the text scheme currently in use in the
diagram. It should currently say “Birth, Marr, Death”.
Select “All Events and Attributes” in the list of text schemes and click on the
Apply button. Move the Diagram Options Dialog to one side if necessary so
that you can see what effect this has on the contents of boxes. You should see
that Cameron Peabody’s box, for example, is much bigger and lists all his
events and attributes.
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5.
6.

7.
8.

Name, Date
and Place
Formats

Now select “All Events and Attributes, and Rec Notes” and press Apply. Now
record notes appear in the boxes as well.
Now select “Birth, Marr, Death, Occups, Resids + notes, colour”. Press Apply.
This text scheme puts event notes and causes in green italics (e.g. see the cause
of Cameron’s death).
Select Name Only (compact) and press Apply. This text scheme is usefully
compact if you don’t have much space and just want names.
Try out any other text schemes, pressing Apply after each one to see what it
does. Then select “Birth, Marr, Death” again, and press Apply to get back to
where we were.

A common requirement is to change name, date and place formats throughout a
diagram. We will now see how to do this. At this point, you should still be looking
at the Text tab of the Diagram Options dialog and the Current Text Scheme should
be “Birth, Marr, Death”.
Steps
1.
2.

3.

4.
5.

6.
7.

8.

9.

Create
Custom
Text
Schemes

Move the Diagram Options Dialog to one side so that you see Sarah Marie
Watts’ box, without having to close the dialog.
Select “Birth, Marr, Death” in the list and click on the Edit button. The Edit
Text Scheme Dialog appears (see Figure 17 below). The Edit Text Scheme
Dialog enables you to change every aspect of a text scheme, and add or delete
any items you like.
Find the Name Format field near the top-left corner of the dialog. Its current
value is “Full” (i.e. show full details for names). Move the dialog so that you
can see Sarah Marie Watts box. Change the Name format to “Preferred” and
press Apply. This displays a shortened version of a person’s name. Sarah
Watt’s middle name, ‘Marie’, no longer appears.
Now select “Surname First” as the name format and press Apply. This time her
name displays as “Watts, Sarah Marie”.
Locate the Date Format field to the right of the Name Format field. Change
the date format from ‘Compact’ to ‘Abbrev(3)’ and press Apply. Sarah’s date
of birth changes from “12 Dec 1907” to “12/12/1907”.
Change the Date Format to ‘Year’ and press Apply. Now her birth is just
given as 1907.
Locate the Place Format field to the right of the Date Format field. Change
the place format from ‘Tidy’ to ‘Short’. Now Sarah’s place of birth has
changed from ‘Durban, South Africa’ to just ‘Durban’.
Click on the Help button. In the help that appears, scroll down to find help for
Name Format, Date Format and Place Format. Follow the links for each
format type to find out exactly what all the different formats are. When you’ve
finished looking at this, close the Online Help again.
Click on the Installation Settings button to reset the text scheme back to its
default values, and click on the OK button to apply the changes and close the
dialog .10

Creating a custom text scheme of your own is straightforward. You click on the
New button in the Text tab of the Diagram Options dialog. The Edit Text Scheme
dialog appears (see Figure 17 above). You have to give the scheme a name and
select the items you want from the list of Available Items on the left. With each
selected item, you click the right chevron button
to add it to the Text Scheme.
Depending on the items you have selected, a dialog may appear giving options
relating to the item you are adding. Each item added is listed in the Items Used in
This Text Scheme list on the right. To remove an item from the Text Scheme, select

10

A common mistake in Windows is to think that if there is an OK button and an Apply button you
have to press Apply before pressing OK to apply your changes. You don’t. They both apply changes.
The only difference is that OK also closes the dialog and Apply doesn’t.
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it in the Items Used… list and click on the left chevron button

.

If you wish to change the order of any items, select them and use the Move Up
and Move Down

buttons to move them up or down the list.

When you have finished, click OK. The new text scheme will appear in the Text
Schemes list in the Text tab of the Diagram Options dialog. Don’t forget to select
it and click Apply to use it with the current diagram.
At this point, you should still be viewing the Text tab of the Diagram Options
dialog. Click now on the Help button. In the Online Help that appears, scroll down
until you find the help for the New button. Find the link entitled “Create a Simple
Text Scheme” and click on it. This help page takes you through a detailed example
of how to create a simple text scheme. Work through this example now to create a
custom text scheme.

Figure 17 – the Edit Text Scheme Dialog for the “Birth, Marr, Death” text scheme.

Clone a A good alternative approach, if you want to create a new text scheme, is to take one
Text that is as close as possible to what you want, and make a copy of it using the Clone
button. Thereafter you can modify it to fit your requirements.
Scheme
Modify
Existing
Text
Scheme

You can modify any text scheme – either a custom scheme or a standard scheme.
We have already seen how to do the latter when we changed name, date and place
formats in the “Birth, Marr, Date” text scheme. The first thing to do is to select the
text scheme you wish to edit in the list of text schemes in the Text tab of the
Diagram Options dialog, and then click on the Edit button to open the Edit Text
Scheme Dialog (see Figure 17 above).
You can do extensive modifications to any text scheme just by adding, deleting, and
re-ordering items as described in the previous section. A simple approach to
modifying schemes is to delete items you want to change and re-insert them by
selecting them in the Available Items list and clicking on the right chevron button
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to add them. When you re-insert an item, you will be prompted for options.
For example, when you insert a Birth item the dialog will allow you to specify a
label to use (e.g. “Born:”) the number of instances you require (all, first only, last
only) 11, which details you want about the birth (date, place, cause, notes), how you
want the item to be aligned (left, right, centred, justified), and whether you want
some special text to be output if there are no birth details. Choose the options you
want (or accept the defaults) and press OK to add.
A complication to be aware of is that when you add a single item from the Available
Items list, you sometimes get multiple items in the Items Used… list. Usually these
items form an Item Group. See the Online Help for more details about Item Groups
and how to identify them. If you wish to modify an item which has been inserted as
an Item Group, be sure to delete all lines in the Item Group before re-inserting the
item. Equally if you wish to re-order an item that has been inserted as an Item
Group, be sure to keep all the lines together. You can select each line in an item
group by the usual technique of selecting the first, and then pressing-and-holding
the Ctrl key while clicking on the other lines in the group, to select them all.

Changing The Online Help page “Create a Simple Text Scheme” (see Create Custom Text
Fonts & Scheme above) gives an example of how to modify an existing scheme to change
the font and style of different items within the scheme.
Styles
Advanced
Text
Schemes

Most people will be able to do everything they ever need to do using the techniques
already described. But there is much more that can be done if you want to drop
down to the level of creating your own custom text scheme items, or modifying
existing text scheme items.
To add a custom text scheme item, you must be looking at the Edit Text Scheme
Dialog (see Figure 17 above). Select ‘<Custom Item…>’ in the Available Items list
and click on the right chevron button to add it. The Edit Template Item Dialog is
displayed and you can configure the item there. Alternatively, select an existing
item in the scheme in the Items Used… list on the right hand side, and click on the
Edit button to edit it (again, in the Edit Template Item Dialog).
Click on the Help button within the Edit Template Item Dialog for extensive help
on configuring template items, including links to advanced features which allow you
to control almost every aspect of text scheme items.

Override It can sometimes happen that you wish to change the standard text, and do
Text something special for a particular individual. You can do this by carefully

modifying the text scheme you are using. First, set a distinctive Record Flag for the
Individual in question (create a new one if you do not already have a suitable one).
Any item in a text scheme can be made conditional upon any given record flag
being set or unset. By referring to the appropriate record flag, you can change the
text scheme to output special text (or not output text) for that person only.
See Chapter 15 for more on Record Flags.

Show You can insert pictures ‘manually’ into a diagram. We will look at that in the next
Pictures in chapter. You can also get Family Historian to automatically display a picture of
each person in each box. We will look at this now.
Diagrams
Family Historian will only display pictures of people if you have linked that person
to one or more pictures. Unfortunately we will not be covering how you do that
until Chapter 9; so this section is out-of-sequence. For now, you just need to know
that you can link Individuals to as many pictures as you like, and even to their faces
11

You can have as many instances of any event or attribute as you like; though it would be unusual for
an Individual to have multiple recorded birth events.
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within pictures. When you do this, each person’s pictures are ordered by
preference. You can change a person’s picture preference order in the Objects tab
of the Property Dialog for that person.

The Picture We cannot illustrate display pictures in boxes at this point because we have not yet
Tab inserted any pictures into our file. But we can see how it is done. Open the
Diagram Options dialog if it isn’t already open, and click on the Pictures tab.

Diagram Options
Dialog

If you wish to display pictures of Individuals in boxes in your diagram, you will
usually set the Preference field to 1 or 1st. If you don’t wish to display pictures in
boxes, set the Preference field to 0 or None. Occasionally you may wish to display
2nd o 3rd preference pictures, in which case set the Preference field accordingly.
By default, pictures are not displayed for all box types, but you can configure that.
You can also control where box pictures are displayed: to the left of the text, to the
right of the text, or ‘within the text’. Press the Help button for detailed help on the
various options.

Box
Features:
Shape,
Colour,
Shadow,
Etc.

The features of a box that you can control include the background (fill) colour of the
box, and the colour and thickness of the frame (line), the shape of the box (if you
opt to have a box at all), and the box shadow colour, position and size (if you opt to
have a shadow). Box features can even include little icons which display below the
box – like the little icons in a Bed-and-Breakfast catalogue that tell you whether
your room will have a TV or an en suite shower.

B&B-style Box features can even include little ‘icons’ (tiny pictures) which display below the
Icons box – like the little icons in a Bed-and-Breakfast catalogue that tell you whether a

room has a TV or an en suite shower. You could, for example, have a little men-atwork icon to show which boxes you are currently working on, or have a ship icon
for sailors. How you use these features is of course entirely up to you. There is no
limit to the number of icons that can be displayed below each box. You can
associate icons with record flags, set on the records themselves. Family Historian
comes with a number of standard icons, but you can design your own if you wish.
To learn more about how to use B&B-style icons with boxes, click the Help button
on the Boxes tab of the Diagram Options dialog.

Figure 18
An example of the use of
B&B style icons.

Conditions More often that not, you will not want all boxes to look the same - you certainly

wouldn’t want them to all have the same icon, for example. You may want each
generation to use a different box colour. Or you may want one set of relatives to be
coloured green, and another set to be coloured red. You may want ancestor boxes to
have a green background, a crinkly box shape, and a brown shadow; and you may
want descendant boxes to have a yellow background, rounded box corners, and no
shadow. You might want females to have red text, and round box edges, and males
to have blue text and hard box edges. Family Historian lets you define conditions,
prioritise them, and assign features to them to suit your requirements.
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The Boxes Open the Diagram Options dialog if it isn’t already open and click on the Boxes tab.
Tab It is here that you define both conditions, and the box features you wish to associate
with them.

Diagram Options
Dialog

The conditions are listed in the top half of the dialog, in order of priority. The
features shown in the bottom half of the dialog, in a tabbed list, are the features
associated with the condition selected in the top half.
The default look for Family Historian diagrams includes sex colouring (overriding
the default text colouring for names, specified in the Text Scheme). Make sure that
‘Sex’ is selected in the Condition List. Notice that the tabbed list below has 3 tabs:
‘Male’, ‘Female’, and ‘Unknown Sex’. Click on each of these tabs in turn and
confirm that they specify 3 different text colours.
Now click on ‘Box Type’ in the Condition list. When you do this, the tabs change
in the tabbed list of features. There are now 6 tabs and they are ‘Root’, ‘Ancestor’ ,
Descendant’, ‘Spouse’, ‘Remarriage’ and ‘Proxy’. Click on the Spouse tab. The
dialog should look like Figure 19 below. Click on the Edit Features button. The
Box Features Dialog opens. Click on the coloured button in the Box Fill area and
select the light pink colour. Press OK, and then press OK again to close the Box
Features Dialog. Now back in the Text tab of the Diagram Options dialog, press
Apply. You should see that spouse boxes in the diagram all go light pink.
Click Edit Features again. This time tick Box Shape, and select ‘Two Step
Corners’ as the shape. Tick Box Shadow and select ‘<no shadow>’ as the shadow.
Press OK to close the Box Features Dialog and return to the Text tab of the
Diagram Options Dialog. Notice that all the features you specified are now listed in
the Features list. Click Apply within the Text tab of the Diagram Options dialog.
Notice that spouse boxes no longer have a shadow (although other boxes still do)
and they have slightly crinkly ‘two step’ corners.

Presets To get you started, and give you an idea of some of the things you can do, some
Presets have been defined for you. These are complete sets of conditions and
associated feature sets. Click on the Preset button now and choose ‘Generations
(basic)’ from the list. Press OK to confirm that you wish to replace existing box
conditions and features and then press Apply to apply the Preset to the current
diagram. The Root box should still be coloured white, but you should now see that
all other boxes are rectangular and coloured by generation. Now try the
‘Generations (Ornate)’ preset. This is the same as the previous one except that each
box has bevelled corners and a shadow. Try all the other presets. The ‘Classic (Box
Types)’ preset is very similar to the look that all diagrams had in version 2 of
Family Historian. The ‘No Box’ preset is handy for getting rid of boxes. The
default look for version 3 is ‘Box Types (Ornate)’.
You should appreciate that the presets do not do anything that you could not do for
yourself. They are just examples. Click on the Help button to learn how to add
your own conditions and how to control the features that the conditions are
associated with. A good exercise is to look at the preset and see if you can work out
how they achieve the results they get.
When you have finished experimenting, select the ‘Box Types (Ornate)’ preset once
again, and apply it to the current diagram.
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Figure 19 – the Boxes tab of the Diagram Options dialog. The picture shows the features associated with the Box
Type condition. In the example, features can be specified for 6 different box types, each of which has its own tab.
The Spouse tab is currently selected.

Proxy The next tab in the Diagram Options dialog is the Proxies tab which deals with
Boxes Proxy Boxes. Proxy boxes are a special kind of box that are only used in All

Relatives trees, and even then, only direct ancestors of the tree root can have them.
They are or can be used to show where an ancestor fits in, in amongst their siblings,
in the context of the ancestor’s own parent’s family.
Owing to the way the All Relatives tree works, it can happen that a given ancestor’s
box is located physically a long way from the part of the tree which shows their
parents and their siblings. In a situation like that, someone viewing the diagram
might look at the parents, wonder who their children were, and find themselves
having to follow a long line across the diagram, to find out. Rather than let this
happen, Family Historian allows you to show two boxes for each ancestor. One box
(box type Ancestor) shows you the ancestor above and between the ancestors
children. The other box (box type Proxy) shows you the ancestor among his or her
siblings, below his or her parents.

It is common practice to display proxy boxes with a transparent background and
with a dotted line frame as in Figure 20 below, but you don’t have to display them
like that. The appearance of Proxy boxes is controlled, like the appearance of any
other box, in the Boxes tab.
It is also common to show less information in Proxy boxes than you show in other
boxes to avoid unnecessary repetition. But again, that’s up to you. It is the text
scheme (chosen in the Text tab) that determines what text goes in to a Proxy box.
It is also common not to show pictures in Proxy boxes, even if you are showing
them in other boxes. That is configured in the Pictures tab.
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The
Proxies
Tab
Diagram Options
Dialog

The display of Proxy boxes is controlled from the Proxies tab of the Diagram
Options Dialog. If you don’t want to use Proxy boxes at all, tick Never in the Show
Proxy Boxes area of the Proxy tab. Otherwise, choose the settings you want and
Family Historian will build (or rebuild) your diagram accordingly. But your options
don’t end there. As we will see shortly, you can hide or show any box in any
diagram. And that includes Proxy boxes. So if the Proxy tab options don’t give you
quite the results you hoped for, you can hide unwanted Proxy boxes. You can even
unhide ones that were hidden, if you wish.
Press the Help button on the Proxy tab to learn more about Proxy boxes and your
choices with regard to displaying them.

Figure 20 – part of an All Relatives diagram for Cameron Peabody. Naomi Prentice Salt has 2 boxes. The one on
the right is a Proxy box.

The Dim- The Print tab and print options are covered separately in Chapter 8. Beyond the
ensions Print tab, the next and last tab of the Diagram Options dialog is the Dimensions tab.
Tab The size of any given box is mainly determined by the text scheme (which in turn
Diagram Options
Dialog

determines font sizes) and the amount and type of data in the records of the
Individuals in the diagram. Other factors include pictures and picture settings, and
text margins. The corner size and the text area indent (box shape features, set in the
Box tab) will also affect the box size and shape. None of these things are set in the
Dimensions tab. But almost every other size and dimension in a diagram is set here.
This means that you have a very level of control over how Family Historian lays out
diagrams. Dimensions are set using your preferred unit of measurement (see
Preferences).
To illustrate the effect of changing dimensions, switch briefly back to the Text tab,
select the “All Events and Attributes, and Rec Notes” text scheme and click Apply.
Cameron Peabody’s box is now tall and thin. Switch back to the Dimensions tab
and set the Maximum box width to 4” (or the equivalent in your preferred unit of
measurement if you don’t use inches). Click Apply. Now Cameron Peabody’s box
is much shorter, but also much wider.
Click on the Help button for an explanation of all the various dimensions. Take a
moment to click on the More Dimensions button and view these too (click the Help
button in that dialog for more help with these).
Finally (back in the Dimensions tab) click on the Installation Settings button to
restore the installation (default) settings. Switch back to the Text tab and select the
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“Birth, Marr, Death” text scheme once again, and click Apply.

The
Diagram
Background

By default, an All Relatives diagram has a striped background, with each stripe
corresponding to a generation. What if you want a different kind of background?
As an exercise we will set the background now to plain white.
Steps
1.

2.

3.

Select the General tab of the Diagram Options Dialog. Find the Background
field and set it to ‘One Colour’. Click Apply and observe that the background
is now all grey. You may still be able to just make out faint thin lines where the
stripe edges had been. These are the boundary lines. We will get rid of them in
a moment.
Click on the Sundry Colours button on the same tab. The Colours Dialog
appears. Select ‘Background if one colour’ in the Items list. Then select the
colour white in the displayed set of Basic Colours and click on the << Select
button. You may be surprised to see that the background colour of the diagram
changes to white immediately. This is just a convenient feature of the Sundry
Colours dialog. Whatever colours you select are immediately displayed in the
current diagram. However, this is only to allow you to see what the effect of
your colour selection is. If you clicked Cancel at this point, the colours would
immediately revert to what they had been. Do not click Cancel. Click OK to
close the Colours Dialog. The colour selection has now been applied.
At this point, you should be able to see the boundary lines more clearly. To get
rid of them set the Boundary Lines field (still in the General tab of the
Diagram Options Dialog) to ‘No Boundaries’ and click Apply. The boundary
lines disappear and you now have a white background.

Tip: If you wanted a plain white background for a print out of your diagram, there
is no need to do any of the above. By default, the background of a diagram doesn’t
print anyway (this is configurable in the Print tab using the Print Background tick
box).
Tip: You can have a picture (or pictures) as background if you wish. See Chapter 9
for how to do this.

Sundry Text colours can be set in text schemes (see the Text tab). They can also be
Colours overridden as a box feature (see the Boxes tab). All other colours relating to boxes

are set in the Boxes tab. That still leaves several other colours that are set from the
Sundry Colours dialog. As we have just seen, the background colour is set from
there. If you are using background stripes, you can set the stripes colours there. If
you are using a single background colour, you can set the ‘one colour’ there too.
The two other colours for backgrounds – ‘background if anc. colouring’ and
‘background if desc. colouring’ – are only applicable if the Background field is
‘Depends on diagram type’. In that case, they affect the appearance of the
Ancestors diagram, the Descendants diagram, and the Ancestors and Descendants
Diagram (i.e. all diagrams except the All Relatives diagram). Click on the Help
button in the General tab and look at the help for the Background field for an
explanation of this setting.

Duplicates If you look back to Figure 10 in Chapter 4, you will see that both Cameron Peabody
and Jean Anderson occurred twice in that diagram. This happened because the
diagram show’s Cameron Peabody’s relatives, and Jean Anderson is related to him
in 2 ways: she was his wife, and she was his cousin.
Where an Individual has more than one box in a diagram, the boxes are called
‘duplicate boxes’.12 Given that in practice, individuals are frequently related to one
another in more than one way, it is necessary to devise a strategy for handling this in
12

The term ‘duplicate’ was used a little differently in version 2 of Family Historian.
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diagrams. It might seem desirable to at all costs, arrange the diagram so that even if
people are related in more than one way, you still never get more than one box per
person. If you are lucky with your data, this approach can sometimes give good
results. However, frequently the results of such an approach are not good. The
problem is that in order to be able to arrange things so that each person gets only
one box, you have to be prepared to make a great many compromises on other
important features of diagrams. It may be necessary, for example, to separate
spouses so that they are nowhere near each other on the diagram. Parents may end
up far removed from their children. Siblings may be separated from siblings; and
siblings and spouses may need to be shown in the wrong sequence. The end result
is often that diagrams become a complicated mess – difficult to make sense of, and
unappealing to look at. That is why we have not adopted this strategy in Family
Historian.

Linking The strategy adopted for dealing with duplicates, is not to try to eliminate them all.
Ribbons Instead, Family Historian provides features for automatically detecting duplicates

wherever they occur. Duplicated branches are closed off to eliminate all
unnecessary duplication. Then each occurrence of remaining duplicated individuals
or families are linked together using a curved coloured ribbon which flows across
the diagram. If an Individual has 3 boxes on a diagram, all 3 boxes will be linked
with a single curving ribbon that flows through them.
Family Historian supports 2 kinds of ribbon links – ribbons linking individuals and
ribbons linking families. The main difference between them is that Family links
have an oval at each end, positioned between and below the spouses in a family.
Individual links have no oval, and connect directly to the Individual’s box.
Duplicate options are configured in the Duplicate Options Dialog (see Figure 21
below). To open the Duplicate Options Dialog, tick on the Check for Duplicates
tick box in the General tab of the Diagram Options dialog (if not already ticked)
and then click on the Options button next to it. By default, Family Historian will
use Family links in preference to Individual links where possible. This is
recommended to keep the number of linking ribbons to a minimum.
A number of different colours are used for ribbons, allocated more or less at
random, to make it easier to follow ribbons across the diagram.
The Duplicate Options Dialog provides a number of options for controlling how
duplicates are handled and how duplicate links are displayed. Click on the Help
button for more details.

Check For The options set in the Duplicate Options Dialog affect how duplicates are detected
Duplicates and handled when you first create a new dialog. They will also be applied if you

insert a tree into an existing diagram. However, they will not prevent you
expanding branches (using the expansion buttons) to explore branches, and thereby
finding, or ‘creating’ more duplicates. When you insert a tree, you might choose to
first disable duplicate checking so that, initially at least, duplicated branches are not
closed off. If you do these kinds of things, you may wish to re-enable, and re-apply
duplicate checking, to an existing diagram. You can do this at any time by clicking
on Check For Duplicates… on the Diagram menu.

Find The ribbons make is easy to locate duplicates visually, but there is another way. If
Duplicates you are viewing a box for an Individual and want to find other boxes for him or her,
select the box and click Find Next Box for Individual on the Diagram menu. This
will switch the selection to the next instance of that box on the diagram. A quick
way of doing this is just to press the F3 key.
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Figure 21 – the Duplicate Options Dialog

Find in What if you want to find someone in a large diagram and you don’t know where
Diagram there are any boxes for him or her? When you are viewing a large diagram, it is not
always easy to locate a particular person just by scrolling. If you know which
person you are after, the quick way to find them is to use the Find in Diagram
command on the Edit menu. Although this command finds an Individual in a
diagram, it cannot be used from the Diagram Window. Instead, without closing the
Diagram Window, switch to another window and select the person you want. For
example, you could use the Record Window. Having selected the required record,
click on Find in Diagram. You will be switched back to most-recently-used
Diagram Window, and the first box found for the selected record will be selected.
You can then press F3, if you wish, to see if there are any others.

Marking It sometimes happens that you want to mark a particular box on a diagram for some
Boxes reason. Perhaps you want to scroll elsewhere and want to make sure that the box

you are looking at now is easy to find again. Or you might want to mark several
boxes as you check each of them in turn, for some feature - to show that the box has
been checked.
By default, marked boxes are displayed with a bright yellow background, but you
can configure this using Sundry Colours (see the General tab of the Diagram
Options dialog).
The easy way to mark one or more boxes is to select them all13 and press Ctrl-M
(that is, press-and-hold the Ctrl key and then press M). Press Ctrl-M again to
unmark.
The Marks menu (off the Diagram menu) has various options relating to marking
boxes. If you can’t remember the Ctrl-M combination, you can use Mark/Unmark
Boxes menu command to do the same thing. You can also Clear All Marks and
Select Marked Boxes.

13

See Select Multiple Boxes in a Diagram in Chapter 5 if you can’t remember how to do this.
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Set/Clear
Marks
Using
Query

We have not yet looked at queries, but as we shall see when we do, they can be a
useful tool for analysis. Suppose you had a diagram of ancestors and you wanted to
see which of them had died of a stroke. You could include the cause-of-death in the
Text Scheme easily enough, but if you had a large number of ancestors, it might not
be easy to see which of them had had what. A better approach would be to use a
query to automatically mark all of the ancestors in the diagram who had died of a
stroke.

Diagram By default, diagrams are oriented top-down. But they can also be oriented left-toOrientation right, right-to-left, or bottom-up. This is set using the Orientation field in the
General tab of the Diagram Options dialog – see figure 15 above.

Diagrams
For
Couples

All Family Historian diagrams can have either an Individual as root, or a couple.
You simply need to select their Family record before selecting the diagram. For
example, we will display an All Relatives diagram for Cameron Peabody, and his
second wife, Jean Clare Anderson.
Steps
1.
2.
3.

4.

Display an All Relatives diagram for Cameron Peabody. Ensure that the
Spouses in Own Boxes button
is checked).
Click on Cameron Peabody’s node to select him, if not already selected.
Hold the Ctrl key down and click on Jean Clare Anderson’s node, to select her
too. Release the Ctrl key. Both Cameron Peabody and Jean Clare Anderson
should be selected – and no-one else. Now click on View All Relatives.
A new diagram appears. Notice that both Cameron Peabody and Jean Clare
Anderson are displayed in white – the colour of the root node. The data
displayed is similar to the data displayed before, but there is an equal balance
between the 2 root boxes, and thus a slightly different emphasis to the previous
diagram which focussed primarily on Cameron Peabody.

Selecting Selecting both boxes in a couple, in a diagram, is actually just a quick way of
Family selecting a Family record. If you select a Family record in the Records Window,
that works equally well.
Records
Steps
1.
2.

3.

Switch now to the Records Window.
Locate Cameron Peabody’s record. Expand his record. You should be able to
see one field labelled ‘Parents family’ and 2 labelled ‘Spouse family’. You can
see that “... of Philip PEABODY and Naomi PRENTICE SALT” references a
family record (as do the other two) because of the presence of the family record
icon
next to the text. Select “... of Philip PEABODY and Naomi
PRENTICE SALT” and click on the View Ancestors button on the main
toolbar. A diagram is displayed showing the ancestors of both Philip Peabody
and Naomi Prentice Salt. Leaving them both selected, click on the button for
each of the other 3 diagram types in turn.
Repeat step 2 for Cameron’s 2 spouse families.

Standard When Family Historian is installed, it comes with a set of pre-configured standard
Diagrams diagrams. Four of these standard diagrams (the default set) are the ones that have

buttons on the application toolbar. To access all standard diagrams, see the
Standard Diagrams menu, which is on the View menu. You may wonder why
most of them are greyed (if they are). Most standard diagrams require that you have
previously selected an Individual or Family record before you click on them. If you
select a record now (e.g. by clicking on a box in the Diagram Window), you should
find that they are ungreyed.
Select Cameron Peabody now and click on the “Pedigree Chart”.
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The
Everyone
Diagram

One standard diagram which does not require a prior selection is the Everyone
diagram. Click on this now. The Everyone diagram shows everyone in the current
family tree file, and all of their relationships. It does this by creating a diagram
which has multiple trees in it, all stacked up one above the other. You will almost
always want to move the trees around, to get a better-looking layout (see Chapter 8
for how to do this).

Create
Custom
Diagram
Types

We saw earlier how you can create custom text schemes. You can also create
custom types of diagram. Suppose, for example, that you regularly want to be able
to use a diagram to view census details that you have accumulated about a given
person’s immediate family. You want to able to select a given person (in the
Record Window say) and click on one menu command to see a diagram showing
their parents and grandparents, uncles, aunts, cousins, siblings and children. And
for each person, you want to see what census data you have accumulated about each
one.
To do this, all you need do is create a single example of the kind of diagram you
want. In the imagined case you would use an All Relatives diagram limited to 2
generations up, and 1 generation down, from the root. You would choose an
appropriate text scheme (custom or standard) and decide on the diagram orientation,
the look and style of the boxes, and other details.
Having created your example, click on File > Save Diagram As > Custom
Diagram Type, and give the new diagram type a name. Thereafter, to open a
diagram of the new type, select the Individual (or couple) that you wish to be the
root of the new diagram, and select the new menu from the Custom Diagrams
submenu, which is accessible from the View menu.
When a new custom diagram type is created, not all details of the current diagram
are saved as part of the new diagram type. Any information which you have to
specify when you open the diagram (such as the new root) is not saved. Also, if you
insert any additional trees or other diagram elements into your example diagram,
these will also not become part of the new custom diagram type. The only
exception to this is Text Boxes. As we will see in Chapter 9, you can insert an
unlimited number of text boxes into a diagram. The first 4 text boxes found in a
diagram are saved as part of the new diagram type. The advantage of this is that it
means you can specify default titles for your new diagram type.
Do not confuse creating a new type of diagram with simply saving the current
diagram to a file. The latter is discussed in Chapter 9.

Modify
Custom
Diagram
Types

Effectively, you modify a custom diagram type by re-creating it. But the easy way
to do this is to open an instance of a diagram, using the new type. Then open the
Diagram Options dialog and make whatever changes you need to make to it. Then
click on File > Save Diagram As > Custom Diagram Type, as you did when you
first created it. You will find that the diagram’s name has been remembered in the
Custom Diagram Name field; so you can leave that unchanged and click OK to
save changes.

Delete To delete a custom diagram, choose the Delete Custom Diagram command at the
Custom foot of the Custom Diagrams menu. Select the diagram you want to delete from
the list that appears and click the Delete button to delete it.
Diagram
Types
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Lock
Window
(prevent
reuse)

When you select a record and click on any of the diagram buttons to open a new
working diagram, Family Historian will normally re-use the current Diagram
Window to display it - if there is one, and if it is currently displaying another
working diagram (that is, a diagram that has never been saved to disk). If the
Diagram Window contains a working diagram, but significant changes have been
made to it, it may (this is configurable in Preferences) ask you if you want to reuse
the current Diagram Window or open another one instead.
If you have a working diagram that you definitely want to keep, you can ensure that
Family Historian will not re-use its Diagram Window by locking it. To do this,
either click on the Lock Window button
on the toolbar, or right-click on the
icon for the relevant window in the Navigation Bar, and select Lock Window
(prevent reuse) from the dropdown menu that appears.
The issue of locking does not apply to all diagrams. Once a diagram as been saved
to a file it is no longer considered a working diagram – it is now categorised as a
chart. Diagram Windows displaying charts are never re-used. You cannot lock a
chart, and you never need to. In effect, charts are always locked.
There is no limit to the number of Diagram windows that you can have open at any
one time. Each open window will have an icon on the Navigation Bar. It will also
have a menu command (for switching to it) at the bottom of the Windows menu.
As we will see later, just as you can open multiple Diagram windows, you can also
open multiple Multimedia and Report windows too. And these too can be locked, in
the same way that you can lock a Diagram Window.
You can only have one Records Window and one Query Window however; and
these can neither be locked or re-used.
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This step presupposes that you have...
Read the Introduction and Chapters 1, 3, 5 and 7

You will learn how to...
Move boxes, branches & trees
Resize boxes
Manage box states
Switch the positions of spouses and siblings
View diagram and file statistics
Move trees in the Everyone diagram
Insert trees, pictures, text boxes, rectangles and lines into diagrams
Hide boxes, show hidden boxes, and unhide boxes
Order diagram layers front-to-back
User the Check for Duplicates command
Save diagrams as chart files

Preamble Diagrams in Family Historian, as we have seen, are tightly integrated into the

program, and are used for a number of purposes – such as browsing, editing, and
navigation. But another very important role for diagrams is for making wall charts.
A ‘wall chart’ at its simplest, is a diagram that you print off and stick on the wall.
But it could just as well be an image file that you email to a relative. If you are
planning to put together a chart to print or send to others, many of the features that
we have already looked at – including most of the features we looked at in the
previous chapter – will be relevant. But the likelihood is that you will have
additional requirements over and above the requirements we have looked at so far.
You may want to add titles, annotations, a frame and other details to your chart.
You may want to add pictures (over and above any pictures in boxes). You may
want a background image. You may want to add additional trees. You may want to
hide some individuals, and branches, and enlarge the boxes of others to emphasize
them. You may want to move boxes, branches and trees around to make best use of
space. You will certainly want to save your chart in a file, so you can work on and
improve it over time.
You can do all of these things, and we will look at how you do them in this chapter.

The To illustrate some of the things you can do when creating charts we will use a new
Munros file called “The Munros” (or “The Munros.ged” if your computer shows file

suffixes). To open this file, click on the Help menu within Family Historian. Then
click on “Tutorial Files (referred to in the manual)”, and then “The Munros”.
Confirm that you wish to open this file.

The Now open the Everyone diagram. To view this diagram, click on View > Standard
Everyone Diagrams > Everyone. Click on the View Whole Diagram button
now to
view
the
whole
thing.
You
will
see
that
the
diagram
contains
3
trees
positioned
Diagram
vertically, one above the other. The topmost tree is the biggest. It is linked to the
next tree down by a duplicate family link (see Duplicates and related sections in the
previous chapter).
The Everyone diagram adds enough trees to a diagram to show everyone in the file,
and all of their relationships. The trees are always stacked up vertically one above
the other. Later we will see how you can move trees round and put them wherever
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you want.

Diagram To confirm that the Everyone diagram is showing all the Individuals in the file, click
Statistics now on Diagram Statistics on the Diagram menu. In the Diagram Statistics

Dialog the first line gives the number of boxes (50) and the second gives the number
of Individuals (48). The discrepancy is because 2 Individuals have duplicate boxes.

The Diagram Statistics Dialog has other useful information such as the number of
pages, the current scaling, the size that the diagram will be when printed, and more.

Files Now click on File Statistics on the File menu and confirm that the number of
Statistics Individual records in the current file is indeed 48. The File Statistics Dialog shows
the count of all records, and also tells you the name and location of the current file,
which can sometimes be useful.

Open All Back in the Everyone Diagram, click on Michael Smith Munro’s box (right at the
Relatives top) and click on the View All Relatives button
. When you do this, the new
Diagram diagram appears in the current diagram window, displacing the Everyone diagram
(figure 22 shows a part of the resulting diagram). This diagram only shows 35
Individuals, as only 35 Individuals in the file count as relatives of Michael Munro.
In Family Historian, a son-in-law counts as a relative (by marriage); but your sonin-laws parents and other ancestors are not counted as relatives of yours. So none of
Jonathan Hodge’s ancestors count as relatives of Michael Munro.

Figure 22 – part of Michael Munro’s All Relatives diagram.

nd
Enable Now select Amanda Morag Munro’s box (she is Michael Munro’s 2 child). Let us
Moving/ suppose that you wish to enlarge her box. Before you can move or resize any boxes,
you must enable moving/resizing. And the easiest way of doing that is to click on
Resizing

the Enable Moving/Resizing Button
on the toolbar. Do this now. Notice that
when you do this, the 8 little selection boxes (‘selection markers’) round the edges
of Amanda Munro’s box change from blue to white. The other thing to notice is
that where the line going up from Amanda Munro’s box meets the horizontal child
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bar connecting her to her siblings, there is now a tiny little white diamond (see
figure 23 below).

Figure 23
Moving/Resize has just been
enabled. Notice the white
selection boxes called
‘selection markers’, and the
tiny white diamond where the
vertical line going up from
Amanda Munro’s box meets
the horizontal line (the ‘child
bar’) above it.

Resize Box To resize Amanda Munro’s box, click-and-drag on any of the little white selection
markers. For the purposes of this example, make sure when you do this that you
make her box taller as well as wider. Increase the size until it is at least twice the
height it had been, comfortably overlapping the boxes below. When you release the
mouse button, notice that the entire row has become deeper and all rows below her
box have moved down.

Figure 24 – Amanda Morag’s box has just been resized. The row that her box is in has become much deeper.
Compare the size of the background stripe with figure 22. The boxes in rows below have all moved down.
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Box Size
Affects
Row Size

Now right-click on Amanda’s box. A dropdown menu appears with a number of
options. The first 5 menu items are box states, 3 of which are currently ticked,
including Box Size Affects Row Size and Include Box in Row. The former means
that the row that Amanda’s box belongs to, is automatically made big enough to fit
her box. So if her box is made bigger, so that it is now the tallest box in the row, the
row must be made bigger too. All boxes have Box Size Affects Row Size set by
default. So the depth of the row is determined by the tallest box in the row – which
in this case is Amanda’s box.
Now click on Box Size Affects Row Size so that it becomes unticked. When you
do this Include Box in Row is automatically unticked too. Now the size of
Amanda’s box no longer affects the size of the row that her box belongs to, and it
shrinks back to its previous depth. Her box now extends down below its row. And
there has been a sideways adjustment to that her older brother Peter’s descendants
do not overlap her box. See figure 25 below.

Figure 25 – Box Size Affects Row Size has been unticked on Amanda’s box. The row that her box belongs to has
shrunk back to its previous size, and her box extends down below the row.

Autosize Right-click once more on Amanda’s box. This time tick Autosize Box. By default,
Box every box has this box state enabled; but it is automatically disabled (unticked)
when you manually resize a box as we did just now.

When you enable Autosize Box on Amanda’s box, you should see that it snaps back
to its previous size so that once again it fits within its row. It is no longer competing
for space with Peter Munro’s descendants so they move back to where they had
been, and the diagram once again looks like figure 22.

Four Types Clicking on the Enable Moving/Resizing button
enables (as the name
of Drag- suggests) both resizing and moving. Family Historian supports 4 different ways of
and-Move moving all or parts of trees by a click-and-drag action. The 4 types are:
Actions
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Box Move
Bar Move
Fixed Point Move
Tree Move

We will look at each in turn.

Box Move Click now on Amanda’s box itself and holding the button down, drag downwards.
If you hadn’t enabled moving/resizing, this would be an add-relative action (see
Chapter 5); but now it is a move-box action.

As you drag down, notice that other boxes jump sideways to get out of the way. If
you drag slowly you will see that they move apart to let Amanda’s box get past, but
will move back the moment there is space for them to do so. They always leave a
minimum gap between boxes (you can adjust these gaps in the Dimensions tab of
the Diagram Options Dialog) so no box ever comes close enough to actually touch
Amanda’s box.
Drag Amanda’s box downwards until it is roughly in line with Edward Wiley’s box,
and then release the mouse button. Now the diagram should look roughly like
figure 26 below.

Figure 26 – Amanda’s box has been dragged downwards. The other boxes have adjusted to make room.

Include Now right-click again on Amanda’s box. Notice that both Box Size Affects Row
Box in Row Size and Include Box in Row are unticked (in fact all box states for this box are

unticked at present, except AutoSize Box). What do you think would happen if you
ticked either of these states now?
The answer is that nothing happens if you tick Box Size Affects Row Size because
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Amanda’s box – even allowing for gaps above and below – is not taller than the row
that it came from. But if you tick Include Box in Row you will see a big change.
Do this now: tick them both in turn14. Now the row that Amanda’s box belongs to
suddenly becomes much deeper until it extends below where her box is now. And
all rows and boxes in generations below hers have to move down. This is shown in
figure 27 below. Notice that once again, the boxes don’t just move down. They
also close in to make the most of the available space.

Figure 27 – The result of ticking Include Box in Row on Amanda’ box.

Box Move Right-click on Amanda’s box and untick Include Box in Row so that the diagram
is a Branch once again looks as it did in figure 26.
Move When you clicked-and-dragged on Amanda’s box to move it down, this is called a
Box Move in Family Historian. You can click-and-drag on any box to do a box
move. When you do this, you will not move just that one box. If the box is a
descendant box type, you will move all descendant boxes too, and any spouse boxes
attached to that box. Moving a spouse box is like moving a descendant box – it
works the same way. Move an ancestor box is the same again, only this time you
move all ancestors of the box, as well as any spouses.
To illustrate the above, click now on Norman Wiley’s box and drag downwards,
passing Amanda Munro’s box, till his box is roughly in line with Anna Lesley
14

‘Ticking X’ in this context is a convenient short-hand for “right-click on the box and click on the X
menu command, which currently has no tick against it, so that henceforth it is ticked”.
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Munro’s box. When you did this you moved not just Norman Wiley’s box (a
spouse box), but also Emily Susan Munro’s box (his wife) and all of their
descendants. Once again, other boxes moved out of the way as needed to make the
best available use of space.

Align With
Others in
Same Row

Right-click on Norman Wiley’s box and tick Align with Others in Same Row.
This state is set by default on all boxes, but becomes automatically cleared when
you manually move a box. When you re-enable it, you should find that Norman
Wiley, his spouse and all his descendants spring back to where they had been and
once again the diagram looks like figure 26.

Box Moves
Are
Outwards
Only

When you dragged Amanda Munro’s box downwards, you had to drag it
downwards (or back up). You couldn’t drag is sideways. Box moves are outwards
only (or more accurately – outwards or back). If your diagram has top-down
orientation, you can only drag a descendant box downwards (or back); and you can
drag an ancestor box upwards (or back). If you were using left-right orientation,
you could only drag a descendant box rightwards (or back); and you could only drag
an ancestor box leftwards (or back).

Bar Move We saw earlier that when we enabled moving and resizing by clicking on the
Enable Moving/Resizing button
tiny little white diamonds appeared on the
horizontal child bar above Amanda Munro. In fact, if you look all horizontal child
bars have them. You can click-and-drag on any of these little white diamonds, and
when you do so, you are doing a Bar Move. Actually you don’t have to click-anddrag on the diamonds themselves. You can click-and-drag anywhere on any of the
horizontal bars. However, suppose a parent had only one child, as Jonathan Hodges

Figure 28 – The results of a Bar Move.
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and Julia Munro do, for example. In that case, there is no horizontal bar to click on.
But there is still a tiny white diamond and you can still click-and-drag on that.
You can do bar moves not just with descendant branches, but also with ancestor
branches too. But ordinarily there is no horizontal bar between an ancestor and his
parents. There is however a little white diamond on the line joining an ancestor to
his or her parents, and you click-and-drag on that to do a bar move.
To illustrate how bar moves work, click now anywhere on the horizontal child bar,
just below Peter Munro’s box linking all of his children. Keeping the button
pressed, drag downwards until you are comfortably below Amanda Munro’s box.
Then continue dragging, but to the right this time, until Alice Daniels’ box is more
or less below Amanda Munro’s box. The results should look roughly like figure 28
above.

Bar Moves
Are
Outwards
and
Sideways

When you move a bar you move all branches attached to that bar. And like a box
move, you move it outwards and back. But unlike a box move, you can also move it
sideways as well. And as with all moves (and all box resizes), other boxes and
branches within the same tree will automatically move out of the way and make the
best use of available space.

Box Moves
Work with
Multiple
Selection

You can only move one bar at a time, but you can move any number of boxes at the
same time. Simply select them all using any of the usual techniques for selecting
multiple boxes, then click on any one of them to drag them all. The only restriction
on this is that they must either all be ancestor type boxes, or none of them can be
ancestor type boxes. They cannot be a mixture of ancestors and non-ancestors.

The
Movement
Control
Box

Now click on the Movement Control Box button
on the Diagram Toolbar.
The Movement Control Box Dialog appears. The first time you see it is rather big.
Read the text in the box, then click on the << Less to reduce the box size. The
smaller version is shown in figure 29 below.

Figure 29
The Movement Control Box in its
smaller guise.

You Don’t
Have to
Close the
Movement
Control
Box

The Movement Control Box is another of those dialog boxes, like the Property
Dialog, that you never have to close. You can close it, whenever you want to, by
clicking on its Close button, or by clicking again on the Movement Control Box
button
on the toolbar. Closing it does not cancel the current drag-and-move
action type, nor does it cancel Moving/Resizing. It just gets the dialog out of the
way.
In practice, you may find it more convenient to move it out of the way (if it’s in the
way) and leave it open, if you are using its buttons and switching repeatedly from
one drag-and-move action to another. When the Movement Control Box is open,
you can do anything, in the Diagram Window or anywhere else, that you can do
when it’s closed.
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Fixed Point When you enable moving/resizing, the default mode is Box and Bar (see figure 29).
Moves In this mode, any click-and-drag on a box is a Box Move. And Bar Moves are also
enabled. So there is no need to open the Movement Control Box to do these.

To enable Fixed Point Moves click on Fixed point in the Movement Control Box.
Do this now. When you do this, the little selection markers continue to be white,
and you can still click-and-drag on a selection marker to resize a box. But the tiny
white diamonds have gone. You cannot do either Box Moves or Bar Moves in this
mode.
Click on Anthony Edward Munro’s box and click on the Set button in the
Movement Control Box. When you do this, a thick red frame surrounds Anthony
Munro’s box (see figure 30 below). It has been marked as a fixed point. Now when
you click and drag on other boxes, they will move relative to that fixed point.

Separating Try this out now: click-and-drag Julia Fish’s box to the left. And click-and-drag
Spouses Susan Dowling’s box to the right. Notice that, as always, the rest of the diagram

automatically adjusts itself to accommodate the change you are making. Notice
that as well as separating them you can also drag them back together again. Do that
now with Anthony’s spouses – drag them back next to him.

Separating Now find Julia Munro’s box (Anthony Munro’s younger sister). Zoom back and
Siblings scroll if you need to. You will remember from Chapter 3 that pressing-and-holding
) so that you can
the space bar switches you momentarily into Grabber mode (
then click-and-drag anywhere on the diagram to move the whole diagram (it’s a
very useful technique so worth remembering, and it works even if you are movingand-resizing). Try it now to reposition the diagram so that you easily see Julia
Munro’s box. Try to arrange things so that you can still see Anthony Munro’s box
too.
Now click-and-drag Julia Munro’s box to the right. If Julia had had younger
siblings, they would have been pushed right too. Now drag her box back.
Now try it again but this time try clicking-and-dragging on her spouse or child or
grandchild. Notice that it doesn’t make any difference which you click-and-drag on.
The whole of Julia’s branch moves together.

Figure 30 – The thick red frame round Anthony Munro’s box shows that it has been set as a fixed point. Clickingand-dragging on either of his spouses will move them away from him (or back)

Separating
Entire
Branches

We’ve already seen that you can use fixed point moves to drag spouses away from,
or back towards, each other. And you can do the same thing with siblings. But it
works just as well with cousins too. In fact you can set a fixed point in any box in
any branch, and drag entire neighbouring branches away from, or back towards, the
first branch. Try this now.
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Find Caroline Wiley’s box (2nd bottom row) and make it a fixed point – that is,
select her box, and then click on the Set button in the Movement Control Box. You
can only ever have one fixed point at a time, so setting a new one cancels the
previous one. Now click on any box in the branch to the left (e.g. Daniella Smiley,
Carolyn Munro, Frederick Munro, etc). Notice that it doesn’t make any difference
which you pick, you can drag the whole branch leftwards, or back towards the fixed
point.
We have illustrated fixed point dragging with descendant branches; but it works just
as well with ancestor branches too.

Press Alt A quick way to set a fixed point is to press-and-hold the Alt key on your keyboard
Key to Set while clicking on a box. As long as moving/resizing is enabled this will make the
box a fixed point.
Fixed
Points
Quickly
Cancelling
Fixed
Points

You can cancel a fixed point by clicking on the background of the diagram (i.e. not
on a box) when the Alt key is held down. This will switch you back to Box and Bar
mode. Alternatively, if you switch to Box and Bar or Tree mode in the Movement
Control Box (see figure 29 above) that will automatically cancel the current fixed
point if there is one. Finally, if you cancel moving/resizing mode (by clicking on
the
button again to ‘uncheck’ it) this too automatically cancels the current fixed
point, if there is one.

th
Tree Move So we have looked at 3 kinds of drag-move action: box, bar and fixed point. The 4

kind is tree move, and it is the simplest of all of them.
Click on Tree in the Movement Control Box, and then click-and-drag on any box in
the diagram. When you do this, the entire tree moves. As the current diagram only
contains one tree, you are (in this case at least) effectively moving the entire
diagram.

Shift The current spouse layout option puts a man between both of this spouses if he has
Spouses two, as Anthony Munro has. You can choose a different spouse layout option for

the whole diagram in the General tab of the Diagram Options dialog. Or you could
simply shift the spouses around on the diagram.
Select Anthony Munro and click on the left Shift Spouse button:
. That moves
Anthony to the left of both of his spouses. Now click twice on the right Shift
Spouse button

to move him to the right of both of them.

Now click on Julia Fish and click again on the right Shift Spouse button. Notice
that she now has a little 1 to the right of her box, and Susan Dowling has a little 2
next to hers. By default, spouses are numbered if they are shown out-of-sequence.
But you can prevent this if you wish by unticking Number out-of-sequence
spouses in the General tab of the Diagram Options dialog.
Using the shift spouse buttons you can arrange spouses in any order you like.

Shift Now click on Anthony Munro’s box again and click on the left Shift Sibling button.
Siblings Anthony swaps places with his elder sibling Julia. Click on the right Shift Sibling
button to swap them back.
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Shift vs. You may remember from Chapter 5 that you can re-order spouses and siblings using
Move the Move Up
and Move Down
buttons on the application toolbar (or the
Up/Down equivalent commands on the Edit menu). You may be wondering what the
difference is between using the Shift buttons and the Move Up/Down buttons?
The answer (which you will know if you read the text of the Movement Control Box
in its large size) is that the Shift buttons simply shift boxes around in the diagram.
They do not change your records in any way. When you use the Move Up/ Down
buttons to re-order spouses and siblings, however, you are changing the data in your
records. It is true that when you use the Move Up/Down buttons, the boxes change
order too; but they do this because they are reflecting the underlying order of the
spouses and siblings in your records.
In summary then, use the Move Up/Down buttons for Diagram-based Editing. But
use the Shift buttons when you just want to change the appearance of a diagram, for
the purposes of putting together an attractive chart.

Hide Boxes You can hide boxes whenever you want, whether moving/resizing is enabled or not.
Right-click on Ian Stephen Munro’s box and click on Hide in the dropdown menu
that appears (or you could have used the Hide Selected Boxes command on the
Diagram menu). Notice when you do this, not only does Ian Munro’s box
disappear, but so too does his wife’s box, and so too do all of his descendant boxes.

You can hide any box, except a tree root. You cannot hide the root of a tree. But
you can get rid of the tree altogether by deleting it as we will see shortly. When you
hide a box the whole of that person’s branch will be hidden too. You can hide a
spouse box without hiding any descendant boxes that the spouse is attached to; but
not vice versa. So, for example, if you had hidden Charlotte Carrington’s box, Ian
Munro’s box would not have been hidden. But when you hid his box, her’s was
hidden too.
The Hide Selected Boxes command works with multiple selection. But often it’s
not needed, because as we’ve seen, you can hide an entire branch by just hiding one
box.

Show
Hidden
Boxes

As well as being able to hide boxes, you can also unhide them again. To do this,
you first have to make the hidden boxes visible by clicking on Show Hidden Boxes
on the Diagram menu. Do this now. When you do this, all hidden boxes become
visible again – in this case, Ian Munro and his branch.

Unhide When you select a box and click Hide you are setting the Hidden box state on that
Boxes box (see the Box States menu on the Diagram menu). When you show hidden

boxes, any box that has the Hidden box state set displays with a purple background.
In this case, there’s only one – Ian Munro’s box. Although Charlotte Carrington’s
box disappeared when you hid Ian Munro’s box, the Hidden box state is not set on
her box, so it has no purple background. Her box was not hidden because her box
state was Hidden (it wasn’t and isn’t), but because she belonged to Ian Munro’s
branch, and his box had the Hidden box state.
Right-click on Ian Munro’s box. Notice that the Hidden state is ticked. Click on
that command to untick it. His box reverts to its normal colour.
Now untick Show Hidden Boxes on the Diagram menu so that hidden boxes are no
longer made visible. Note that no boxes disappear when you do this. If you hadn’t
unchanged the Hidden state of Ian Munro’s box, he and his branch would have
disappeared again.
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Smart As we have seen, in Family Historian, trees automatically adjust themselves to
Trees accommodate any change you may make – such as moving a box, moving a branch,
resizing a box, expanding a branch, or hiding or showing boxes. This ability to
automatically adjust their layout to accommodate changes, is what is meant when
trees in Family Historian are called Smart Trees.15

Multi-Tree In the ordinary way when you create a new diagram it only has one tree in it. But
Diagrams any diagram can have any number of trees in it. There are 4 kinds of tree:





Ancestor
Descendant
Ancestor and Descendant
All Relatives

Every tree is one of those. For each tree type there is a corresponding diagram, but
the reverse is not true. The ‘Everyone’ diagram is made up of multiple Ancestor
and Descendant trees. There is no ‘Everyone’ tree.

Insert Tree When you insert a new tree into an existing diagram it is inserted into the centre of
the window as you are now looking at it. So it is a good idea, before inserting a
tree, to first arrange the window to leave a suitable empty space in the centre of the
window. There is no need to do this very carefully. You will be able to reposition
the new tree once you have inserted it. But there is no point in creating unnecessary
confusion by inserting one tree straight on top of another.
To insert a new tree into an existing diagram, you click on the Insert into Diagram
menu command on the Diagram menu, and then select the tree you want from the 4
listed on that submenu. A quick way to get at the same menu is to right-click on the
background of the diagram. In the dropdown menu that appears, Insert into
Diagram is the first item on it.
We will now insert a tree into the current diagram.

Steps
1.

2.

Click on View Whole Diagram

to zoom back out. Then press the

spacebar to switch temporarily to Grabber mode
and click-and-drag
downwards on the diagram (anywhere on the diagram) to move the whole
diagram downwards, until the topmost box is near the bottom of the window.
Click on Diagram > Insert into Tree > All Relatives Tree. The Add Tree to
Diagram Dialog appears (see figure 31 below). Click on the Select button and
choose Jonathan Wesley Hodges. Leave other settings unchanged and click
OK. The new tree is inserted into the diagram, with a duplicate family link
linking the family of Jonathan Hodges and Julia Munro, which has boxes in
both trees. Anthony Munro Hodges gets a separate individual duplicate link of
his own. Click on View Whole Diagram
see the whole diagram again.

15

to zoom back so that you can

Trees are also dynamic (which means that they automatically reflect changes in the underlying data)
and interactive (which means that you can use them interactively – e.g. to change your underlying data
using diagram-based editing).
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Figure 31
The Add Tree
to Diagram
Dialog.

Move Tree Family Historian assumes that the first thing you are likely to want to do, after
After Insert inserting a tree into a diagram, is to move it to a good position. So whenever you

insert a tree into a diagram, moving/resizing is automatically enabled, and the mode
is automatically set to Tree Move.

Click-and-drag now on any box in the new tree that you have just inserted, and
move it from side to side to confirm that you are in Tree Move mode. Notice also
that the Enable Moving/Resizing button

is pushed in. Click on the Movement

Control Box button
to open the Movement Control Box Dialog (see figure 29
above). Notice that the Drag-and-Move Action is now set to Tree. Close the
Movement Control Box Dialog again, but leave moving/resizing enabled.

Trees are
Smart,
Diagrams
aren’t

Now move the new tree so that some of its boxes overlap the original tree. Notice
that the trees will overlap. The original tree does not move to get out of the way of
the new tree. You may be wondering why not. Aren’t trees supposed to be smart?

Front-toBack
Ordering

You will have noticed that the boxes from the new tree appear in front of the boxes
of the original tree. Suppose you wanted the new tree to be behind the original tree?
Do this now. Right-click on any box in the new tree. In the dropdown menu that
appears, click on Order and then Send to Back. Notice that where the new tree
overlaps with the old tree, it is now the new tree boxes that are behind the old tree
boxes.

The answer is that trees are smart. It is diagrams that are not smart. Or, if you
prefer, another way of saying the same thing is that trees are only smart internally.
A tree will automatically adjust itself to accommodate changes to boxes that are
part of that tree. But trees do not move to get out of the way of other trees. Nor
will they adjust themselves to avoid other diagram elements that we will be looking
at shortly – namely pictures, text boxes, rectangles and lines. So there is nothing to
stop trees from overlapping if you want them to. If you don’t want them to, it’s up
to you to position them so they don’t.

Check For We looked at duplicates in chapter 7. In general, you will usually want to keep the
Duplicates number of duplicate boxes to a minimum. We could have reduced duplication by

stipulating that we only wanted one generation of descendants when we inserted the
new tree. Or we could simply click on the expansion box beneath one of the sets of
boxes for Jonathan Hodges and Julia Munro to hide their descendants who are
unnecessarily duplicated. But you can also get Family Historian to do it for you.
Click now on the Check for Duplicates command on the Diagram menu, and press
OK to confirm the warning dialog that appears.
When you do this, you should see that the descendant branch of Jonathan and Julia
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in the new tree is closed. Jonathan and Julia still have duplicate boxes, so there is
still one duplicate family link; but their descendants are no longer duplicated.
The reason that the branch was closed in the new tree and not the old tree was that
we had moved the new tree to the back. Check for Duplicates works from front to
back. Duplicate branches are closed in the trees at the back, rather than in the trees
at the front.
All trees (and for that matter, all diagram elements) are ordered relative to one
another, front-to-back. If the trees don’t overlap, you won’t be able to simply see in
what way they are ordered, but they are nevertheless. When you first insert a tree, it
will be ordered so that it will appear in front of all other existing diagram elements.
But as have seen, you can change that. Think about front-to-back ordering before
using Check For Duplicates to make sure you get the results you want.

Cancel Find a suitable place to put the new tree and then cancel moving/resizing. You do
Moving/ this by clicking on the Enable Moving/Resizing button
. If it was ‘pushed in’,
Resizing when you click on it, it should pop back ‘out’ again.
Tree Type
in Status
Bar

When you only have one tree it’s easy enough to remember what kind of tree it is.
Often you can see at a glance just by looking at it, that it is an Ancestor,
Descendant, Ancestor & Descendant or All Relatives tree. Sometimes, however,
you can’t easily tell just by looking at it. And if you have multiple trees in one
diagram, it is easy to forget. And yet it does make a difference. You can do things
with one type of tree that you can’t do with others. You can add ancestors by
clicking-and-dragging on all trees except Descendant trees for example.
You can easily find out what kind of tree you are looking at. Just click on any box
in the tree, and the tree type will be displayed in the status bar. This only works if
moving/resizing is not enabled.

Delete Tree If you want to get rid of a tree, it’s easy to delete it. Just click on any box in the tree
and press the Delete key on your keyboard. You can do this whether or not
moving/resizing is enabled. When you do this the Confirm Delete dialog appears.
The purpose of this dialog is to establish whether you are simply trying to make a
change to your diagram, or whether you wish to delete data records.
Remember that diagrams in Family Historian are used for diagram-based editing, as
well as for putting together wall charts. You can use a diagram, if you wish, to
identify records you wish to delete, and delete them. So Family Historian needs to
know what your intentions are.
In this case, however, we don’t want to delete any data records. We just want to
change the diagram (and get rid of a tree), so leave the default dialog setting which
is to Delete selected diagram items only, and press OK.
When you do this, another warning message is displayed. This time, Family
Historian is warning that if you proceed one entire tree will be deleted.

Each Tree
Counts As
Just One
Diagram
Element

For the purposes of deletion, and for other purposes too – such as front-to-back
ordering – each tree counts as just one diagram element. You can’t delete
individual boxes within a tree. If you want to get rid of them, you have to hide
them. So the message that appears now is to make sure that you realise that you are
about to delete an entire tree. Click OK to confirm. The new tree has now
disappeared. No changes have been made to any of data records.
Do not worry, incidentally, that you might forget what you are doing and
accidentally delete data records when you didn’t mean to. If, when the first warning
dialog had appeared, you had chosen the non-default option labelled “Delete data
records for selected boxes (you will be required to confirm)”, another confirmation
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dialog would have appeared entitled “Confirm Delete Records” with “CAUTION!
Please read carefully…” at the top. The dialog would have explained carefully what
you were about to do and suggested alternative actions if it wasn’t what you meant
to do. Before you could delete anything you would have had to tick a box saying “I
understand that X records will be deleted” (where X is the number that you were
about to delete). Only when you had done that would the Delete Records button
have become enabled; and you would then have had to click on that to actually do
the deletion. So it’s not something that anyone is like to do inadvertently. But that
doesn’t mean you don’t need to take backups! It is always a good idea to take
regular backups to protect you against all the things that can go wrong – and
especially to protect you against your own mistakes.

Insert
Pictures
Into
Diagrams

We have seen how Family Historian will automatically display pictures of
Individuals in boxes for you, if you ask it to (see the Pictures tab of the Diagram
Options dialog). You can also manually insert pictures into diagrams, as separate
diagram elements. If you have a suitable picture you can try this now. The formats
supported are bitmap, jpeg, pcx, tif (or tiff), png, targa, or wmf.
Just as there is no limit to the number of trees you can have in a diagram, there is
also no limit to the number of pictures or other diagram elements that you can have
in a diagram.

Move and
Resize
Picture

Background
Picture

It sometimes happens that when you insert a picture into a Family Historian, you
discover for the first time how big your picture really is! When inserted it will be
displayed it at its full size.16 If you can’t see the diagram any more because the
picture has completely covered it, click on View Whole Diagram. Look at the
edges of the picture. Can you see white selection markers? Click-and-drag on any
of these to resize the picture. You have to enable Moving/resizing to move or resize
a tree or parts of tree. That does not apply to other diagram elements. These can
always be moved or resized. To move a picture (or any other diagram element)
simply click-and-drag on it, to move it to where you want it to go.
We saw earlier how trees are ordered front-to-back with respect to one another.
This applies not just to trees but to all diagram elements, including pictures. When
a picture is first inserted, it will be layered in front of all existing diagram elements
– which is why it may cover them. If you want to use a picture as a background
picture, that’s not a problem. Right-click on it, anywhere and a dropdown menu
appears. Click Order and then Send to Back to move the picture behind all other
diagram elements.

Format Right-click on a picture to bring up a Format dialog, to specify whether you want a
Picture border round the outside of the picture, and if so, how thick and what colour.
Insert Text As well as pictures, you can also insert as many text boxes, lines and rectangles as
Boxes you like into any diagram. To insert a text box, click on Diagram > Insert into
Diagram > Text Box. When you do this, the cursor will change to look like a

cross-hair:
. Click-and-drag on the diagram to draw a stretchy box where you
want the text box to go. When you release the mouse button the text box Format
dialog will be displayed (see figure 32 below).

Format Enter what text you want in the Text tab. You can use text boxes for titles or
Text Boxes annotations, or anything else you can think of. Each text box can have its own font,
alignment (left, right, centred or justified), and inner margins.

Using the Insert Data Reference button you can insert a data reference into the
16

Other programs like MS Word will automatically resize a large picture if it is too big to fit into the
current document, given the current page size. As Family Historian has no equivalent size limits,
pictures are never too big and are consequently never automatically resized.
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text. When the diagram is displayed, the data reference will be replaced by the
name or other details of the diagram root. If you were using the text box as a title,
for example, and you were creating a custom diagram type (see chapter 7) you
might use text like this: “Relatives of %INDI%”. The data reference is the
‘%INDI%’ bit. If a custom diagram type had that title, it would show the correct
title, no matter which Individual had been selected as the root.
The Line and Fill tab (see figure 32) allows you to specify whether you want a
frame round the text, and if so how thick and what colour. You can also specify
whether you want the areas behind the text to be ‘filled’ or transparent, and (if
filled) what colour.
When you have entered details, press OK to close the Format dialog. You can
modify text box details whenever you want by right-clicking on the text box and
selecting Format from the dropdown menu that appears.

Figure 32
The Text box
Format Dialog

Insert Inserting rectangles is similar to inserting pictures. Select Rectangle on the Insert
Rectangle into Diagram menu (remember that if you right-click on the background of the

diagram Insert into Diagram will be the first item on the dropdown menu that
appears). Then click-and-drag on the diagram to draw a stretchy box in the shape
of the rectangle you want. When you release the mouse button the rectangle will be
inserted. Click-and-drag on the selection markers to resize the rectangle.
If a rectangle has no ‘fill’, you have to click on the frame to select the rectangle, or
click-and-drag on the frame to move it. However, if it has a fill, you can click
anywhere inside the rectangle to select it, and can click-and-drag anywhere on it to
move it.

Format Right-click on a rectangle and click on Format on the dropdown menu that appears,
Rectangle to bring up a format dialog for the rectangle. This allows you to specify a ‘fill’ for
the rectangle if you want one, and other details.
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Insert Line Inserting lines is similar to inserting rectangles. Select Line on the Insert into
Diagram menu. Then click-and-drag to draw a stretchy line. When you release
the mouse button the line will be inserted. Click-and-drag on the selection markers
to move the ends of the line. Click anywhere on the line to select it. Click-and-drag
on it to move it.

Format Right-click on a line and click on Format on the dropdown menu that appears, to
Line bring up a format dialog for the line. This allows you to change the thickness and
colour of the line.

Delete
Diagram
Elements

Deleting any diagram element is simple: just click on it to select it, and then press
the Delete key on your keyboard. Whereas you will be asked to confirm if you try
to delete a tree, you won’t be asked to confirm the deletion if you are deleting a
picture, text box, rectangle or line.

Moving
Tree
Branches
Anywhere

We saw earlier how to move branches within a diagram using Box Move, Bar Move
or Fixed Point Move. In each case though there were constraints on where the
branch could be moved to. But suppose you want to move a branch with no
constraints? Suppose, for example, you wanted to Peter Munro’s branch of the
family to put it at the top of the diagram, above both of his parents?
There is no branch move that will let you do that. But using the techniques we have
already learned in this chapter, you can get the desired result anyway. All you need
do is hide the branch that you wish to ‘move’. Then add a tree corresponding to the
branch and position it in the desired location. Finally, insert lines into the diagram
and using as many lines as you need, link the ‘moved’ branch back to where it came
from.
To do this with Peter Munro, you would first hide the box for Peter Munro. When
you do this, his spouse and all of his descendants will disappear. Then insert a
Descendant tree for Peter Munro and position it where you want it to go. Finally
add all the lines you need to link Peter Munro back to his parents.

Saving a
Diagram as
a Chart File

When you are opening a diagram for browsing, navigating or editing, you don’t
usually need it again when you’ve finished whatever you were doing. You can
always open another diagram as needed. But when you are creating a wall chart, or
a chart that is to be kept and sent to others, your diagram is of value in itself and you
will want to be able to save it.
You can save any diagram in a number of different picture formats; but if you want
to be able to save it exactly as it is now – so you can open it in a Diagram Window
and carry on working on it another time – you must save it as a file in Family
Historian Chart format. If you click Save Diagram on the File menu, this will save
the diagram in Family Historian chart format. Clicking File > Save Diagram As >
Family Historian Chart is another way saving a diagram as a file in Family
Historian Chart format.

You Can’t
Open a
Chart On
Its Own

Before you open a chart file, you must already have opened the family tree data file
(that is, the GEDCOM file) that it came from. Then click on Open Diagram on the
File menu and select the chart. It will be opened in a new Diagram Window.
If you tried to open a chart when you were looking at the wrong GEDCOM file (not
the one that it came from) a message box would tell you that it was the wrong data
file, and would tell you the name of the original file that it was created from. You
would be warned that if you proceeded you are unlikely to get any useful results,
and you may see little or nothing of the original chart; but you won’t actually be
prevented from proceeding if you decide to do so.
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Charts Are
Still
Integrated,
Interactive
and
Dynamic

When you open a previously-saved chart you should find that (with a caveat that I
will come on to in a moment) it looks exactly as it looked when you saved it. Not
only that, but you can continue doing everything with it that you could do before you
saved it. The diagram is still tightly integrated. It is still dynamic. That is, if you
make a change to the data in your records, the diagram will update immediately to
reflect the change. It is still completely interactive. You can click on expansion
boxes to hide or show branches. You can click-and-drag to add records using
diagram-based editing. The trees are still smart trees. Everything is as it was before
you saved the diagram. Or at least (and this is the caveat) the chart will be the same
if you haven’t changed anything else.

Charts
Reflect the
Current
Reality

Suppose you saved a chart of Michael Munro’s relatives, but after you saved the
chart, you deleted one of his children and added some new grandchildren. What
would you see when you re-opened the chart?

How to
Ensure
that a
Chart
Doesn’t
Change

The answer is that you will see the new grandchildren (or at least, if expansion
buttons are enabled, you will see an expansion button at the appropriate place to
show where the grandchildren go) and you won’t see the deleted relatives. Charts
reflect the current reality. If the data in the family tree data file has changed since
the chart was saved, the chart will show the changed data. A chart does this by
synchronising itself with the current data file when it is opened.
If you have a chart that is just the way you want it, how can you keep a copy of it
exactly as it is now, that is guaranteed to look exactly as it does now when you open
it again? The answer is: you must not only save the diagram as a Family Historian
chart, you must also save a copy of your family tree data file. Then when you want
to re-open the chart, you should always open the copy of your family tree data file
first and then open the chart file (and, of course, you must be sure that you never
change the copy of the family tree data file).
Even if you do this, there could still be changes, if you change the text scheme that
the chart used, or if you change the multimedia associated with your family tree data
file.

Saving
Charts As
Pictures

You can save any diagram in a choice of 9 different picture formats. Most of these
formats are not suitable for really big diagrams. If you find that you cannot save a
diagram in one format, try another. Enhanced Metafile (.emf) is probably the best
choice for very large diagrams.

Copy You can also copy a diagram, or part of a diagram, to the clipboard using the Copy
Diagram Diagram command. This is available on the Diagram menu. When you click on
Copy Diagram, the Copy Options Dialog opens (see figure 33 below).

Choosing All Pages as the area to copy will result in a larger area being copied than
Whole Diagram. The former sizes the entire grid of occupied pages. Depending
on how page boundaries are positioned, this may result in a lot of unused extra
space being copied. Whole Diagram by contrast pays no attention to page
boundaries and just copies the diagram itself.
Diagrams can be copied in either enhanced metafile format or bitmap format, using
either the currently displayed size (i.e. the current zoom level) or the ‘actual size’
(i.e. 100% zoom). Having copied a diagram in either of these formats, you should
then find that you can paste it into another application – such as word-processor
document. Be aware, when you do this, that many applications will automatically
resize images when you paste or otherwise insert them into the document, if they are
too large to fit.
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Figure 33
The Copy Options Dialog
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This step presupposes that you have...
Read the Introduction and Chapters 1 & 3.

You will learn how to...
Print diagrams
Understand how a diagram will print, before you print it
Control the size and layout of a diagram, when printed
Prevent diagram boxes from printing over page edges
Print a diagram in black and white, and control other aspects of printing
Use the Print Preview screen

Preamble In this chapter, we will look at issues to do with printing diagrams. You will need
to have a printer installed and available to be used from your computer.

This chapter uses, but does not alter, the file saved at the end of chapter 6. If you
skipped chapter 6, or read it but didn’t create your own file, use the ‘pre-cooked’
version (see “Tutorial Files (referred to in the manual)” on the Help menu).
You should open the file you plan to use now. Then locate Thomas Peabody in this
file, and open an Ancestors diagram for him.

Print To print a diagram, at any time, simply click on Print on the File menu. You don’t
Diagram have to print the whole diagram. You can print individual pages (or a range of
pages) if you want to.

As we saw earlier, zooming in and out has no effect on how a diagram will look
when printed. So how can you tell what a diagram will look like when printed?
Diagrams in Family Historian do not have to print on a single sheet of paper. If you
want, you can (and many people do) print diagrams big enough to cover an entire
wall. Assuming that your printer doesn’t print wall-size sheets of paper, the only
way you can do this is either to get a professional genealogy printer to print you
diagrams for you, or print the diagram yourself on a large number of sheets of paper
and fix them together somehow. Most printers do not print right up to the edge of
the paper. If yours doesn’t you will either have to accept that there will be gaps at
the edges of each page, or you will have to cut off the unused edges of the paper.
Tip: If you’re printing a large diagram on many pages, it’s a good idea to write the
page number in pencil on the back of each page to make it easier to remember how
they fit together.

Show Page To determine how a diagram will look when printed, the first step is to find out how
Boundaries many pages it will print on, and which bits of it will print on which page. The Show
Page Boundaries button achieves both of these for you.
Steps
1.

Click on the Show Page Boundaries button
now. The button stays
depressed, and a grid of dotted lines appears behind the diagram. To ensure
that you can see the grid clearly, zoom out now (press Num–) until you can
easily see the whole diagram and at least 1 extra unused grid square on each
side of it. Unused grid squares (that is, grid squares which will not print) have
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2.

3.

Position
Diagram
on Printed
Page

a white background. You will probably find that the diagram occupies only a
single grid square – but this will depend on your paper size and the print
orientation.
Click the Show Page Boundaries button a few times to make the grid
disappear and re-appear. You should notice that at the top left-hand corner of
each occupied (i.e. not empty) grid square is a page number. The grid squares
correspond to printed pages. If you printed the diagram now, only the grid
squares that have page numbers would print. The other empty grid squares
with a white background would not print.
Click on the View Whole Diagram button
now. The behaviour of this
command is slightly different when you are viewing page boundaries. Instead
of arranging the diagram so that it fits nicely inside the current window, it
arranges it so that all occupied pages fit inside the current window. This should
make it easy to see at a glance exactly how many pages will print, and where
different bits of diagram will print on each of them.

How do you position the diagram relative to the grid of pages so that you can
control whereabouts it appears on the page, when printed? In Family Historian you
can do this by moving the elements that make up the diagram (in this case, a single
tree); but the recommended approach is to move the grid instead.
In this example, we will assume that the diagram will currently print on a single
page, and we will move the grid to force the diagram to print on 4 sheets of paper
instead (not something you will usually want to do in practice, but it will help make
clearer how the grid works).
First ensure that the grid is visible and that you have clicked View Whole Diagram
so that you can see all occupied pages.
Steps
1.

2.

3.

Grid intersections are the points where grid lines meet. Pick any grid
intersection, and move the cursor carefully so that the tip of the cursor is over
the intersection. You should see that the cursor changes to this shape:
.
Click the left mouse button and, keeping the mouse button pressed, move the
cursor. You should find that you move the entire grid when you do this (if not,
repeat steps 1 and 2 taking care to ensure that the cursor has the required shape
at the moment when you click the mouse button). Move the mouse so that the
intersection you are dragging is roughly between the boxes for Ian Peabody and
Fiona Peabody.
Release the mouse button. Now click on the View Whole Diagram button.
You should find that the diagram now occupies 4 grid squares (conceivably
more if you have every small paper, but it’s not likely). If you printed the
diagram now, 4 sheets of paper would print.

In some ways this may appear to be a back-to-front way of doing things. It may
seem more natural to move the diagram relative to the grid, rather than move the
grid relative to the diagram. But it amounts to the same thing. The effect is that you
have adjusted whereabouts on the printed page the diagram will appear.

Print Now click on Print Preview on the File menu. You can use the Next Page button
Preview on the toolbar to step through each page in turn. If there were 4 occupied pages in
the grid, there should be 4 now. Confirm that the results were what you expected.
Remember that each previewed page should correspond to what you see in the
preview.
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Printing
the Background

If you used default settings for your Ancestor diagram, it should have had a striped
background, and expansion buttons should be visible in the Diagram Window. But
in the Preview window, the background is white, and the diagram has no expansion
buttons. This is because, by default, the diagram background doesn’t print, and
neither do expansion buttons. Close the Preview dialog now by clicking on the
Close button on the toolbar.

The Print Open the Diagram Options dialog, and click on the Print tab. Tick Print
Tab Background, and untick Never print expansion buttons. Press OK to close the
Diagram Options
Dialog

Diagram Options dialog and click on File > Print Preview to view the preview for
the diagram again. This time you should see the striped background. You should
also be able to see expansion buttons.
Close the Preview window, and go back to the Print tab in the Diagram Options
dialog now. Click the Installation Settings button to revert to default settings, and
press OK.

Black-andwhite and
Colour
printing

By default, Family Historian will print diagrams in colour. If you just want to print
a draft version of a diagram, you can, if you wish, specify that text, lines and boxes
should print in black-and-white only. To do this, check Print text, lines and boxes
in Black and White only in the Print tab of the Diagram Options Dialog. You
can check the effect of this by looking at the diagram in Print Preview.

Landscape When you look at the grid, are the squares wider than tall or taller than wide? If the
vs. Portrait former, your printer is currently set for Landscape mode. If the latter, it is currently
set for Portrait mode. To change this, click on Page Setup on the File menu now.
Does the dialog that appears look familiar? It should do? It is the Print tab of the
Diagram Options Dialog (but without the other tabs). Choose the Orientation that
want, and press OK.
If you have changed orientation, you should see that the grid squares have changed
shape too.
Now switch back to Landscape mode (if you aren’t already in Landscape mode),
and click-and-drag on the grid intersection to position the diagram right in the
middle of a grid square (any grid square). Assuming your paper is not very small,
you should find that you can the whole diagram onto one page. Press View Whole
Diagram to view the whole thing.

Scaling Suppose your diagram had been too large to fit onto a single page? How could you
make it smaller?
The size of a diagram is affected by a great many things. For a start, there is the
amount of text displayed in each box, the font sizes used for the text, the number of
generations in the displayed tree(s), whether spouses are displayed in their own
boxes or not, whether pictures are displayed or not, and if so at what size – not to
mention the dimension settings (see the Dimensions tab of the Diagram Options
Dialog). Even the orientation of the diagram has an effect. Top-down diagrams
tend to be wide. Left-right diagrams are often more compact.
If you want to change the size of your diagram, one option is to change any or all of
the above. But what if you don’t want to? What if you want your diagram to print
exactly as it is now, only smaller?
For this you need to adjust the Scaling setting. To change scaling open the
General tab of the Diagram Options dialog. Set the Scaling field to 50% and press
OK. Normal scaling is 100%. If you set Scaling to 50%, each box in the diagram
will be half the height that it had been before, and half the width. The combined
effect of this is that the diagram as a whole will take up only one quarter of the
space that it had previously taken up when printed.
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When you adjust diagram scaling, the diagram may appear to have moved on the
printed page. Use the techniques described in the section Position Diagram on
Printed Page above to move the diagram back into the middle of a grid square.

Zoom To Don’t assume that because you’ve set scaling to 50% that the diagram will look
Actual Size small on the screen. The size of a diagram on your screen is affected by scaling; but
it’s also affected by the current zoom. To see a diagram in its ‘actual size’ (i.e. at
100% zoom), click on Diagram > Zoom > Zoom to Actual Size.

The current zoom level is always shown in the status bar as a percentage figure
(when the Diagram Window is active). If scaling is not 100%, it too is displayed in
the status bar. As scaling is also expressed as a percentage, the scaling factor
always has the label ‘Scale:’ in front of it, to ensure that it is not confused with the
zoom factor.

Scaling a
Diagram to
Fit a Page
Size

You don’t have to scale a diagram down to make it smaller. You can also scale it
up to make it bigger. For example, a scale of 200% would double the width and
height of each box.
Let us now assume that we want to adjust scaling so that whatever paper size you
are using, the diagram will fit neatly onto a single page. If it is bigger than the
printed page we will make it smaller. But if it is smaller than the printed page we
will make it bigger.
One way to do this would be to keep adjusting the Scaling setting in the Diagram
Options dialog until we’ve found the right setting to give us what we want. This
would be a fiddly way of doing it though as we would probably keep having to
reposition the diagram on the printed page, each time we changed the scaling
setting.
There is another way of doing it. Just as we found that we could position the
diagram relative to the printed page by moving the grid, so too, we can effectively
scale the diagram (adjust the size it will have when printed) by resizing the grid.
First, ensure that the grid is visible and that you have clicked View Whole Diagram
so that you can see all occupied pages.
Steps
1.

2.

3.
4.

Start by moving the grid so that the top-left corner of the occupied area is as
close as possible to the diagram. Click View Whole Diagram again, if
necessary, to ensure you can see the whole diagram.
Now move the cursor over the grid intersection at the bottom right-hand corner
of the occupied area. You should see that the cursor changes to this shape
again. This time, however, click the right mouse button and, keeping the button
pressed, move the mouse slowly in the direction of the intersection in the topleft corner of the window. You should find that the entire grid changes size and
each grid square becomes smaller when you do this. Find the position where
the whole diagram fits neatly into a single grid and release the mouse button.
Take note of the ‘Scale:’ value in the status bar. That is your current scaling
setting. If it is larger than 100% you have enlarged the diagram to fit the page.
You may want to reposition the grid slightly at this point to centre the diagram
nicely in its grid square.

Note: When you make the grid squares larger, you are effectively making the
printed size of the diagram smaller. When you make the grid squares smaller, you
are effectively making the printed size of the diagram larger. If this seems
confusing, remember that each (occupied) grid square corresponds in the real
world, to a printed sheet of paper , and that nothing you are doing is actually
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changing the size of real world bits of paper. In resizing the grid, you are actually
just changing the relative size of the printed diagram, and the paper upon which it
will be printed.
Tip: You don’t have to use the bottom-right intersection to resize the grid. You can
click-and-drag on any intersection. But in practice it is usually easiest if you use
the bottom-right one.

Avoid Page As we have seen, diagrams can print on multiple pages, either horizontally,
Boundaries vertically or both. You may want to arrange your diagram so that boxes do not print
over the edges of diagrams.
To ensure that boxes do not overlap the edges of pages (either at the side or at the
top and bottom) click on the Avoid Page Boundaries button:

.

If page boundaries are not visible, you should make them visible now by clicking on
Show Page Boundaries. This just makes it easier to see what effect the Avoid
Page Boundaries button has.
Now use the technique described in Position Diagram on Printed Page, above, to
move the grid relative to the diagram. Notice that you cannot position a grid line on
top of a node. Or rather, if you do so, the diagram adjusts itself so that boxes are
moved away from the page edge.
You can configure exactly how close a box is allowed to come to a page edge, when
you are avoiding page boundaries. There are 2 settings that determine this. They
are labelled Avoid boundaries gap (‘Horz.’ and ‘Vert.’). These can be set in the
More Dimensions Dialog which you can reach by clicking the More Dimensions
button in the Dimensions tab of the Diagram Options Dialog.
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This step presupposes that you have...
Read the Introduction and Chapters 1, 2, & 3.

You will learn how to...
Add pictures to a Family Historian file and link them to one or more individuals
Distinguish between embedding files, and linking to them
Use the Multimedia Window, and its menu and toolbar
Create frames (chosen areas within pictures) and link Individuals to them
Manage and understand Frames, Links and Notes
Display and manage pictures in diagrams
View all pictures of an Individual in date order, and the Individual’s age at the time
Add sounds to a Family Historian file and link them to one or more individuals
Add documents to a Family Historian file and link them to one or more individuals
Play sounds and view documents
Manage links to external files

Preamble In this chapter we will look at how to work with pictures and other multimedia
objects. You will learn how to associate pictures with Individuals, Families and
Source records; and then make use of these pictures in reports and diagrams.
In some ways we are approaching things in the wrong order, because we have
already looked at how pictures can be used in diagrams. In chapter 7, we saw how
to make Family Historian display pictures of Individuals in boxes. In order for that
to be possible, the Individuals concerned had to already have pictures associated
with them. In this chapter, we will learn how to associate pictures with Individual
records. We will also look at other things that you can do with pictures.
Ordinarily, the first thing you need to do, when working with pictures (and other
multimedia), is to get them onto your computer in a digital form – assuming that
they weren’t in a digital form when you acquired them. If you have a digital
camera, it will have instructions on how to do this. You can also use a scanner, to
scan the pictures into the computer. The pictures we will refer to in this chapter, are
already in digital form, and were installed onto your computer as part of the
software installation.

Open a File Start by opening the file from Chapter 6.
Steps
1.

From the File menu, click on Open (or click on the Open button on the
toolbar). Locate the file you saved at the end of Chapter 6. It should be called
“Tutorial – Chapter 6” (it will have a “.ged” suffix, if you are displaying them).
Press OK.

If you skipped chapter 6, or read it but didn’t create your own file, use the ‘precooked’ version (see “Tutorial Files (referred to in the manual)” on the Help menu).

Save As You should save the file now under a new name. See the discussion in the Save As
section in Chapter 4, for the reasons for this.
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Steps
1.

From the File menu, click on Save As. Use the same folder as before and save
the current file as “Tutorial – Chapter 10”. Press OK.

Insert We will start by inserting a picture of Cameron Peabody.
Pictures
Steps
1.
2.

Locate Cameron Peabody in the Records Window. Select his record.
Click on Pictures... on the Insert menu. A file dialog opens titled “Insert
Pictures”.
3. Locate the “Tutorial Files” folder (see “The Tutorial Files Folder” in the
Introduction which tells you where it is). There should be 3 files visible. Select
“Peabody – Cameron & Jean Clare Anderson”. You should see a picture in the
Preview box.
4. Confirm that Store link to picture file (recommended) is checked for the
Picture storage options.…
5. Check record linked to Cameron PEABODY in the Insert as New... area.
6. Click Open.
7. The Multimedia Window opens, displaying the picture you saw in the Preview
box. It shows 3 adults standing (2 women and a man, with the man in the
middle) and 3 children seated at their feet. The title of the Multimedia
Window (i.e. in the title bar - not the Title field) is “Multimedia Linked to
Individual Record: Cameron PEABODY”.
8. The Title field (in the area above the picture) has defaulted to the file name:
“Peabody – Cameron & Jean Clare Anderson”. Change this to “Cameron &
Jean Clare + 4 others”. Press Tab.
9. In the Date field, type “1935 (app” (you don’t need to bother with the closing
bracket) and press Tab. The field should change to “1935 (app)”. If it doesn’t,
type the text in again, or double-click on the field and use the Date Entry
Assistant Dialog.
10. In the Note field, type “Photo has ‘Margo’s wedding’ in pencil on the back. Is
not known who ‘Margo’ was.”
It wasn’t actually necessary to select Cameron Peabody before clicking on Insert >
Pictures... The only effect of doing this was for Family Historian to provide the
option for the pictures(s) to be inserted as pictures of Cameron Peabody. If no
record had been selected when you opened the dialog, the only option would have
been to insert the pictures as unlinked records. However, as you can create or
remove links whenever you wish, it doesn’t much matter which way you do it.
Tip: You don’t have to just insert one picture at a time. You can insert as many
pictures as you like in one go.

Linking vs. In this example, what we inserted wasn’t actually the picture file itself, but a link to
Embedding the picture file. This is because we chose the option Store link to picture file
(recommended) as Picture Storage Option. Family Historian will allow you
either to embed, or link to, multimedia files17.

An embedded multimedia object is stored within your Family Historian file. A
linked multimedia object is not stored as part of the Family Historian file. Instead,
the multimedia object is stored elsewhere – perhaps elsewhere on the hard disk, or
on a CD – and the Family Historian file contains a link to the multimedia object’s
file.

17

You can in fact embed, or link to, any kind of file; but in practice the files you are likely to want to
embed, or link to, are multimedia files – pictures, sounds, videos, documents, etc – so they are usually
referred to as multimedia files.

108

Chapter 10 – Pictures and Other Multimedia

Although, you can embed multimedia objects, you are not recommended to do so.
You should link to them instead. Pictures and other multimedia can be very large,
and will make your Family Historian files very large. Although the GEDCOM
format supports embedded multimedia objects, it is not a good format for storing a
large number of embedded images. Loading and saving files containing embedded
pictures will be slower than loading and saving files containing linked images.
There are other advantages to keeping your multimedia files external – for one thing
you can then use the file system to organise them into a sensible directory hierarchy.

The Like the Diagram Window, the Multimedia Window has its own menu (the
Multimedia Multimedia menu) and its own toolbar, both of which only appear when the
Multimedia Window is open and active.
Menu and
Toolbar
The
Multimedia
Window

Like the Records Window and the Diagram Window, the Multimedia Window is
another MDI Child Window. And like all Family Historian MDI Child Windows, it
has its own Navigation Bar Icon – the first of the two icons shown on the left. The
second icon is the Multimedia Window’s toolbar icon (see later for more on this).
The Multimedia Window is divided into 2 areas, divided by a vertical dividing
line. The area on the left is called the Context Pane. The Context Pane, is itself
broken down into 3 areas. These are:




The Objects List (top-left, with label ‘Pictures Etc’)
The Links and Notes List (below the Objects List)
The Link Note field (below again)

The area to the right, consists of the Title Pane at the top (where the Title, Date and
Note fields are located), and, underneath it, the picture itself.
The partition lines between the Context pane and the right side of the Multimedia
Window, and between all 3 areas within the Context pane, can all be moved. Move
your cursor over any of these partition lines and click-and-drag to reposition them.

Figure 34 – the Multimedia Window
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Multimedia When you insert a picture, sound, video, document, or any other kind of multimedia
Records object into Family18Historian, a Multimedia record is created to represent that
multimedia object . It doesn’t matter whether the Multimedia object is embedded
or linked. You can see a full list of these Multimedia records in the Multimedia tab
of the Records Window (if it’s currently hidden, you can open it by clicking on
View > Record Lists > Multimedia).

You will remember that all records in Family Historian have their own distinctive
(don’t ask what it’s supposed to
record icon. Multimedia records have this icon:
look like).

The
Objects
List

Switching back to the Multimedia Window, the Objects List displays a list of
Multimedia records19. Currently the Objects List should only be displaying one
record – the Multimedia Record we just inserted: ‘Cameron & Jean Clare + 4
others’ (you can probably only see part of this text). See Figure 34 above.
The Multimedia record that is selected in the Objects List is the one that is
displayed in the Picture Pane. Click on the background of the Objects List now,
to clear the current selection. Notice that the Picture Pane, and the Links and
Notes List are both cleared when you do this. Now re-select the Multimedia record
and notice that the picture is displayed again and the Links and Notes List is
updated to show Cameron Peabody’s record.

The Links Why does the Link and Notes List show Cameron Peabody’s record? Because it
and Notes lists all records that the current multimedia object is linked to. And the current
multimedia object is linked to Cameron Peabody’s record because we stipulated that
List it should be when we inserted it.
Add Frame There are 6 people in the picture. Which of them is Cameron Peabody? We will
now draw a small frame round his face and attach it to the link.
Steps
1.

If Cameron Peabody’s record is not already selected in the Links and Notes
List, select it now.

2.

Click on the Add Frame button
in the Multimedia toolbar. The button
stays depressed.
Move the cursor over the picture. Notice that instead of an arrow, the cursor is
now a cross when over the picture. Click-and-drag to draw a stretchy box
round the head of the man standing in the middle of the picture. Don’t worry if
the box isn’t quite right – you can correct it in a moment. Release the mouse
button when it’s good enough. The Add Frame button ceases to be depressed.
A frame appears with 8 little white boxes round it. Click-and-drag on any of
the white boxes to adjust the shape and size of the frame around Cameron
Peabody’s face (or click-and-drag within the frame to reposition it).

3.

4.

18

Actually this isn’t necessarily true. Exceptionally, Multimedia Objects can be stored as fields within
other records (such as fields within Individual records). However, we will ignore this possibility for
now. Family Historian supports storing Multimedia Objects as fields, because GEDCOM allows it.
But you are not recommended to store Multimedia Objects that way. You are encouraged to always
use a Multimedia record to represent each Multimedia object (linked or embedded).
19
Same caveat as before. They’re not necessarily records – they can be fields. But, again, we will
ignore this possibility for now.
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New Frame
&
Link/Note

We only needed to add a frame for Cameron Peabody because the picture was
already linked to him. However, frequently we want to add both a link and a frame
in a single step. We will do this now, both for Jean Clare Anderson and for her (and
Cameron’s) son, Daniel Peabody – both of whom are shown in the picture.
Steps
1.
2.

3.
4.
5.

6.

File Links
and
Record
Links

Click on the New Frame & Link/Note button
in the Multimedia toolbar.
The button stays depressed.
Move the cursor over the picture. Notice that instead of an arrow, the cursor is
once again a cross when over the picture. Click-and-drag to draw a stretchy
box round the head of the woman standing on the right-hand side of the picture.
Don’t worry if the box isn’t quite right – you can correct it in a moment.
Release the mouse button when its good enough. A dialog appears with the
title “Create Link”.
Confirm that “an Individual” is selected and press OK. A dialog appears titled
“Select Record”, showing a list of Individual records.
Select Jean Clare Anderson’s record, and press OK.
A frame appears with 8 little white boxes round it. Click-and-drag on any of
the white boxes to adjust the shape and size of the frame around Jean Clare
Anderson’s face.
Repeat steps 1-5, only this time draw the frame round the middle of the 3
children, and instead of Jean Clare Anderson, select Daniel Peabody.

It is perhaps worth pausing at this point to try to head off a possible confusion.
When we inserted our picture, we created a multimedia record that stored a link to
an external file. That is a file link. The same multimedia record is also now linked
to 3 Individual records in our Family Historian file. These are record links. Do not
confuse the two. The Links and Notes List displays record links. It does not
display file links.

Browsing The Links and Notes List should be displaying 3 records: Cameron Peabody, Jean
Links Clare Anderson and Daniel Peabody. Click on each of these in turn. Notice that
when you do so, a frame appears round the face of the appropriate person in the
picture.
Steps
1.
2.

3.

4.

Select Cameron Peabody’s record in the Links and Notes List. A frame
appears around his face in the picture.
Now move the cursor over Jean Clare Anderson’s face in the picture. You
should see a dotted box appear over her face. Click inside this box. The frame
round Cameron Peabody’s face disappears and there is now a frame round Jean
Clare’s face. Also, her record is now selected, instead of Cameron Peabody’s,
in the Links and Notes List.
Move the cursor over Daniel Peabody’s face. This time double-click on his
face when the dotted box appears. The Property Dialog appears, showing his
properties.
Select Jean Clare Anderson by clicking on her face. Click on the View
Ancestors and Descendants button. A Diagram Window appears, showing
her ancestors and descendants. Close the Diagram Window again.

The Link The Link Note field if you remember, is the area underneath the Links and Notes
Note Field List. Whenever you add a record link to a Multimedia object, you can also attach a
note to that link.
Steps
1.

Select Cameron Peabody’s record in the Links and Notes List. Click in the
Link Note field and type “Cameron wore spectacles but presumably removed
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2.

them for this photograph.”.
Select Daniel Peabody’s record in the Links and Notes List. Click in the Link
Note field and type “At this point, Daniel’s hair was still fair. Later it became
darker.”

Notes You can add a note with or without a frame, even if there is no link.
without
Steps
Links
1.
2.

3.
4.

5.

Click on the New Frame & Link/Note button
in the Multimedia toolbar.
The button stays depressed.
Move the cursor over the picture. The cursor is once again a cross when over
the picture. Click-and-drag to draw a stretchy box round Jean Clare Anderson’s
dress. When you release the mouse button a dialog appears with the title
“Create Link”.
Select “nothing (note only) and press OK.
A frame appears with 8 little white boxes round it. Click-and-drag on any of
the white boxes to adjust the shape and size of the frame around Jean Clare
Anderson’s dress.
The cursor should be in the Link Note field. Click in it if isn’t, and type
“Michael Peabody says this dress is now in his children’s dressing-up box”.

As this example illustrates, you can use notes without links to comment on any
aspect of a picture.

New In the previous example, we created a frame and a note to go with it. However, you
Link/Note can create links or notes or links-and-notes (henceforth, links/notes) that do not have
frames associated with them. To do this, click on the New Link/Note button
.
The result is the same as if you had clicked on New Frame & Link/Note, except
that you skip the initial stage when you draw a frame, and jump straight to the
“Create Link” dialog, to create the link/note.
Having created a link/note, with no frame, you can always add a frame later if you
want to, by selecting the link/note in the Links and Notes List, and clicking on
Add Frame (see Add Frame earlier).
Why would you want to create a link/note with no frame? You might want to do
this if you wanted to link a person to a photograph even if they weren’t in it (if, for
example, you knew that they had taken the picture). If you wanted to add a note
about the picture itself as a whole, you might create a linkless note, with no frame.
Usually, the place for a note about the picture itself, as a whole, would be the Note
field in the Title Pane.

Insert Last time we inserted just one picture. You can insert multiple pictures, however.
Pictures
Steps
(again)
1.
2.

3.

Click on Pictures... on the Insert menu. A file dialog opens titled “Insert
Pictures”.
Locate the “Tutorial Files” directory (see “The Tutorial Files Folder” in the
Introduction which tells you where it is). There should be 3 files visible in this
directory. Select “Peabody - Amanda & Ian”. You should see a picture in the
Preview box.
Press the Ctrl key, and click on “Prentice Salt - Naomi & Daniel” to select that
too. 20

20

This is a useful technique for selecting multiple items which are not next to one another (works in
most Windows applications where multiple selection is supported). Using click-and-drag to ‘lasso’
items, with a stretchy box, is another technique which works best when items are next to one another.
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4.

5.

Confirm that Store link to picture file (recommended) is checked for the
Picture storage options... Click on unlinked record as the Insert as New...
value. This is because the pictures do not show Cameron Peabody, so we don’t
want to link them to him.
Two new Multimedia records are created to represent the 2 pictures. You can
see both of them listed in the Objects List of the Multimedia Window, as well
as the previous picture you inserted. One of the two new records is selected
and its picture is now displayed. The title of the Multimedia Window says
“Selected Multimedia Records”.

Picture Now supply missing picture details, links and frames.
Details,
Steps
Links and
Frames 1. Select the Multimedia record for the file “Peabody - Amanda & Ian”, in the
2.

3.
4.

Objects List.
A picture is displayed of a girl and a boy. The girl has her arms round the boy,
who is smaller and younger. Notice that the Links & Notes List is empty –
this picture has no links to any other records, as yet.
Change the Title field (in the area above the picture) to “Amanda & Ian
Peabody”. Press Tab.
In the Date field, type “1932 (app” and press Tab. The field should change to
“1932 (app)”.

5.

Click on the New Frame & Link/Note button
and draw a frame round the
boy’s face. Link the frame to Ian Peabody.
6. Click on the New Frame & Link/Note button again, and draw a frame round
the girl’s face. Link the frame to Amanda Peabody.
7. Now select the Multimedia record that was created for the file “Prentice Salt –
Naomi & Daniel”, in the Objects List.
8. A picture is displayed of a woman in a black hat, holding a baby.
9. Change the Title field to “Naomi & Daniel (aged 6 months)”. Press Tab.
10. In the Date field, type “1930 (app” and press Tab. The field should change to
“1930 (approx.)”.
11. In the Note field, type “Daniel’s christening”.
12. Click on the New Frame & Link/Note button
and draw a frame round the
woman’s face. Link the frame to Naomi Prentice Salt.
13. Click on the New Frame & Link/Note button again, and draw a frame round
the baby’s face. Link the frame to Daniel Peabody.

Select Suppose you decide that you want to adjust the frame around Amanda Peabody’s
Frame face?
Steps
1.
2.

Select the Multimedia record “Amanda & Ian Peabody” in the Objects List.
Click on Amanda’s face in the picture (or on her record in the Links and Notes
List – it amounts to the same thing).

3.

Click on the Select Frame button
in the Multimedia toolbar. 8 little white
boxes appear around the frame on the picture, and the Select Frame button
remains depressed.
Click-and-drag on any of the white boxes to adjust the picture until you are
satisfied with it.
Click again on the Select Frame button (or click anywhere else on the picture
or in any of the lists). Amanda’s frame remains at the new position.

4.
5.

Clicking on the first item in a group that you want to select, and then pressing the shift key before
clicking on the last item in the group, is yet another technique.
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Tip: Click-and-drag anywhere inside the frame to move it, when selected.

Pictures in We will now look at how you display pictures in diagrams.
Diagrams
Steps
1.

2.
3.

Select Cameron Peabody’s record, using any technique you like (e.g. by
clicking on the Go To Record button in the Property Dialog when it is
displaying his record, by clicking on his face in the Multimedia Window, by
selecting his record in the Links and Notes List, or by clicking on his record in
the Records Window).
Click on View Ancestors and Descendants.
The Diagram Window should display a picture for everyone who has one – i.e.
Cameron, Jean Clare, Amanda Peabody, Ian Peabody, Daniel Peabody, and
Naomi Prentice Salt. If it doesn’t, open the Diagram Options Dialog and
select the Pictures tab. Select 1st for Preferred Picture. Press OK. The
pictures should now be displayed.

Pictures in You can also see a person’s pictures in the Property Dialog. You should still be
the viewing the diagram you opened in the previous step.
Property Steps
Dialog
1.

2.

3.

4.

Objects in
the
Property
Dialog

Select Cameron Peabody in the diagram and click on the Properties button
(or just double-click on his box). If the Property Dialog is not in Small Mode,
switch it to Small Mode now.
The 5th tab of the Property Dialog is labelled ‘Picture’. Click on it now. The
tab shows a picture of Cameron Peabody – specifically the area that you
framed. In Small Mode, the dialog always shows the first (in order of
preference) picture of the record owner.
Make sure that the Property Dialog is in Pinned Mode (i.e. the Pin is pressed
in and looks like this:
). Now click on a series of records in turn, some with
pictures, some without. Notice that a picture is displayed for Ian and Amanda
Peabody (for example). But if you click on Mary Peabody the text ‘No picture’
is displayed.
Click on Daniel Peabody. Switch the Property Dialog to Large Mode. Notice
that the 5th tab has been renamed, and is now called ‘Objects’.

In Large Mode, the Picture tab becomes the Objects tab. The top part of the dialog
lists all multimedia objects associated with the record owner – in the case of Daniel
Peabody there are two.
The bottom part of the list shows the picture which is selected in the top-half (if it is
a picture). You can switch between seeing the framed area, and the full picture, by
clicking on Full-picture or Close-up at the bottom.
By default, the multimedia objects are displayed in Date order, and the list shows
the record owner’s age at the time of the picture (this presupposes that you supplied
both a date for the picture, and a date-of-birth for the record owner). You can resort the list in other orders, however, by clicking on the column headings.

Higher & There is a column labelled ‘Pref’ which shows the order of preference (with respect
Lower to the record owner – in this case Daniel Peabody) of the Multimedia records in the
list. Select the picture with a ‘Pref’ value of 2, and click on the Higher Preference
Preference
button
, to give it higher preference. It acquires a ‘Pref’ value of 1, and the
other picture is demoted to 2. Henceforth, this picture will be displayed as the 1st
preference picture for Daniel Peabody, in diagrams.
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The
Objects
Tab
Toolbar

As well as buttons to control preferences, the toolbar in the Objects tab has an Open
Multimedia Window button
which will open the Multimedia Window to
view the same list of multimedia objects. Another button lets you remove the link
between the current record and the selected multimedia object. There is a Perform
Action button. This is designed to look like the ‘Play’ button in a cassette recorder.
It is for use with Multimedia records such as Sounds and Videos. For example, if
you click on a Sound multimedia record and click on ‘Perform Action’, an
application should open and the sound file should be ‘played’ so you can hear it
(assuming your computer’s sound system is switched on).
Finally, there is a Go To Record button, which let’s you ‘jump’ to the selected
multimedia object’s own record and display it in the Property Dialog.

View As we have seen, you can see the multimedia linked to any Individual by looking at
Multimedia the Objects tab of the Property Dialog when viewing their record. This works for
Family and Source records too (we haven’t encountered Source records yet). If,
however, you want to see these multimedia records listed in the Multimedia
Window (e.g. if you want to add links and/or frames to these records), the quickest
way to do this is usually to select the Individual and click on the View Multimedia
button

in the application toolbar.

Steps
1.
2.

3.

View
Multimedia
for Multiple
Records

Select Daniel Peabody’s record in the current diagram.
Click on the View Multimedia button on the application toolbar (not the one in
the Objects tab of the Property Dialog, although in this case, pressing it would
have the same effect).
The Multimedia Window appears showing the 2 pictures that include Daniel, in
the Objects List. The title of the window is “Multimedia linked to Individual
record: Daniel Anderson PEABODY”.

The View Multimedia command works both with a single record selection, and
with a multiple record selection. You can select multiple records in the Diagram
Window by clicking-and-dragging on the window background and then drawing a
stretchy box around all the records you want to select (only completely enclosed
boxes are selected). As we shall see later, you can also select multiple records in the
Result tab of the Query Window (we haven’t encountered the Query Window yet
but we shall, shortly).
When you opt to View Multimedia for multiple records, the Multimedia Window
is displayed and the Objects List will show all Multimedia records that have one or
more links to any of the records you selected.

Run
Multimedia
Query

This option is only available from the Multimedia menu, so you must already be
viewing the Multimedia Window before you can do this. We haven’t covered
queries yet, but their use here is very straightforward. When you click on the Run
Multimedia Query command, a list of Individual queries is displayed. It is not
necessary at this point to understand what all these queries do. An example will
suffice. If you select Ancestors, say, a dialog box will prompt you to select a
starting person. Then the query will be run and the Multimedia Window will
update to display all Multimedia records for all the individuals found by the query –
i.e. in this case, all ancestors of the person you selected.
As well as the standard queries that Family Historian was installed with, you can
also create as many custom queries as you like. See Chapter 13 – Custom Queries
for more on this.
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Work with
Multimedia
Objects

As we have seen, the Multimedia Window can display the Multimedia records for a
single Individual (or Family or Source) record. It can also display the Multimedia
for a selected group of records, or for all the records found by a query. Finally, it
can of course also display all Multimedia records in the file.
Steps
1.

Working
with
Multiple
Multimedia
Windows

Click on the Work with Multimedia Objects command on the Tools menu.
The Multimedia Window displays 3 Multimedia records in the Objects List –
i.e. all the pictures in the file. Its title changes to “All Multimedia Records”.

Like the Diagram Window (and unlike the Records Window) you can have
multiple Multimedia Windows open if you want to. To open a 2nd Multimedia
Window when you already have one open, click on the Lock Current Window
button
to lock the active Multimedia Window, or right-click on the
Multimedia Window’s icon in the Navigation Bar, and select the Lock Window
(prevent reuse) command. Then click on a multimedia command such as View
Multimedia or Work with Multimedia Objects, and they will open another
Multimedia Window instead of reusing the current one.

Insert We will now insert a record of Daniel Peabody reciting a verse from a poem.
Sound
Steps
1.
2.
3.
4.

5.
6.
7.

Click on Other Multimedia... on the Insert menu. A file dialog opens entitled
“Insert Other Multimedia”.
Locate the “Tutorial Files” directory (see “The Tutorial Files Folder” in the
Introduction which tells you where it is). Select the file called “The Jumblies”.
Insert as New... should be set to unlinked record. Other values can be left at
the default.
A new Multimedia record is created for the new sound file, and it appears in the
Object List in the Multimedia Window, and is selected. A small icon
representing the sound file appears in the top-left corner of the area in which
pictures are usually displayed.
The Title field should say “The Jumblies”. Leave this unchanged.
In the Date field, type “1970 (app” and press Tab. The field should change to
“1970 (app)”.
You can only add Frames to pictures, so the Frame-related buttons on the
Multimedia Toolbar are all greyed. Click on New Link/Note button
instead, and link the sound file to Daniel Peabody.

Play Sound Up to now, the Perform Action button

has been greyed. This is because it is
not used with pictures (or not, at least, with pictures that are in a format that Family
Historian can handle itself).
Now play the new sound file by clicking on the Perform Action button. When you
do this, another application should open, and if your sound system is enabled, you
should be able to hear a voice reading a verse from the poem “The Jumblies”, by
Edward Lear.
There is no way of knowing which application will play the sound file for you. It
depends on what software you have installed on your computer. If you have no
special sound software, you will probably find that the application is the Windows
Media Player. When the poem is finished you will probably want to close the
application that was opened.
As we saw earlier, you can also perform actions such as this in the Objects tab of the
Property Dialog.
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Insert A very common requirement is to link external documents to records in your file.
Document We will link such a document to Cameron Peabody.
Steps
1.

2.
3.

4.
5.

6.
7.
8.

Select the record for Cameron Peabody using any technique you like, and click
on the View Multimedia button
. The Multimedia Window opens (or
rather updates itself, as it was already open) to show Cameron’s linked
multimedia (one picture). The title reads “Multimedia linked to Individual
record: Cameron PEABODY”.
Click on Document... on the Insert menu.
Locate the “Tutorial Files” directory (see “The Tutorial Files Folder” in the
Introduction which tells you where it is). Select the file called “I Did it My
Way”.
Confirm that the Insert as New... value is record, linked to Cameron
PEABODY. Leave other values unchanged and press OK.
A new Multimedia record is created for the document, and it appears in the
Object List in the Multimedia Window, and is selected. A small icon
representing the document appears in the top-left corner of the area in which
pictures are usually displayed.
The Title field should already contain “I Did it My Way”.
In the Date field, type “12 June 1971” and press Tab.
In the Note field, type “Cameron’s barely-started autobiography”.

View To view Cameron’s autobiography, you can select it in the Object List and click on
Document the Perform Action button
. Or you could just double-click on its icon.
An application should appear displaying the contents of the file.
It is just possible that an application might not appear, and that you might get this
message instead: “There is no application associated with the given filename
extension”. If this happens, you need to associate an application with files that
have a .RTF extension. In most versions of Windows you can do this as follows:
Open Windows Explorer and locate the file in question (“I did it my way” in the
Tutorial Files directory). Click on the file name with the right mouse, and select
Open With... in the menu that appears. Select WORDPAD (unless you have a
preferred word-processor that you know will do the job instead. Make sure that
Always use this program to open this file is checked and press OK. The document
should open in Wordpad. If you close Wordpad, and repeat the instructions in this
section, for displaying Cameron’s autobiography, it should now work.

Link To
Other
GEDCOM
Files

We have seen that when you insert a Multimedia object of whatever kind into a
Family Historian, you are creating a Multimedia record to represent a file, which is
either embedded within, or linked to, the Family Historian file. We have also seen
that this can be done with any kind of file – which means that it can be done with
another GEDCOM file.
There is no obvious reason why you would want to embed one GEDCOM file
within another (although, if you really wanted to, you could). Far more useful,
however, is the ability to link 2 or more GEDCOM files together. Suppose, for
example, that you were researching into your own family and your wife’s family.
You could, if you wanted to, keep the results of these projects completely separate,
in 2 GEDCOM files, but each could contain a Multimedia record representing the
other GEDCOM file. Both you and your wife could have a record in each file.
Your wife in your file, could be linked to the record which represents the GEDCOM
file holding her family tree information. And your record in her file, could be
linked to the record representing the GEDCOM file that stores your family tree

117

Chapter 10 – Pictures and Other Multimedia

information. If you select a Multimedia record representing a GEDCOM file, and
click on the Perform Action button, a second instance of Family Historian will
open up to display the Family Tree information in the GEDCOM file in question.
To insert a link to another GEDCOM file, click on Insert > Other Multimedia. In
the Insert Other Multimedia dialog that appears, select All Files (*.*) in the Files
of Type field. Then locate the GEDCOM file you want to insert, select it, and click
on Open. A Multimedia record is created, to represent the GEDCOM file.

What if
You Need
to Move
the Linked
File?

All of the examples in this tutorial are of linked files. Suppose you wanted to move
the linked file, how could you ensure that the link in the Multimedia record is
updated to point to the new location? Here’s an example of what you could do.
Steps
1.
2.
3.

Select the Multimedia record you want to update. The Objects List in the
Multimedia Window is as good a place as any.
Open the Property Dialog for this record
The full path name of the linked file is in the Linked File field. You can
change this path name to whatever you want, whenever you want. You will
have to unselect and re-select the record in the Objects List, to get the picture
(if it is a picture) to update correctly, using the new path address.

This solution is easy to do if you only have one file. But what if you want to move
all of your files from one directory to another? If you had a large number of
multimedia files you would not want to have to manually change the Linked File
field for each one. Fortunately, there is a better solution.

Work with
External
File Links

You can see all of the external file links in your Family Historian file, organised in a
hierarchical directory structure, in the Work with External File Links Dialog – see
figure 35 below. This can be accessed by clicking on Work with External File
Links on the Tools menu.
This dialog effectively allows you to update the Linked File field in all Multimedia
records that store links to external files. Suppose, for example, you kept all your
pictures in a folder called C:\Pics and you decided to move them into a folder called
C:\Family Historian\Pics. You would first move the files using Windows Explorer.
You would then open your Family Historian file, and open the Work with External
File Links Dialog. The listing would show the files in the C:\Pics directory (with a
cross through each file, to show that it wasn’t really there). You would click on the
Pics folder and click Move. A dialog with a listing like Windows Explorer, of all
the folders on your computer, would appear. You would select C:\Family Historian,
and press OK. If you pressed OK again to close the Work with External File
Links Dialog, all your file links would be updated appropriately.
The Work with External File Links Dialog cannot be used to move or copy
external files. It is simply for maintaining file links. For more information about
how to use it, view the online help for this dialog.
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Figure 35 – the Work with External File Links dialog. The link to Jumblies.wav has been deliberately renamed to ‘The
Jamblies.wav’ to illustrate what a bad link looks like. To correct this bad link it is only necessary to select ‘The
Jamblies.wav’, click the Rename button, and rename the link.

Copying
Files vs.
Copying
Directories

The main advantage of using embedded multimedia, rather than linked multimedia,
is that life can be more straightforward when you want to copy your Family
Historian file, perhaps in order to give it to someone else, with multimedia intact.
Any multimedia which are embedded will be automatically copied when you copy
the Family Historian file that contains them. How do you achieve the same thing if
the multimedia files are linked?
If the multimedia files are on a diskette or CD, you could copy the diskette or CD
and give the person that, as well as a copy of the Family Historian file.
If you want to store your multimedia files on your hard disk, and you think you
might want to copy them with the Family Historian file, the easiest solution is to
keep them in either the same folder as the Family Historian file, or in a sub- folder
within that folder (or in a sub-folder within a sub-folder … etc). Then what you
give to your recipient is not just the Family Historian file, but a folder containing the
Family Historian file all the multimedia objects it links to.
When you do this, any links to files that are part of the copied folder structure will
continue to work when the Family Historian file is next opened, in whatever context.
However, any links to files that are external to the copied folder structure will
remain as links to files in their original location. In other words, links behave
differently depending on whether the files they link to are part of the Family
Historian file’s folder or not.21

21

Experienced computer users may wonder if this is achieved by the use of relative file paths.
Actually it isn’t. Family Historian always uses absolute file paths (and you should too, if you specify
file paths).
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Save Finally, save the work that you have done.
Changes
Steps
1.

From the File menu, click on Save (or click on the Save button on the toolbar).
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This step presupposes that you have...
Read the Introduction and Chapters 1, 2 & 3.

You will learn how to...
Set up, use and cancel automatic source citations.
Tell whether an automatic source citation is enabled.
Work with the Source Pane in the Property Dialog.
Manually add source citations (and create source records).
Copy and paste existing source citations.

Preamble When accumulating genealogical data, it is a very good idea to document not just

the information you accumulate, but also where the information came from – your
sources. A ‘source’ can be whatever you choose to consider the source of your
information to be. The most common kind of source would be a document of some
kind – e.g. a birth or marriage certificate, or a census record. But a source could
also be a person (their recollections) or, more narrowly, a particular interview with a
person. A book could be a source, or a part of a document, a gravestone, or even
another GEDCOM file (which might or might not have been created by Family
Historian).
In this example, we will add a little more detail – this time about Michael Peabody.
We will treat Michael Peabody himself as a source and create a source record for
him. We will automatically add source citations to him as we enter the data.
We will also create another source record for a book written by Jonathan Peabody.
We will retrospectively indicate that various items of information came from this
source.

Open a File Start by opening the file from Chapter 10.
Steps
1.

From the File menu, click on Open (or click on the Open button on the
toolbar). Locate the file you saved at the end of Chapter 10. It should be
called “Tutorial – Chapter 10” (it will have a “.ged” suffix, if you are
displaying them). Press OK.

If you skipped chapter 10, or read it but didn’t create your own file, use the ‘precooked’ version (see “Tutorial Files (referred to in the manual)” on the Help menu).

Save As You should save the file now under a new name. See the discussion in the Save As
section in Chapter 4, for the reasons for this.
Steps
1.

From the File menu, click on Save As. Use the same folder as before and save
the current file as “Tutorial – Chapter 11”. Press OK.

Now click on the Sources tab in the Records Window. The window displays the
text “No Source Records”. This is because, so far, we haven’t specified the source
of our information for anything.
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Set
Automatic
Source
Citation

We will shortly enter some data supplied by Michael Peabody. This time, however,
we want all the data we enter to have source citations. A citation is a link between
an item of data and a source record. A typical ‘item of data’ would be a field in a
record. The citation indicates where the data came from.
You can, as we will see, painstakingly type in source citations for every item of data
as you enter it. However, if you are entering a large number of items of data, and
what you want to say about each one is that this is what Michael Peabody told you
in an interview in 1998, you might find yourself feeling that there has to be a better
way. In fact, there is: automatic source citations.
Steps
1.
2.
3.

4.

5.
6.

7.
8.
9.

Click on Set Automatic Source Citation in the Tools menu. The Set
Automatic Source Citation Dialog appears.
At the top is the Source field. Click on the << Select button to the right of it.
A dialog comes up with the title “Select Source Records” – but the list is
empty. There are no source records. Click on the New... button to create a new
one.
A New Source Record Dialog appears. In the Title field type “Michael
Peabody”. In a real-world situation, you might choose to put Michael
Peabody’s address in the Note field. Notice that all the fields appear to be
chosen on the assumption that a source is a published document of some kind –
perhaps a book. That’s because sources frequently are published documents.
However, as stated in the Preamble, sources can be whatever you consider your
source of information to be. Where a source is not a document, you must use
the various fields in the source record in the way that seems most appropriate.
Obviously you can put whatever you like in a Note field. In the Type field
enter “Person”. If the others do not seem at all appropriate in a given case, you
should simply leave them blank.
Press the Create button. This takes you back to the Set Automatic Source
Citation Dialog, with the Source field now set to Michael Peabody.
Set the Entry Date to “12 June 1998”. This field is typically used to store the
date that a particular entry in a document was made (e.g. in a marriage register
perhaps), which is why it is labelled in this way. However, in this case, we are
using it to store the date that an interview took place. Press Tab.
Set Assessment to Primary Evidence and press Tab.
In the Note field type “Interview at M.P.’s home, in Maidstone, Kent”.
Leave other values as they are, and press Set Automatic.

Status Bar In the bottom right corner of the status bar, you should see the text ‘Auto-citation
‘Flag’ enabled’. Take good note of this. As long as this ‘flag’ is there, all the new data

that you enter, irrespective of which tools and techniques you use to enter it with,
will all be automatically cited to Michael Peabody as source. And that flag will be
there until you cancel the automatic citation. However, existing data, which was
already there when you set the automatic source citation, is never affected by
automatic source citations.

Show
Sources in
the
Property
Dialog

Open the Property Dialog for Michael Peabody (his Individual record). Switch to
Large Mode if you aren’t already in it. Now click on the Show Sources button
on the toolbar. The Property Dialog increases in size yet again. The button stays
depressed, and a new pane, in a yellow background colour, appears to the right of
the normal Property Dialog fields. This is the Source Pane.
Steps
1.

2.

Click in the Name field of the Main tab. The Sources For field in the Source
Pane now shows the word Name. But the Source list below it is empty. There
are no source citations for that item of data.
Now click in the Born field. The Sources For field is empty, because there is
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3.

as yet no data about Michael Peabody’s birth to provide a source citation for.
Enter the date as “22 april 1958” and press Tab. The Property Dialog now
looks as in Figure 36 below. The Sources For field shows the text “Birth*”.
In the Source List, there is one entry: “Michael Peabody”. All other details
match the automatic source citation that you set up.

Tip: to hide the Source Pane, click on the Show Sources button again. The button
ceased to be depressed, and the Source Pane is hidden. Switching to Small Mode
will also automatically hide the Source Pane.

Figure 36 – the Property Dialog, with the Source Pane open

The Source Although the Source Pane was open when we added Michael Peabody’s birth date,
Pane it didn’t have to be. If you added Michael Peabody’s details directly into the

Records Window, without the Property Dialog even being open at the time (which
can be done, if you know how to do it) the source citations would still be set up
automatically. However, if you are entering details into the Property Dialog, the
Source Pane automatically updates itself to show the sources for whatever item of
data you last clicked on (or tabbed to) in the ordinary (non-source) part of the
Property Dialog.
A potentially annoying consequence of this is that, if you are not careful, you may
miss the source citation you have just created. The reason is that Family Historian
only actually creates or updates field information when you tab or click away from a
field. The source citation is created at the same time. But because you have just
clicked away from the field, you don’t now see the source citation you just created
for it.
One solution is to enter the data in the field, press Tab to ‘register’ the data. Then
click back into the field you just vacated. We didn’t have to do this with the Born
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field because when we tabbed we moved from the birth date field to the birth place
field, and these share the same citation (i.e. the citation applies to the recorded birth
event details). But it could arise with other fields.

F5 An alternative, if you can remember to do it, is to press the F5 key when you enter
data in a field, instead of pressing the Tab key. This has the effect of forcing
Family Historian to register the data you have entered or updated, but without the
cursor leaving the field. The advantage is that you can immediately see not only the
effects of your update in the field itself, but you can also immediately see the
automatic source citation created for it. Try it now.
1.
2.
3.

Click in the Occupation field. The Source Pane is empty.
Type “Journalist”. Press F5.
The Source Pane updates to display the Source Citation for this item of data.

It should be stressed that in terms of the underlying data created or updated, there
is absolutely no difference between pressing F5 and pressing Tab, or clicking
elsewhere. If you are prepared to take on trust that your source citations are being
created, you don’t need to bother with it – indeed, you don’t need to have the Source
Pane open at all.

Source All record types have their own distinctive record icon. The icon for Source
Record records, you may have realised by now, looks like this: . Your Family Historian
Icon file now contains one record for Michael Peabody qua Individual, and another

record for Michael Peabody qua Source. Keeping clear about the kind of record you
are looking at, at any given time, should help to avoid the possible confusions that
might arise. The record icons give a visual clue, which should help.

Cancel
Automatic
Source
Citation

As soon as you have finished entering all the data provided by a given source, it is a
good idea to cancel the automatic source citation, so that you don’t accidentally
create citations you didn’t want to create.
Steps
1.

On the Tools menu, click on Cancel Automatic Source Citation. The status
bar no longer has the “Auto-citation Enabled” text displayed.

Add We will now retrospectively add source information to information that had been
Citation added previously. We will also create another source record – this time for a book
written by Jonathan Peabody.
Steps
1.
2.

3.

4.
5.
6.
7.
8.
9.

Locate Cameron Peabody, and display his record in the Property Dialog.
Open the Source Pane.
Click in the Occupation field (containing the value ‘printer’). The Sources
For field in the Source Pane shows the value Occupation. No source citations
are listed below it.
Click on the Add Citation button
in the Source Pane toolbar. A dialog
titled “Select Record” appears, displaying the Source record for Michael
Peabody. Do not select it. Instead click on the New... button.
A dialog titled “New Source Record” appears. In the Title field, type the title
for Jonathan Peabody’s book: “Printing in the 20th Century”.
In the Type field, type “Book”.
In the Author field, type “Jonathan Peabody”.
In the Publication Information field type: “Bookles & Bookles Publishing”.
Press Create. The new source record is created and a source citation to it is
displayed for the Occupation field, for Cameron Peabody.
Set the Assessment field to Primary Evidence.
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10. Set the Where within Source field to “Chapter 11”.

Copy and You would not want to have to do that much work for each item of data, if you had
Paste many items of data which required the same citation. You don’t have to.
Citation Steps
1.

Ensure the citation you just created is selected. Click on the Copy Citation
button

2.

3.

on the Source pane toolbar

Click in the Born field. Press the Paste Citation button
in the Source
Pane toolbar. The Born field now has the same source citation as the
Occupation field (select the citation you just pasted and note that the
Assessment and Where with Source fields for this citation are the same as the
ones you specified for the printer field).
Click in the Died field and press the Paste Citation button again. The Died
field now has the same source citation as the Occupation field.

Citation You should be now have gathered that the Entry Date, Assessment, Where within
Fields Source, Actual Text and Note fields in the Source Pane, are all aspects of the
citation selected in the source citation list, just above the Source Pane toolbar.
Although the values are frequently the same for many citations (which is why
automatic source citations, and copying-and-pasting, are useful) these values can be
different for each source citation.

The
Sources
For List

Look now at items in the Sources For list in the Source Pane. Each item, is a field,
or sometimes an entire ‘sub-branch’ of fields, for which data has been provided, and
for which a source citation can be provided. The ones with an asterisk next to them
are the ones for which one or more source citations have been provided.

Delete To delete a source citation, select it in the Source Pane, and click on the Delete
Citation Citation button
.
Go To To navigate to the source record, for a selected source citation, click on the Go To
Source Source Record button
in the Source Pane toolbar. You can, of course, return
Record to the previous record you were viewing by clicking on the Go Back button
in
the Property Dialog toolbar.

Source
Records in
the
Records
Window

Like all records, there is a tab for Source records in the Records Window (some
record types may have their tab hidden, but you can always unhide it from the
Record Window Options Dialog, available from the Tools menu).
Click on the Source tab in the Records Window now. You should see 2 records –
one for Michael Peabody, and one for Jonathan Peabody’s book.

Repository You may have noticed, when we created the source records, that you can specify a
Records Repository for a source. This is optional. You don’t need to specify repositories.

Each source record can have at most one – but many source records can be linked to
the same repository. The repository record stores details of an address at which
potentially many sources may be located. The record icon for a Repository record
looks like this:
.

Specifying
a Source
When
Merging

Later we will look at how you can merge another GEDCOM file into the current
file. As we will see, when you do this, you can get Family Historian to create a
source record for you, to represent the file being merged, and create source citations
to link all the merged data to this source record.
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Save Finally, save the work that you have done.
Changes
Steps
1.

From the File menu, click on Save (or click on the Save button on the toolbar).
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Reports
This step presupposes that you have...
Read the Introduction and Chapters 1, 2 & 3.

You will learn how to...
Run standard queries
Find out what standard queries do
Copy all or part of a query result set to another program
Save a query result set to a file
Print a query result set as a report
Create a custom query
Control how a query will appear when printed

Preamble In this chapter we will be looking at Family History’s support for queries. We will
start by looking at what a query is. We will introduce a new Family Historian
window – the Query Window – and look at some of the many things that you can do
with queries.
This chapter uses, but does not alter, the file saved at the end of chapter 11. If you
skipped chapter 11, you can use the pre-cooked version (see “Tutorial Files
(referred to in the manual)” on the Help menu).

What is a Queries are stored sets of instructions which allow you to specify criteria for
Query? identifying a set of records of a given record type. For example, a very simple

criterion might be: “Find me all the Individual records where the date-of-birth is
later than the year 2000”. A slightly more complex one might be “Find me all the
Family records where the father has ‘Paterson’ somewhere in his name, and the
father’s birth-place includes the word ‘Australia’”.
When a query is ‘run’, Family Historian looks through the current file to find all the
records (of the required type) which match the criteria contained in the query. The
resulting set of records is called the Result Set.
There is much more to queries than this, however; but this definition will at least
serve as an introduction.

Standard Family Historian comes with a pre-defined set of queries, called Standard Queries.
Queries We will look at a selection of these now.
Relations
and
Nearest
Relationship

We will start by looking at the Relations and Nearest Relationship query. This
query finds everyone in the current file who is related to a given person (whoever
you choose) and shows exactly how they are related to that person. Actually, any 2
people can be related in more than one way (Cameron’s 2nd wife is also his first
cousin, for example). This particular query only shows the nearest relationship.
Later we will look at another query that shows the nearest 5 relationships.

Standard Query

Steps
1.

Select Cameron Peabody. You should know by now that you can select his
record wherever you can see a reference to it – in the Records Window, in the
Diagram Window, or in the Multimedia Window.
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2.

3.

Look at the application’s View menu, and click on Standard Queries, and then
Relations and Nearest Relationship. The Query Parameters Dialog appears
with title “Enter Query Parameters”. The dialog box has one field, labelled
“Starting Person”. The value in this field already shows “Cameron Peabody”.
Leave the Starting Person field unchanged and click OK. The Query Window
appears looking roughly like figure 37 below.

Tip: Unlike opening diagrams, you don’t actually need to select a record before
running a query. However, it can sometimes save you a little time if you do. For
example, the reason that the Query Parameters Dialog already showed Cameron
Peabody as the Starting Person, when it appeared, was that you had selected him.
If nobody had been selected this field would have been blank. In that case, you
would have had to click on the Starting Person field to get a dropdown list, and you
would have selected Cameron Peabody from this list. By selecting Cameron
Peabody before you run the query, you save yourself this extra step.
22
The Query The Query Window is the 4th of the 5 MDI Child Windows supported by Family
Window Historian – the other four being the Records Window, the Diagram Window, the

Multimedia Window and the Reports Window (we haven’t covered the Reports
Window yet). Like all Family Historian MDI Child Windows it has its own
Navigation Bar Icon – the first of the two icons shown on the left. The second icon
is the Query Window’s toolbar icon.

Like the Records Window, the Query Window has multiple tabs. These tabs never
alter. They are: General, Columns, Rows and Result Set. At the moment the Result
Set tab is selected. Take note that the other tabs are there, but otherwise ignore them
for now. We will be looking at them presently.
Above the tabs, there is a field labelled ‘Query:’. This field is a dropdown list,
containing all the standard queries, plus any custom queries that you have created
yourself. It shows the current query in the Query Window. At present, the current
query is Relations and Nearest Relationship – the query we have just run. To the
right of this field is the Query Toolbar (see figure 38 below). We will be looking at
this shortly. Beyond the Query Toolbar, to its right, is the text ‘Standard Query –
read only’ in blue. This simply indicates that you are looking at a standard query,
and that, like all standard queries, it is read only – you can’t modify it. However, as
we will see presently, you can copy it, and modify the copy.
Tip: You can open the Query Window at any time, without having to previously run
a query from the View menu, by simply clicking on the Query Window button
on the main application toolbar. If the Query Window is already open, you can
switch to it at any time – as you can with any MDI child window – by simply
clicking on its Navigation Bar icon.

The Result If you use spreadsheet applications, the Result Set Tab of the Query Window
Set Tab should look familiar to you.
Query Window

The columns in the Result Set Tab are determined by the query whose result set it is
displaying. At present, you should see 4 columns, with headings: Relation,
Relationship, Relationship from relation’s point-of-view, and finally Relative’s
Generation. You may have to scroll sideways to see all of them. Alternatively,
move your cursor over the gap between any 2 column headings, until the cursor
looks like this
; and click-and-drag to resize a column.
You should see that the Relation column contains a list of individuals, as you might
expect. The Relationship column shows how each person is related to Cameron

22

If you don’t know what an MDI Child Window is, see the section “MDI Child Window”: a windowwithin-a-window in Chapter 2.
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Peabody, and the Relationship from relation’s point-of-view shows what you would
expect it would. Cameron Peabody is there too – treated as a limiting case of his
own relation. His relationship to himself is given as ‘root.
The Relative’s Generation column effectively assigns a generation number to each
person, giving 0 to anyone who belongs to the same generation as Cameron
Peabody, -1 to anyone from the previous generation, -2 to anyone from the
generation before that, +1 to Cameron’s children’s generation, and so on.

Figure 37 –The Query Window with the Result Set tab selected. The current query is
Relations and Nearest Relationship. 6 cells have been selected.

Sorting the You will notice that the query is sorted in generation order, starting with the most
Result Set recent generation. This sort order was specified in the query. We will see later how
this is done. For now, however, note that you can re-sort the result set by clicking
on any column heading.
Click now on the Relative’s Generation column heading. This sorts the list in
ascending order of generation instead of, as it was, in descending order of
generation.
If you press-and-hold the Alt key and then click on the column heading, the list will
be sorted in reverse order.
How can we now revert back to the original sort order?
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Run Query To get the Result Set to revert to its original sort, in this case, we have to run the
query again. We have already seen that a query can be run from the Standard
Queries menu, within the View menu. However, any query can also be run from
within the Query Window itself.
Query Toolbar

Steps
1.

Select the query you wish to run from the dropdown list labelled ‘Queries:’ at
the top of the Query Window. In this case, we just want to re-run the current
query, “Relations and Nearest Relationship”, which is already selected.

2.

Click on the Run Query button
on the Query Toolbar. The Query
Parameters Dialog appears again. The Starting Person field in the dialog
should still contain Cameron Peabody.
Click OK in the Query Parameters Dialog. The query is run again, and reverts
to its original sort order.

3.

Run and
Invert
Result Set
Query Menu

If you look at the status bar, at the bottom of the application window, you should see
that it says “Records in Result Set: 23”. That may seem surprising. There are 24
Individual records in this file. Isn’t everyone in the file related to Cameron
Peabody? Who is missing?
It is very easy to find out which record has been excluded by this query.
Steps
1.
2.

3.

Click on the Query Menu button
at the right-hand end of the Query
Toolbar. A dropdown menu appears.
Click on the menu command: Run and Invert Result Set. This command runs
a query in exactly the same way as it is ordinarily run, except that instead of
displaying all the records which match the query, it displays all the records
which don’t. You should see the Query Parameters Dialog appear again, with
the Starting Person field still showing Cameron Peabody.
Click OK. The query is run again, but this time the ‘inverted’ result set is
displayed.

The inverted result set contains 1 record only – that of Thomas Andrews. The other
columns are all blank. The fact that these columns are blank is of course quite
reasonable if Thomas Andrews is not related to Cameron Peabody. But why isn’t
he?

Select
Record in
Result Set

Just to the left of the text ‘Thomas Andrews’ in the first cell of the Result Set, you
should see that there is a little Individual record icon – the identity card icon .
You may remember from earlier chapters on the Records Window, that it is a
general principle that text which has a record icon next to it represents the record
itself. And so it is here. Records can be selected in the Result Set tab, by clicking
on any cell which contains a record icon.
To select a single cell in the Result Set tab (as in most spreadsheets) you just click
in it. This gives it a thick border. If the first cell is not already selected, click in it to
select it now, and then click on the Property Dialog button
in the application
toolbar (or just double-click on the cell). The Property Dialog appears and shows
record details for Thomas Andrews. Now click on the View Descendants button
. If spouses are not already being displayed, click on the Spouses in Own Box
button
too. You can see from the diagram in the Diagram Window that
Thomas Andrews is the father of Fiona Andrews, who is the ‘spouse’ (they never
married, although they had a child together) of Ian Peabody. Ian Peabody, you may
remember, is Cameron Peabody’s son.
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This explains why Thomas Andrews doesn’t count as a relative of Cameron
Peabody. For most purposes (such as this query), Family Historian treats as a
relative of a given person, X, anyone who is a descendant of X, an ancestor of X, a
descendant of an ancestor of X, or a spouse of any of these people. It will also
count as a relative of X anyone who is a relative (by the above definition) of X’s
spouse. And Thomas Andrews, uniquely in the current file, does not match any of
those criteria, for Cameron Peabody. He is Cameron Peabody’s son’s father-in-law;
but not, by our definition, a relative of Cameron Peabody as such.

More Close the Diagram Window and the Property Dialog but leave the Query
Standard Window open. If you accidentally closed it, click on the Query Window button
Queries
on the main application toolbar to re-open it.
We will now look at a selection of other standard queries.

Relations
and 5
Nearest
Relationships

The Relations and 5 Nearest Relationships query is similar to the Relations and
Nearest Relationship query, but instead of showing just one way that a person is
related, it shows up to 5 ways that they are related. Like all queries, you can run
this query either from within the Query Window, or from a menu command (View
> Standard Queries > Relations and 5 Nearest Relationships). We will run it
from within the Query Window. For a change, we will look this time at the
relatives of Jean Clare Anderson.

Standard Query

Steps
1.

Click on the Query field at the top of the Query Window, and select Relations
and 5 Nearest Relationships from the dropdown list.

2.
3.

Click on the Run Query button
on the Query Toolbar.
Select Jean Clare Anderson as Starting Person in the Query Parameters
Dialog that appears (the list is sorted in surname order), and click OK.

The Result Set for this query has 6 columns and 21 rows (i.e. 21 records match the
query – which in this case means that Jean Clare Anderson has 21 relatives in the
current file). The first column is labelled ‘Relation’. The remaining 5 are all
labelled ‘Relationship’. The first relationship column shows how the given person
is most closely related to Jean Clare Anderson. The second relationship column
shows the second-closest relationship, and so on. For example, Cameron Peabody’s
closest relationship to Jean Clare Anderson is that he is her husband. His second
closest relationship to her is that of cousin. And he is also, third-closest, her
husband’s cousin’s husband (you might want to think about that one).

Contains Now run the Contains Text query. Type ‘Maidstone’ into the Enter Text field
Text) when prompted. The Result Set contains Michael Peabody only.
Standard Query

This is a useful query. It finds all the Individuals that have any fields which contain
the entered text – in this case, it found the only record with any connection with
Maidstone.

Birthdays Now run the Birthdays (all) query. Notice that this time the Query Parameters
(all) Dialog does not appear. Some queries, such as this one, do not take any parameters.
Some take several parameters.

Standard Query

Why are there only 5 records in the Result Set? Because this query ignores all
records where the month of birth is not recorded. Only 5 records satisfy that, in this
file.
Although the sample is not big enough to show this properly, this query sorts the
Result Set by month, and within month, by day, and within that, by name of the
Individual. However, as always, you can re-sort the list by clicking on any column
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heading.

Birthdays
(for given
day and
month)

Run the Birthdays (for given day and month) query. This is an example of a query
that takes more than one parameter. When the Query Parameters Dialog appears,
enter 2 in the Month field, and 14 in the Day field, to find out who was born on
Valentine’s Day. You should see that only Mary Peabody was.

Standard Query

Search For The standard query Search For Orphans is a useful one if you want to locate any
Orphans records for individuals who are not related to anyone else. In fact, not only can you
Standard Query

use it for this, but you can also use it to identify small groups of individuals who,
although related to one another, are not related to other individuals in the file.

Run the query now. It doesn’t take any parameters. There should be one row in the
result set for each individual in the file – i.e. 24. The way it works is that each
individual is assigned a ‘pool’ number. The value of the pool number is arbitrary.
The significance of it is that all individuals sharing the same pool number are
directly or indirectly related to one another. Cameron Peabody, as we saw, is not
directly related to Thomas Andrews, but they are indirectly related (they are each
related to Ian Peabody, for example).
In this example, all individuals in the file have a pool number of 1. This shows that
they are all directly or indirectly related to one another. However, if you added a
new unrelated individual and ran the query again, the new person would have a pool
number of 2, which would show that they were not directly or indirectly related to
anyone in pool 1.
The query is sorted by descending order of pool number. By looking for pool
numbers which are only held by a small number of individuals, or just by one, you
can easily identify small isolated groups, and orphans.

Boys’ The standard query Boy’s Names is another that takes no parameters. Run it now. It
Names lists all the given names of the males in the current file. There is an exactly similar
Standard Query

one for girls’ names. It includes the year of birth, where known, so that you can see
not only which names have been popular, but when they were popular.

Named List We haven’t looked at Named Lists yet. They will be discussed in Chapter 15.
Members However it is worth mentioning the Named List Members query. It is a very simple
Standard Query

query that prompts you to specify a named list, and then returns the Individuals who
are members of that list. This can be useful if you want to use a Named List where
a query is expected (e.g. in Split Tree Helper, or using a query to mark boxes in a
diagram). It effectively allows you to use your Named List as if it were a query.

All If you want to print off the Records Window, this is the query for you. Its columns
Individuals correspond to the Records Window columns (when first installed). If you want the
columns sorted by Record Id, click on the Record Id column heading.

Standard Query

Print Query All queries, including queries you create yourself (custom queries) can be printed as
as Report a report. To see what a query will look like when printed, click on File > Print
Preview. Do this now, to see what the Boys’ Names query looks like when printed
as a report.
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Print As Print Preview is a command you are frequently likely to want to use with
Preview queries, there is a button for it – the Print Preview button
– on the Query
Toolbar. This button is there for convenience only. There is no difference in effect
between clicking on this button, or the Print Preview command on the File menu.
Query Toolbar

Configure
Query
Reports

Note: Print Preview is only available if you have a printer installed.
Although standard queries are read only, for most purposes, you can still control
some aspects of how they will print as reports. In particular, the width of the
columns of a report when printed correspond roughly to the relative width of the
columns in the Result Set tab. By clicking and dragging on the intersection between
) you can resize columns in the
column headers (when the cursor looks like this:
Result Set tab, which in turn will determine the width of the same columns when
printed.
Click now on the General tab of the Query Window. Most of the fields in this tab
are grey, but you will notice that the Orientation and Multi-page handling fields at
the foot of the window, are not grey. The Orientation field determines whether this
report prints in Landscape or Portrait.
The Multi-page handling field determines what Family Historian does about
reports which are too wide to fit onto a single page (reports which are too long to fit
onto a single page are not considered a problem – you just get multiple pages in the
report). The best solution, if at all possible, is to arrange your report in such a way
that it can fit within the width of a single page (by adjusting column sizes if
necessary). However, if this is not possible, you effectively have to choose between
simply discarding any data which is too wide to fit onto one page (this is the Max.
one page across option), or you have to accept that you will get a grid of report
pages when the query is printed. In the latter case, you can choose between
numbering these pages Across then down, or Down then across.
To see how many pages you will get when a report is printed, use Print Preview.

Standard
Query
Descriptions

While we are looking at the General Tab of the Query Window, notice that it
contains a Description field. Each standard query is described in this field.
Select the first query in the Query field: Age At Death (all). Notice that the
Description field describes what this query does. Now click the Down Arrow key
on your keyboard once. If the keyboard focus was still on the Query field (i.e. you
haven’t clicked anywhere since you clicked on it) the query will change to Age at
Marriage (all), and you can read its Description. Click the Down Arrow key again,
to step through each query in turn and see what it does. This is an easy technique
for browsing the list of queries.
Later when we look at custom queries, you will see that you can write your own
descriptions for them in this field.

The Query We have already looked at the Run Query button
Toolbar

and the Print Preview

button
. We will now look at the remaining buttons on the Query Toolbar
(see figure 38 below)
Tip: As with all Family Historian toolbars, if you simply move the cursor over a
button and pause briefly, a small floating message will appear next to it as a brief
reminder of the function of the button. These messages are sometimes called ‘Tool
Tips’ or ‘Bubble Help’.
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Figure 38 – the Query Window toolbar

Cancel Do not be concerned if you do not recognise this button. The Cancel Query button
Query
spends most of the time in its greyed state, in which it looks like this:
. It
Query Toolbar

is only enabled when a query is actually running. You click on it if you want to
cancel the currently running query. However, if you have a moderately powerful
computer, you may find that queries run so quickly that there is no time to cancel
them before they have completed. This does not mean that the Cancel Query
button does not work on your computer. It just means that the queries take very
little time to run.

Print Like the Print Preview button
Query Toolbar

the Print button
is on the Query Toolbar
for convenience only. There is no difference in effect between clicking on the Print
button on the Query Toolbar, and clicking on the Print command on the File
menu.

Queries
and
Spreadsheets

We have already noted that you can print any query as a report. Almost equally
useful is the fact that you can also easily copy all or part of a query’s result set into a
spreadsheet. Modern spreadsheet applications are usually powerful programs that
can be used for sophisticated data analysis, and can produce all kinds of charts and
graphics for you.

Select
Multiple
Cells

Before you can copy cells, you must first select the cells you wish to copy. We
have already seen how you can select a single cell in the Result Set tab of the Query
Window by simply clicking in the cell. Users of spreadsheet applications will know
that you can also select a range of cells by clicking in the top-left cell and, keeping
the mouse button depressed, drag down to the bottom right cell that you wish to
select (i.e. this is a single action click-and-drag). The ‘bottom right’ cell can, of
course be in the same column as the ‘top left’ cell, if you just want to select a
column, or in the same row, if you just want to select a row.
An easy alternative to click-and-drag, which is particularly useful for a large range,
is to click (ordinary click) in the top-left cell of the range you want, then scroll until
the bottom-right cell is visible, press the Shift key, and keeping it pressed, click
again in the bottom-right cell. This will select all cells between the top-left to the
bottom-right. Figure 37 above shows an example of a Result Set in which a grid of
6 cells (in 3 rows of 2 columns each) have been selected. Where a range is selected,
all but one of the selected cells display in inverse video.

Copy Having selected the cells you want, you can then click on the Copy Selected Cells
Selected button
on the Query Toolbar to copy the cells to the clipboard23. Pressing
Cells Ctrl-C does the same thing.
If you have a spreadsheet application, try copying a range of cells to it now.
Query Toolbar

Steps
1.

Select the range of cells you want in the Result Set tab (the whole Result Set if

2.

you like), then click Copy Selected Cells
to copy the range to the
clipboard (don’t be concerned that nothing obvious apparently happens when
you click on the button).
Now open your spreadsheet application and start a new, empty worksheet.

23

For users who are unfamiliar with the term, the ‘clipboard’ is the name for a hidden holding area
within Windows that items are copied to (when you copy) prior to being pasted (when you paste).
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Click in a cell in your worksheet, and paste the contents of the clipboard into
the worksheet. Typically you can do this by clicking on Paste on the Edit
menu in the spreadsheet. Alternatively, pressing Ctrl-V together (press-andhold the Ctrl key, and then press V on your keyboard) will usually achieve the
same thing. The contents of the selected range of cells are copied into the
spreadsheet.

Save As well as copying the contents of a Result Set to the clipboard, you can also save
Results to the entire contents of a Result Set as a file. When you click on the Save Results to
File File button
a dialog box appears in which you can specify the name and
location of the file.
Query Toolbar

The default format is CSV (Comma delimited). You can also use Text format. If
you are planning to open your file in another application such as a spreadsheet,
word-processor or database application, you should definitely use CSV format.
Saving a Result Set to a file can be useful in various ways. For example, if you
have a Word-processor which has a Mail-Merge facility (which any decent one
should do) you could use a Result Set to generate standard letters to other
genealogists, or create custom reports using your word-processor. See your wordprocessor documentation for instructions on how to do this.

Query When you click on the Query Menu button
, the last button on the Query
Menu Toolbar, a small dropdown menu appears with a few extra menu commands. We
have already looked at the Run and Invert Result Set command.
Query Toolbar

Four of the commands will be discussed in Chapter 15. These are





Add Result Set Records to Named List
Remove Result Set Records From Named List
Set Flag on Result Records
Clear Flag on Result Records

The Options command lets you set various fonts. One of these, Query Window
Results, is the font used in the Result Set. The others are fonts used when a query is
printed.
The other commands on the Query Menu all concern custom queries. We will look
at custom queries in the next chapter.

Delete
Multiple
Records

We have already seen in Chapter 5 that you can select multiple records in diagrams.
Another way to select multiple records is to run a query which returns those records.
Then select all the cells that represent those records. Remember that a cell which
represents a record has a record icon to the left of the text.
One reason you might want to select multiple records is if you wanted to delete
them all. To do this, click Delete on the Edit menu (or press the Delete key).
When you do this, a message will warn you that you are about to delete records, and
give you the opportunity to cancel.
Using a query to select multiple records that you wish to delete is especially useful
when you want to split a Family Historian file. There is a dialog designed to help
with precisely this scenario, called the Split Tree Helper dialog. It is discussed in
Chapter 14.
Tip: Another way to delete multiple records is to put them into a Named List, and
then use the command Delete All Records in Named List. See the Chapter 15 for
more on Named Lists.
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Delete
Multiple
Fields

It sometimes happens that you don’t want to delete multiple records, but you do
want to delete multiple fields within a record. Suppose, for example, that you want
to delete all birth and death details from a file. Simply run a query that shows the
fields you want, select them all (i.e. select all the cells that represent the fields) and
press the Delete key. As always, you will be given a warning and an opportunity to
cancel, before any data is actually deleted.
It may, of course, be that there is no query which conveniently includes the fields or
records that you want to delete. In that case, you will have to create one yourself.
Custom queries are the topic of the next chapter.
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This step presupposes that you have...
Read the Introduction and Chapters 1, 2, 3 & 12

You will learn how to...
Create, change and delete custom queries
Specify which columns you want in a custom query, and how the results should be sorted
Use filters to specify which records you want in the result set
Understand the role of expressions in queries
Control the printing of query output

Preamble This chapter continues exactly where the last chapter left off, so if you haven’t
already done so, you should read the previous chapter first.
In this chapter, we will create some sample custom queries, to show some of the
things that you can do with them.
Like the previous chapter, this chapter uses, but does not alter, the file saved at the
end of chapter 11. If you skipped chapter 11, you can use the pre-cooked version
(see “Tutorial Files (referred to in the manual)” on the Help menu). You should
open whichever file you plan to use now.

Custom Custom queries are queries that you create yourself. They (and standard queries too
Queries for that matter) are not stored in GEDCOM files. They are kept completely separate
and maintained by Family Historian. This means that both standard and custom
queries can be used with any GEDCOM file.

Once you have created a custom query, you never have to explicitly save changes to
it, as you do with family tree files – changes are automatically saved as soon as you
make them.

New To create a new custom query, click on New Custom Query in the drop down
Custom menu that appears when you click on the Query Menu button
on the Query
Query Window toolbar. A dialog box will appear in which you have to specify the name
Query Menu

of the new query, and its type. The name must be unique among custom queries. A
custom query can, however, have the same name as a standard query.
The type of the query is its record type. An Individual query produces a Result Set
that consists of Individual records. A Source query produces a Result Set consisting
of Source records; and so on.
If you run a new custom query, without making any changes to it, you will find that
the result set consists of every record of the required type, in unsorted order.

Save As As stated earlier, you cannot modify a standard query (apart from configuring it for
Custom printing), but you can copy it, and modify the copy.
Query Steps
Query Menu

1.

Ensure that the query you wish to copy is the current query in the Query
Window (select it in the Query field at the top of the Query Window if it isn’t
already selected).

137

Chapter 13 – Custom Queries

2.
3.

Click on the Query Menu button
and select Save as Custom Query
from the dropdown menu that appears.
By default, the name field will show the name of the current query. If you are
copying a standard query, you don’t actually have to change this, although you
may wish to. Set the query name to whatever you wish it to be. The custom
query is created. You will not be allowed to use the name of another custom
query.

You can use Save As Custom Query to copy custom queries, as well as standard
queries.

Delete To delete a custom query, first make sure it is selected as the current query in the
Custom Query Window (using the Query field in the top left corner of the Query
Query Window). Then click on the Query Menu button
on the Query Toolbar, and
Query Menu

choose Delete Custom Query in the menu that appears. You cannot delete
standard queries.
You can also delete custom queries from the View > Custom Queries menu.

The Parent
Names
Sample
Query

As a first example, we will create a custom query that finds all the individuals in the
current file whose father was called ‘Philip’ and whose mother was called ‘Naomi’.
We will create a simple version of this initially, and will gradually look at ways to
enhance it.
Steps
1.

Open the Query Window if it is not already open, by clicking on the Query
Window button

2.
3.

The
General
Tab
Query Window

on the main application toolbar.

on the Query Toolbar, and select New
Click on the Query Menu button
Custom Query from the dropdown menu.
Set the name of the query as ‘Parent Names’. The type should be Individual.
Click on Create. The new query is created.

Click on the General Tab of the Query Window (see figure 39 below). The Query
Type field should contain ‘Individual’. The Read Only field is unchecked. You
can check this field if you have finished making changes to a custom query, and
want to ensure you don’t absent-mindedly make further changes to it, or delete it.
For now, though, leave this unchecked.
Enter the following description, as a reminder to yourself, in the Description field:
“finds all the individuals in the current file whose father was called ‘Philip’ and
whose mother was called ‘Naomi’”.

Title and The Title and Subtitle fields are used when a query is printed as a report. The
Subtitle Subtitle field contains the special characters “%#x”. This is a code which ensures

that the day and date are inserted as a subtitle when the query is printed as a report.
Leave the Subtitle field as it is for now, but change the Title field to ‘Parent
Names’.
For more information on special codes see the online help (press F1).
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Figure 39 – the General tab of the Query Window

The
Columns
Tab
Query Window

We are looking for all individuals whose father is called ‘Philip’ and whose mother
is called ‘Naomi’. What information do we want to see about the individuals that
we find who match this? Obviously we want to see the name of individuals found.
But we would probably also like to see their parents full names, and perhaps some
other details. For now, we will opt to see the following information:






Individual’s full name
Father’s full name
Mother’s full name
Individual’s date of birth
Individual’s place of birth

We can modify this later if we want to, but this will do for a start. Click on the
Columns tab (see figure 40). If the Query Window seems small at this point, resize
it to make it bigger, or maximize it to fill the frame of the application main window.

The
Column
List
Columns Tab

On the right of the window is a box labelled ‘Columns’. This is the Columns List.
The Columns List has 4 columns with headings Heading, Expression, Sort and
Hidden. Each row in the list corresponds to a column in the Result Set. At present,
there is only one row. This row has ‘Individual’ in the Heading column and ‘INDI’
in the Expression column. When you create a new custom query, Family Historian
automatically creates one column for you, by default; so that if you run the query
without doing anything else, you will see one column in the Result Set.

The Fields On the left of the window is a box labelled ‘Fields’. This is the Fields List. This
List lists all of the possible fields you can have in records of the query type (Individual
Columns Tab

in the current case). As we have seen before, GEDCOM fields are hierarchical.
Fields can have sub-fields, which in turn can have more sub-fields, and so on.
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Figure 40 – the Columns tab of the Query Window. ‘Family as Child>>’ has been expanded in the Fields List.

Add Field To see the value of any field, listed as a column in the Result Set, you simply need
as Column to select the field in the Fields List, and click on the Add Field as Column button

Columns Tab

near the bottom left of the Column tab, to add the field in question to the Columns
List. Then, when you run the query, the new column will appear in the Result Set.
We will do this now. The current query should still be Parent Names at this point.
If it isn’t, select Parent Names in the Query field at the top of the window.
The default column that was provided when the query was created, will do very well
as our first column. This means we only need to add 4 more.

You will notice that there are 4 items at the end of the ‘Individual’ branch, labelled
Father, Mother, Spouse and Child. These do not represent fields as such. They are
shortcuts from one record to another – which is why each of them has the shortcut
icon next to them. In practice, shortcuts are very convenient, and ordinarily you
would use them in this query. We will look at shortcuts in a moment, but for this
example, we will show you how to construct this query without using shortcuts. So
ignore these items for now.
Steps
1.

2.
3.

Click on the expansion button
next to Family as Child>> to expand that
branch. Do not double-click on the text, as that will cause the field Family as
Child>> to be inserted as a column in the Columns List (if you did it anyway,
don’t worry – we will see shortly how to delete columns). Now select
Father>> and click on the Add Field as Column button
.
Now select Mother>> and click on the Add Field as Column button again.
Now close the expanded branch for Family as Child>>, and expand the branch
for Events. Find Birth in the expanded branch, and expand that too. Finally,
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4.

under Birth, select Date and click on Add Field as Column.
Still looking under Birth, select Place, and click on Add Field as Column.

There should now be 5 items (each corresponding to a result set column) listed in
the Columns List. The values in the Expression column of the Columns List will
no doubt seem quite strange. The values in the Heading column should be a little
more intuitive, but still not exactly plain English. Nevertheless, ignore them for
now, and click on the Run Query button
now to run the query. This action
should switch you to the Result Set tab, and there should be one row for each
Individual record in the current file (we haven’t yet got round to being selective),
arranged in 5 columns. The heading for each column should correspond to the
headings in the Column List, and you should be able to see that for each individual
next to
found, the first column gives their name (with an Individual record icon
it). The 2nd column gives their father’s name (if known) with the same icon. The 3rd
column gives their mother’s name (if known) with the same icon. The 4th column
gives their date-of-birth (if known), and the 5th column gives their place of birth.
Now switch back to the Columns tab.
Tip: An alternative to clicking on the Add Field as Column button is just to doubleclick on a field name.

Making
Sense of
the Field
List
Columns Tab

As we know, GEDCOM fields are hierarchical; so it may not be too surprising that
birth date is stored in a field called Date which is a sub-field of a field called Birth,
and that birth place is stored in a field called Place which is another sub-field of
Birth. Remember that sub-fields qualify (i.e. provide more details about) their
‘parent’ field.
In case you’re wondering, there is no field called Events though. Fields of different
types are sometimes grouped together into categories in the Fields List, just to make
it easier to find the ones you want. Categories always have the folder icon
next
to them. Birth is an event, which is why it is listed under Events. You cannot add
Events itself as a column. Conversely, any row which does not have the folder icon
can be added.
Whereas a person’s birth date and birth place are stored in their own record, the
names of their parents are not stored in their own records. Instead, they will have a
field, called Family as Child, which stores a link to a Family record. The Family
record in turn contains more fields, including fields which hold links to all the
Individual records for the members of the family.
What this shows is that although a Result Set is, essentially, an ordered collection of
records, the data displayed for each record does not actually have to come from the
record itself. It can also come from other records linked to it. And that is what has
happened here. By inserting the field we did, we effectively have got Family
Historian to traverse a link from the original individual, to that person’s family
record (as child); and then traverse again from that family record to the individual
record for the father.
Any field in the field list which stores a link to another record always ends in ‘>>‘.

Shortcuts It is useful to understand how records are linked together, because for some
Columns Tab

purposes you need to know this. However, in practice, most of the time you will
find it much easier and more convenient to use shortcuts, when you want to create
an expression which refers to a person’s parents, spouses or children. Shortcuts are
not fields. They are just there to make it easier for you to reference one record from
another.
Shortcuts are easy to identify because they have the shortcut icon
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If you want to add a column for maternal grandfather, for example, you could do
this somewhat laboriously by expanding the branch for Family as Child>>, then
within that expand Mother>>, then within that expand Family as Child>>, then
within that select Father>> and click on the Add Field as Column button.
Alternatively, you could expand the Mother shortcut, select the Father
shortcut within that and click on Add Field as Column. The two approaches
achieve the same result, but the latter technique is simpler.

Change
Column
Headings
Columns Tab

Look now at the columns you created a few sections back. The first column is
labelled ‘Individual’, which is fine. The second column is labelled ‘Family as
Child.Father’, which is not. You should think of the column headings that Family
Historian generates for you as useful reminders of what the field contains. But you
should always expect to have to adjust them to make them more presentable.
Steps
1.

2.
3.
4.

Click on Family as Child.Father in the Columns List now. Notice that all the
values for the selected column are now displayed in the fields below the
Columns List. Change the value of the Heading field from ‘Family as
Child.Father’ to ‘Father’.
Click on the Update button (bottom right corner).
Now click on Family as Child.Mother in the Columns List, and use the same
technique to change the heading to Mother.
Then do the same again to change Birth.Date to Birth Date and Birth.Place to
Birth Place.

Now run the query again, and confirm that the column headings are what they
should be.

Expres- You may be wondering what the significance of the values in the Expression
sions column are. Expressions determine what data is displayed in the column (as we will
see later, you can also use expressions in filters – and even to a limited extent in
report titles and subtitles).

There are 2 different kinds of expression: functions and data references. All the
expressions we have looked at so far have been data references. 24 We will look at
an example of a function expression shortly.

Handling
Multiple
Instances

You do not have to construct data references as Family Historian will always
generate them for you. You just have to select the fields you want from the Field
List and click on Add Field as Column. The only qualification to this, however,
concerns instances. The data references that Family Historian generates always
retrieve the first instance of each of the fields referenced. But what if it is not the
first instance that you want? In that case, you should get Family Historian to
generate the field as normal, but modify the instance value in the expression. For
example, the expression for a person’s father generated earlier was
INDI.FAMC>HUSB>
If you select the column by clicking on the heading, the expression is shown in the

24

We have come across data references before when looking at text schemes in Chapter 7 above. The
technically-minded may be interested to know that data references are usually just sequences of
GEDCOM tags (GEDCOM field names) separated by either a ‘.’ or a ‘>’ (the latter indicates a link
from one record to another record). For example, in the expression ‘INDI.FAMC>HUSB>’, INDI is
the GEDCOM tag for an INDIvidual record. FAMC is the ‘FAMily as Child’ field within that, which
stores a link to a Family record. The HUSBand field in the Family record stores a link to the
Individual record for the father/husband figure in the family. A proper discussion of data references is
beyond the scope of this manual, but there is more information about them in the Online Help. Look
up ‘Data References’ in the Index for the Online Help.
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Expression field below the Column List as
INDI.FAMC[1]>HUSB>
These 2 forms are equivalent. The latter shows the field instance explicitly, the
former does not. The default instance is always 1, if not specified.
If you want the second Family as Child (for people who have more than one sets of
parents), you only have to change the [1] to a [2] (and remember to press the
Update button to register the change).

The Rows We have chosen the columns we want, but we haven’t yet selected the records we
Tab want. This is what we will do now.
Query Window

Select the Rows tab (see figure 41 below). The top part of the Rows tab contains a
box with 3 column headings. These are Filter, Param. and Parameter Label. This
box is called the Filter List.

Add We need to filter the result set. We want to only include records for individuals
General whose father is called ‘Philip’ and whose mother is called ‘Naomi’.
Filter At the bottom of the Rows tab is an area with three tabs: General, Relations and
Rows Tab

List.
Steps
1.

The General tab should already be selected, but if not, click on it now to select
it.
2. The Condition field should be set to Add If…
3. The Expression field must refer to the father’s name. To the right of the
Expression field is a button with 3 little dots . Click on this now. The Data
Reference Assistant dialog appears. Expand the branch next to Family as
Child and then expand Father. Then select Name and press OK25. The text
‘INDI.FAMC[1]>HUSB>NAME[1]’ appears in the Expression field.
4. Set the Operator field to Contains.
5. Type Philip into the Value field.
6. Press the Add button (bottom right). A row is added to the Filter List.
7. Now set the Condition field to Exclude Unless…
8. This time Expression field must refer to the mother’s name. Click on the little
button
to the right of the Expression field. In the Data Reference Assistant
dialog, expand the branch next to Family as Child and then expand Mother.
Select Name and press OK. The text ‘INDI.FAMC[1]>WIFE>NAME[1]’
appears in the Expression field.
9. Set the Operator field to Contains.
10. Type Naomi into the Value field.
11. Press the Add button (bottom right). A second row is added to the Filter List.
At this point the Rows Tab should look like figure 41 below.
Now click on the Run Query button
. This time there should be only 2 rows
in the Result Set (i.e. 2 records found): one for Mary Peabody and one for Cameron
Peabody. They are of course brother and sister. Their parents are shown as Philip
Peabody and Naomi Prentice Salt.

25

Alternatively, you could use the Father shortcut.
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Figure 41 – the Rows tab of the Query Window. Two filters have been added.

How Filters Each row in the Filters List represents a Filter. Filters created using the General tab
Work are called General Filters, filters created using the Relations tab are Relation
Filters, and filters created using the List tab are List Filters.

When a query is run, Family Historian applies each filter in turn. It is important to
appreciate that filters are applied in sequence, starting with the first filter in the list,
then working down through each in turn to the end of the list.

The Result
Set and the
Input Set

When Family Historian runs a query and applies its filters, it starts by creating 2
lists, called the Input Set and the Result Set. You will never see any references to
the Input Set in the program. It is only used by Family Historian internally while
the query is being run, and is discarded when the query has completed.
Nevertheless, it is helpful to know about it, to make sense of how filters work.
The Result Set is not just an internal list. We have heard many references to the
Result Set before. This is the list of records which is displayed in the Result Set tab
of the Query Window, when the query has finished running.
When Family Historian runs the Parent Names query, it starts by putting all records
(of the query type) into the Input Set. The Result Set list is empty at this point.
As stated earlier, Family Historian then applies each filter in turn.
For each filter, if the filter has an Add condition (Add if… or Add Unless…), Family
Historian will look through the Input Set to find records that match (if it is an Add
If…) or don’t match (if it is an Add Unless...) the condition specified in the filter.
Any records found will be moved from the Input Set to the Result Set.
If the filter has an Exclude condition (Exclude if... or Exclude Unless…), Family
Historian will look through the Result Set to find records that match (if it is an
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Exclude If…) or don’t match (if it is an Exclude Unless…) the condition specified in
the filter. Any records found will be moved back from the Result Set to the Input
Set.
In our example, when the Parent Names query is run, Family Historian will initially
move all Individual records into the Input Set and leave the Result Set empty.
When it applies the first filter, it will look through the Input Set and find all the
records where the father’s name contains ‘Philip’. It will move all of these records
into the Result Set. When it has finished doing that, it will move on to the second
filter and apply that. Because this is an Exclude condition, it will look through the
Result Set and find all the records there where the mother’s name is not Naomi
(‘not’ because it is an Exclude Unless…). It will move all such records back into the
Input Set.
Can you see that the combined effect of these 2 filters is to leave in the Result Set
all and only records where the father’s name is ‘Philip’ and the mother’s name is
‘Naomi’?

First Filter
has
Exclude
Condition

If the Input Set always initially contained all of the records, an empty filter list
would mean an empty Result Set. Equally if the first filter had an Exclude
condition, it would never have any effect. For this reason, Family Historian uses the
following rule when initialising the Input Set and the Result Set, before applying
filters:
If the filter list is empty, or if the first filter has an Exclude condition, it puts all
records (of the query type) into the Result Set and leaves the Input Set empty.
Otherwise (i.e. if there is at least one filter and the first one has an Add condition) it
puts all the records into the Input Set and leaves the Result Set empty.

More on As we have seen, filters are applied sequentially. When applying filters, Family
Filters Historian simply moves records forwards and backwards between 2 lists – the Input
Set and the Result Set. At any given time, while the filters are being applied, each
record is always in one, and only one of these lists. It is never in both lists at the
same time. It can never have more than one occurrence in a list. That is why you
will never see the same record occur more than once in the Result Set tab of the
Query Window.

There is no limit to the number of filters you can have in a query. Nor is it the case
that there are any special rules to say that you can’t move a record from one list to
another if you had previously moved it the other way. In fact a series of filters
might easily result in the same record shuttling forwards and backwards any number
of times between the 2 lists, as the filters are applied. Do not make the mistake of
attributing undue complexity to filters. In fact their role is quite straightforward,
once you have understood it.26

Benefits of
Sequential
Filtering

The main benefit of sequential filtering is that you can have steps which make
reference to the results of the previous step. This is never done with General or List
filters, but as we shall see shortly, it is done with Relation filters. For example, you
can have one filter which adds all of the ancestors of a given person. The next filter
can then stipulate that you should also add all descendants of those people (i.e. the
people in the Result Set at this point). A further filter could then go on to add the
ancestors of everyone who is now in the Result Set, and so on. This way of working
is very useful when you are dealing with family tree relationships.

26

Some peoples’ reaction is to see this way of applying filters as inefficient, and to anticipate that
Family Historian queries will run slowly. In fact, however, this is not the case. Family Historian
queries are efficient and run very fast.
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Using Instead of looking for records where the name contains ‘Philip’ and ‘Naomi’, we
Parameters might want to make our query more generally useful, so that it can be used to search
Rows Tab

for records, using a pair of parent names that you supply when the query is run. For
this you need parameters.
Make sure that you are now looking at the Rows tab.
Steps
1.
2.
3.
4.
5.
6.

Select the first filter in the list (by clicking on the text in the first column). The
filter details are displayed below the Filter List in the General filter tab.
Click on the Parameter check box. The Label field becomes ungreyed.
Enter “Father’s Name” into the Label field. Click on the Update button to
update the filter.
Select the second filter in the list. This filter’s details are now displayed in the
General filter tab.
Click on the Parameter check box. The Label field becomes ungreyed.
Enter “Mother’s Name” into the Label field. Click on the Update button to
update the filter.

Now run the query again, by clicking on the Run Query button
. The Query
Parameters Dialog appears. Change the father’s name to ‘Peabody’ and the
mother’s name to ‘Jean’. Press OK. This should produce a result set with 4 records
– one child of Cameron Peabody and Jean Clare Anderson, and 3 children of Daniel
Anderson Peabody and Pamela Jean Winters.
Tip: If you want the same parameter value to be inserted into different filters, just
make sure that you use exactly the same label each time.

Using Suppose that what we wanted was a query that only checked the first name of a
Qualifiers person’s mother? For the convenience of this tutorial, we will arbitrarily assume

that this requirement only applies to the mother’s name and not to the father’s name.

Rows Tab

Steps
1.
2.

3.

Select the second filter in the list (the ‘Exclude Unless…’ filter that refers to
the mother’s name).
Click on the button with 3 dots
to the right of the Expression field. Expand
Family as Child>>, then Mother>> then Name (or use the Mother shortcut if
you prefer). The Name field has various sub-fields, but listed before them are 7
possible qualifiers for the Name field. Qualifiers always begin with a ‘:’ and
they have no field icon next to them. Unlike sub-fields, qualifiers do not
represent distinct items of data. Rather they are used for qualifying the way the
value in a field is presented. For example, the :FIRST qualifier for the name
field doesn’t store the first name. When used, this qualifier effectively pulls out
the first name from the Name field. Select :FIRST now and press OK. The
Expression field in the General filter tab now reads:
INDI.FAMC[1]>WIFE>NAME[1]:FIRST (unless you used the shortcut, in
which case it will read: INDI.~MOTH>NAME[1]:FIRST).
Ensure that the value for Operator is Matches (we’re looking for an exact
match on first name). Press the Update button.

Run the query again, and again specify ‘Peabody’ as the father’s name and ‘Jean’ as
the Mother’s name. This time there should only be one match - for Daniel Peabody,
the son of Cameron and Jean Clare Anderson. Pamela Jean Winters is now
excluded as a mother’s name, by the 2nd filter.
Some fields have qualifiers, some don’t. Qualifiers are especially useful with all
date fields and, as we have seen, with name fields.
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Tip: If you want to look more closely at the effect of qualifiers, run the standard
queries Qualifiers for Dates and Qualifiers for Names. These queries have no
filters. They are designed to illustrate the effect of different qualifier types.

Add Now suppose that you want to modify your query again, to add the record id for
Record Id each record found, and also the record ids of that person’s father and mother (if
any).

Record Ids are not stored as fields in Family Historian. They are held internally in
the record itself. So to retrieve a record id, you cannot use a data reference as we
have done up to now. Instead, you must use a function. If you have used Microsoft
Office products, such as MS Excel, you may have encountered functions before.
Support for functions is a powerful feature that allows you to make use of derived or
calculated data.27
In Family Historian, as in MS Excel, function names begin with an ‘=’ sign. In this
example we will be using the function ‘=RecordId()’ which returns the record id of
the current record.
Steps
1.

Click on an unused part of the Columns List so that no existing column is
selected. The Update button becomes greyed (you don’t actually need to do
this, but it clears the fields we are about to enter data into, and ensures that you
won’t accidentally update an existing column by mistake).
2. Insert “Record Id” into the Heading field below the Columns List.
3. Insert “=RecordId()” into the Expression field below that, taking care to ensure
that you have entered it exactly like that.
Click on the Add button. If you entered the Expression field value incorrectly, a
message will warn you that the expression is not recognised, in which case, correct
the error, and press Add again.

Re-order Let us suppose that we want Record Id to be the second column.
Columns
Steps

Columns Tab

1.

Select Record Id in the Heading column and click repeatedly on the Move Up
button
list.

on the bottom toolbar, until Record Id is the second column in the

Now run the query again, and confirm that the Record Id column does display the
record id, and is the 2nd column in the result set.

Specify
Column
Sort
Columns Tab

You specify how you want the Result Set to be sorted as part of the column data, in
the Column tab. Each column has a Sort field value – which can be Ascending,
Descending or None. For sorting purposes, columns on the left take precedence
over columns on the right. For example, if the first column was Surname, and it
was to be sorted in descending order, and the second column was Given Name, and
it was set to be sorted in ascending order, the result set would appear to be sorted in
descending order of surname. However, where 2 or more records shared the same
surname, those records would be sorted additionally in ascending order of given
name.
If you wanted the result set to be sorted by given name first and then by surname,
you could do this by simply moving the given name column up, so that it came

27

A proper discussion of functions is beyond the scope of this manual. If you are interested, there is a
complete list of all Family Historian functions, as well as detailed information about how to use them,
in the Online Help. To find this, look up ‘Functions’ in the Index for the Online Help.
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before surname.
If you didn’t want to re-order the columns in the Result Set, but still wanted the
given name sort to take precedence over the surname sort, you can still do this. You
should set the Sort field value to None for both columns, and then create copies of
each column, using the original Sort values, and with the Hidden field checked.
These hidden columns will not appear in the Result Set. They are used for sorting
purposes only. You can put them anywhere in the Column List, but it is usual to
add them to the end of the list. To get the sort precedence you want, you would
only need to make sure that the hidden Given Name column came before the hidden
Surname column.

Delete To delete a column, you need only select it in the Column List and click on the
Column Delete button
on the bottom toolbar.
Columns Tab

The Born
After 1900
Sample
Query

In the Parents Names sample, we created a custom query that used only general
filters. We will now create a custom query that also uses a relation filter.
For this example, we will create a query that attempts to find all people who were
born after 1900. We will do this first by creating a general query to find everyone
whose birth date falls after 1900. However, some people will not have a birth date
specified, and will consequently be excluded. So to find at least some of these
people, we will also include anyone who is descended from anyone whose birth date
falls after 1900.

Add We must start by creating the new custom query.
Relation
Steps
Filter
Rows Tab

1.

Open the Query Window if it is not already open, by clicking on the Query
Window button

2.
3.
4.
5.
6.

7.
8.
9.

on the main application toolbar.

Click on the Query Menu button
on the Query Toolbar, and select New
Custom Query from the dropdown menu.
Set the name of the query as “Born After 1900”. The type should be
‘Individuals’. Click on Create. The new query is created.
Click on the Rows tab and select the general filter tab if not already selected.
The Condition should be Add If…
Click on the button with 3 little dots
to the right of the Expression field.
The Data Reference Assistant dialog appears. Expand the Events branch, and
within that expand Birth, and then select Date within that. Press OK. The text
‘INDI.BIRT[1].DATE’ appears in the Expression field.
Set the Operator field to was later than.
Type 1900 into the Value field.
Press the Add button (bottom right toolbar). A row is added to the Filter List.

10. Click on the Run Query button
to run the query. Notice that there are
only 4 records in the Result Set (one of the status bar panes, at the foot of the
main application window, reads “Records in Result Set: 4”).
11. Now return to the Rows tab, and click on the Relations filter tab.
12. Leave the Condition field as Add If…
13. Set Relationship to Descendants.
14. Leave Max Generations blank (i.e. no maximum).
15. Set Of to Anyone in the current result set.
16. Leave Inc spouses of relatives unchecked, and press the Add button to add the
filter to the filter list.
17. Now, run the query again. This time there should be 12 people in the Result
Set.
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Delete To delete a filter from the current query, you need only select it in the Filter List
Filter and click on the Delete button
on the bottom toolbar.
Rows Tab

Re-Order To re-order a filter, select the filter that you want to move, and click either the Move
Filters Up
or Move Down
buttons, until the filter is in the position you want.
Rows Tab

Relation
Filters that
Reference
a Single
Individual
Rows Tab

Descendants of a
Particular
Individual

Look now at the relation filter tab within the Rows tab. You will notice that as well
as specifying Anyone in the current result set, as the Of value, you can also specify
This Individual. When you do this, you have the option, if you want to, of
specifying a value at this point for This Individual (you do this by clicking on the
box with 3 dots
to the right of the box next to This Individual). However, there
is no need to specify a value at this point. Family Historian requires that any
relation filter which uses This Individual, must take a parameter. It will not let you
uncheck the parameters check box. Consequently, the only effect of specifying a
value for This Individual at this stage, is to provide the default value which will
appear in the Query Parameters Dialog when you next run the query.
Suppose you regularly work with a query consisting of the descendants of a
particular person, and want to be able to run this query without having to select that
person’s name from a list in the Query Parameters Dialog.
Let us suppose that the person’s record id is 278.
Steps
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.

Create your new custom query and give it a suitable name.
Select the Rows tab, and within that choose the General filter tab.
Set Condition to Add If….
Set Expression to ‘=RecordId()’.
Set Operator to equals.
Set Value to ‘278’.
Click on the Add button to add the filter.
Now choose the Relation filter tab
Set Condition to Add If….
Set Relationship to Descendant.
Set Of to Anyone in the Current Result Set.
Click on the Add button to add the filter.

Although this query can be run for any file, it is not likely to be at all useful for any
file except the one that contains the person whose descendants you want to be able
to find easily, who has record id 278. So you should add a note to this effect, as a
reminder to yourself, in the Description field in the General tab.
Note: An alternative approach to the one shown here would be to create a Named
List which contained the person whose descendants you wished to see, and no-one
else. Then the first filter, instead of using a record id, could simply add everyone in
the specified Named List. For more on Named Lists, see Chapter 15.
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Tree Files
This step presupposes that you have...
Read the Introduction and Chapters 1 & 2

You will learn how to...
Understand the differences between different kinds of Merge/Compare
Compare 2 GEDCOM files
Merge 2 GEDCOM files
Split a GEDCOM file

3 Kinds of Family Historian supports 3 kinds of Merging and Comparing. These are:
Merge
Compare  File Merge/Compare



Basic Record Merge/Compare
Branch Merge/Compare

File Merge/Compare is when you compare and (optionally) merge 2 entire files.
Basic Record Merge/Compare is when you compare and (optionally) merge 2
records of the same type (e.g. 2 Individual records or 2 Source records).
Branch Merge/Compare is an extension of Basic Record Merge/Compare for
Individual or Family records. It sometimes happens that you discover that 2 records
in your file turn out to be records for the same Individual. But it may further
emerge that not only are they duplicated, but so too are their parents, children,
spouses and other relatives. Branch Merge/Compare helps you locate entire
branches of duplicated records, compare all records in each record, and merge them
all in one step.
Basic Record Merge/Compare and Branch Merge/Compare are both initiated by
selecting 1 or 2 records that you wish to merge, and clicking on Merge/Compare
Records on the Edit menu. For more information about them, see the Online Help
within Family Historian. The remainder of this chapter deals exclusively with File
Merge/Compare.

File Merge/ With File Merge/Compare, Family Historian’s Merge/Compare Dialog can be
Compare used to compare any 2 GEDCOM files. Neither of the files being compared need

have been created using Family Historian. Having compared the two files, you can,
if you wish, use Family Historian to merge them. Once you have learned how to
interpret the information Family Historian provides to you, you will be able to see
exactly what the outcome of the merge process will be before Family Historian does
it.

Why is File
Merge/
Compare
Needed?

Why do we need a file merge/compare facility? Isn’t a record merge/compare
feature enough? No it isn’t.
Without a File Merge facility, records must be merged, one pair at a time. To do
this yourself would be very time-consuming if you had a large number of records.
But it’s the wrong approach anyway. If X and Y are father and son in one file, and
A and B are father and son in the other, the question of whether Y is the same
person as B has to be answered at the same time as deciding as whether X is the
same as A. Being asked to decide these questions, one pair at a time, is like being
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asked to sign a contract one clause at a time. You don’t want to have to commit to
giving the other person your car before you know whether they in return are going
to agree to give you your asking price. The same is true of decisions about merging
records.
If you don’t have a full file merge/compare facility, the only alternative to you
merging them one record at a time yourself, is to trust your genealogy application to
do it for you.- that is, you or the program simply insert all records from one file into
another, and then you have to trust your genealogy program to automatically detect
duplicates and merge them for you. This is still record-at-a-time merging - the only
difference is that the genealogy program is doing it instead of you. It is a very risky
strategy, as it could take years to detect errors that have been introduced in this way
(if indeed you ever can detect them). Such an approach is not likely to appeal to
anyone who values their data.

The Family
Historian
Solution

With Family Historian’s file merge/compare feature you get to see the whole
picture, make all the decisions, and see what you will get before you have to commit
yourself to anything. Crucial to this solution is that Family Historian allows you not
to just to merge two files, but - before you do so - to compare them side by side, so
that you can see exactly where and how they differ. Not only that, the compare
facility is designed so that it is very easy to spot which records have differences and
which do not. Suppose you had 10,000 records in each file. Imagine that all the
records except 20 are identical, of which 3 are unique to one file, and 3 to the other.
Family Historian lets you effortlessly detect (and group together for easy scrutiny)
the 20 records that have differences, and see exactly how they differ. You can see
exactly what will happen to your file if you merge them, and override Family
Historian’s proposed strategy for merging them if you wish.

You Are In You can use the Merge/Compare Dialog just for comparing two files. You don’t
Control have to merge anything. If you want to merge the files, there are 3 options open to
you:

(1) Leave it all to Family Historian
(2) Let Family Historian do it for you, but only after you have made whatever
changes you want to ‘override’ Family Historian’s initial merge plan
(3) Use Family Historian solely for comparison purposes – you do all the data
changes manually yourself
In this chapter, we will look at options (1) and (2), and at how to use the
Merge/Compare dialog. If you want to do option (3), the best solution is to copy the
files to be compared and view them in one instance of Family Historian while using
another instance of Family Historian to actually make the changes.
Finally, we will look briefly at the Split Tree Helper dialog, which can be used to
split a GEDCOM file.
Tip: Before using merging, or even comparing, 2 GEDCOM files it is a good idea to
ensure that both files are in a good state. Sometimes GEDCOM files created by
other applications can contain errors. If you have not already done so, you are
recommended to open each file in Family Historian at least once, run checks for
errors if recommended to do so, and run the Validate command on the File menu.
You are also recommended to ensure that each file has been saved using Family
Historian at least once.

Prepar- To illustrate how merge and compare work, we need 2 GEDCOM files that have
ation records in common, records which are identical, records which are similar but

different, and records which appear only in one of each of the files and not in the
other.
We will use the file you created in Chapter 11 as one of the two files. We will
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compare it with the file you created in Chapter 4 – but only after we have made
some changes to the latter file, to provide the required differences. So, locate the
file you saved at the end of Chapter 4. It should be called “Tutorial – Chapter 4” (it
will have a “.ged” suffix, if you are displaying them). Open it now.
If you skipped chapter 4, or read it but didn’t create your own file, use the ‘precooked’ version (see “Tutorial Files (referred to in the manual)” on the Help menu).

Save As Having opened the file, you should immediately save it under its new name. See the
discussion in the Save As section in Chapter 4, for why it is better to Save As now,
rather than wait until after you have made the changes you are about to make.
Steps
1.

From the File menu, click on Save As. Use the folder you always use for
Tutorial files and save the current file as “Tutorial – Chapter 14 (Chapter 4
modified)”. Press OK.

Modify File Now change the file.
from
Steps
Chapter 4
1.
2.
3.

4.

Find Ian Peabody’s record. Change his name to “Ian Robert /Peabody/”.
Enter his date of birth as 1st June, 1930.
Find Amanda Peabody’s record. Create a new spouse for her, Hamish Wiley.
Make sure you add Hamish Wiley as the father of Adam Wiley when you do
this (i.e. if you do this in the Property Dialog, add Hamish Wiley in the spouse
tab in which Adam Wiley is listed as child).
Click on File > Save to save changes.

Open File Now, locate the file you saved at the end of Chapter 11. It should be called
from “Tutorial – Chapter 11” (it will have a “.ged” suffix, if you are displaying them).
Open it now.
Chapter 11
If you skipped chapter 11, or read it but didn’t create your own file, use the ‘precooked’ version (see “Tutorial Files (referred to in the manual)” on the Help menu).

The When files are merged, there is always a ‘direction’ to the merge – that is, a new
Direction file, which you select, is always merged into the current file. All the changes are
made to the current file. The new file is never changed in any way by a merge.
of a Merge
The Merge/Compare Dialog let’s see you both how the 2 files differ, and what
would happen to the current file if you merged the new file into it. It is up to you
whether you then go on to do this merge.

Open the Open the Merge/Compare Dialog to compare the 2 files.
Merge/
Steps
Compare
Dialog 1. Click on Merge/Compare… on the File menu. A file dialog appears.
2.
3.

Select the file you just created, called “Tutorial – Chapter 14 (Chapter 4
modified)”.
Click on Open. The Merge/Compare Dialog appears (see figure 42 below).

The files in this case are both small. If the files had both been large, it could take a
little while for the Merge/Compare Dialog to appear. This is because Family
Historian has to analyse the 2 files and work out which records match, and which
fields, before opening the dialog. It uses a sophisticated algorithm for record
matching, and with large files, it can be a slow process.
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At this point, of course, no changes of any kind have yet been made. So far Family
Historian has merely compared the 2 files. If you were to click on Cancel now, to
close the Merge/Compare Dialog, no changes of any kind would have been made
to either file.

Figure 42 – the Merge/Compare Dialog

The Merge/ The Merge/Compare Dialog can be resized (like many dialogs in Family
Compare Historian). Click on its Maximize button to make it full-screen now.
Dialog

The dialog has some similarities to the Records Window. Like the Records
Window, it has tabs – one for each record type. However, there is no facility to hide
record types. The dialog will display a tab for a record type if and only if that
record type occurs in at least one of the 2 files being compared. If there are no
Note records in either file, for example, there will be no Note record tab in the
Merge/Compare Dialog.

The 3 Each tab of the Merge/Compare Dialog has 3 panes. These are (in order):
Panes




the Information Pane
the Current File Pane
the New File Pane

Records in the Current File Pane are labelled ‘Current Records’. Those in the New
File Pane are labelled ‘New Records’.
If you scroll any of these panes vertically, or expand any of the records in the
Current or New File panes, you will find that they all move together. You should
think of each row as extending across all 3 panes.

Matched Each row displays a record (or field, if you 'expand' the record) in either the Current
Records File Pane, the New File Pane or both. The records in the Current File Pane belong
to the current file. The records in the New File Pane belong to the file you selected
to compare with the current one.
If a row displays a record in one pane only, this means that the record is considered
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to have no equivalent in the other file. If, however, a given row displays a record in
both the Current Pane and in the New Pane, this means that the 2 records have been
'matched' and are considered to be equivalents. Records in the same row will be
merged, if you opt to execute a merge.
So far then we can see that Family Historian has matched most of the records; but
there are 7 Individual records in the current file that have no equivalent in the ‘new’
file; and there is one Individual record in the new file (for Hamish Wiley) which has
no equivalent in the current file.

Matched
and
Unmatched
Fields

You can view the contents of a record by clicking on the expansion button next to it,
to 'expand' it. Where you have a match between 2 records, some or all of the fields
belonging to the records may also match. Again, fields on the same row are deemed
to be equivalents and will be merged. Fields which occur in one pane only, are
deemed to have no equivalent in the matching record.
Find the records for Ian Peabody. The one in the Current File Pane is lined up in the
same row as the one in the New File Pane, which means that Family Historian has
matched them. Expand either of these records. When you do so, both records
expand together. Notice that the Name fields in each record are on different lines,
because they do not match. Also, there is a Birth field in the new file record, that
doesn’t exist in the current file record. And there is a Multimedia Object field in the
current file record which doesn’t exist in the new file record.
If you were to merge the records now, Ian Peabody would acquire an additional
name field (in which his name is recorded as ‘Ian Robert /Peabody/’. It would also
acquire a Birth field, and its associated Date field.

Retained
Data and
Discarded
Data

Records or fields which only appear in one file or the other are said to be either
retained or discarded. If a record or field has been flagged to be discarded, its
name, and all of its fields/sub-fields, will display ‘struckout’ (e.g. struckout). When
Family Historian compares the 2 files (which it does while opening the
Merge/Compare Dialog), it will always assume that all records should be retained
(the only exception to this is that the header record for the new file is always flagged
to be discarded).
You can override Family Historian to flag any records (except Header records), or
any fields, from either file, as needing to be discarded.

The Information
Pane

The Information Pane on the left provides information both for comparison
purposes and for merge purposes. The Action column gives information about
would happen if the files were merged. The Chk column is a special case that we
will discuss later. All the other columns provide information about how the records
compare with one another (or not as the case may be).

The Score The Score column is only applicable to matches between records. When Family
Column Historian compares 2 records it assigns them a match score to calculate the

likelihood of a match. It will match any 2 records that have a match score higher
than zero, unless either of them has a higher score when matched against another
record. If you force Family Historian to match 2 records that it did not match itself
(and we will look at how you do that shortly), you should not be surprised to see
negative values appearing in the Score column.

Family
Historian is
not
Infallible

There is no way that Family Historian can guarantee that its matches are correct. It
may fail to match 2 individual records that should be matched because (you just
happen to know) although wildly different, they are about the same person. It may
incorrectly match 2 individual records that look practically identical, but actually are
about 2 different people. Family Historian uses a sophisticated algorithm and
checks not just the records themselves, but also takes into account other records that
they are linked to (e.g. grandparents – in the case of individual records). Records
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which have few links to other records, or none, are particularly hard to match.
The Match Score is a very useful indication of how reliable a particular match is. In
principle, if it matters, you should carefully check all of Family Historian’s matches
(and make sure it hasn’t failed to match some it should). However, although no
matches are guaranteed, you should always be especially vigilant in carefully
checking any matches with a score less than 100. In our example, there are 7
records with a score of under 100, which merit close attention. In fact, in this case,
all 7 are valid matches.
Sorting on the Match column is a useful way both of grouping together all the
records that have been matched. It all makes it very easy to find all records which
have a low match score.

The Match The Match column is only applicable to records or fields which have been matched.
Column It gives information about the match. Possible values for this column are shown in
the table below:

Note: A ‘field branch’ is a convenient name for a field and all of its sub-fields.
Match Column
All

Subset
Discards

Compatible

Meaning
The records, and all of their fields, have been matched. When
applied to 2 fields, it means that the entire field branches have
been matched.
The new record or field branch is a subset of the current one.
Implies that at some level within the record, at least one field
on one side or the other, has been flagged to be discarded (see
the discussion of the Discard button below). Intutively,
‘Discards’ implies that there are conflicts between the
matching records or field branches.
There are differences between the Current record or field and
the New one (including some fields on the New side, which are
not present on the Current side); but no fields have been
flagged to be discarded on either side.

L+, L-, The L and R columns are either blank, or contain ‘Y’. ‘L’ stands for ‘Left’ – i.e. the
R+, R- current file pane. ‘R’ stands for ‘Right’ – i.e. the new file pane.
‘Y’ in the L+ column means that the record or field branch is not discarded, and is
or contains data that is only to be found in the current file.
‘Y’ in the R+ column means that the record or field branch is not discarded, and is
or contains data that is only to be found in the new file.
‘Y’ in the L- column means that the record or field branch belongs to the current file
and has either been discarded, or contains a field branch that has been discarded.
‘Y’ in the R- column means that the record or field branch belongs to the new file
and has either been discarded, or contains a field branch that has been discarded.
Once you have got used to the L and R columns, you will find that you can use them
to easily and quickly see exactly where and in what way 2 records or field branches
differ.

The Chk This column is entirely for the convenience of the user. If you select a record and
Column click on the Checked or Unchecked buttons, it will set or clear this flag. That way,
you can methodically check each record if you wish to (e.g. to make sure that it has
been matched correctly, or correctly left unmatched), and use this flag to remind
yourself which records you have checked and which you haven't. If any records are
unchecked when you click on Merge..., you will get a warning message to that
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effect, which you can safely ignore if you wish to.

All
Columns
are
Sortable

The Chk column is particularly useful because you can sort on any column in any
pane of the Merge/Compare Dialog, by just clicking on the column header. This is
often a very useful thing to do – but it would be hard to keep track of which records
you had checked if you didn’t have the Chk flag to mark them.

The Action The Information Pane’s Action column gives information about what will happen if
Column you choose to merge the new file into the current file at this point. As we have seen,
any records or field branches which have been matched will be merged. But what
does this ‘merge’ really mean. If the 2 records are identical, or if the new one is a
subset of the current one, it may mean that nothing at all happens to the current
record or field branch. This is labelled in the Action column as a ‘Null Merge’. It is
still counted as a ‘merge’, even though the current record or field branch is not
updated in any way as a result of it.
A value beginning with an asterisk, indicates an action which will affect the current
file. If it is for a record, it will be in bold. For example, Ian Peabody has ‘* Merge
*’ opposite his matched records. This is because merging these records will result
in a new Name field being added, and a new Birth field (and Date subfield).
If you sort on the Action column, you can see all the rows that begin with an
asterisk, in bold, grouped together. We have already seen ‘* Merge *’. ‘* Add *’
means that a record will be added to the current file. ‘* Delete *’ means that a
record will be deleted from the current file.
Unmatched records in the current file which are to be retained are simply marked as
‘Keep’. Unmatched records in the new file, which have been flagged as discarded
(i.e. to be ignored if and when the merge occurs) are marked as ‘Discard’. Neither
of these options are in bold, or start with an asterisk, because neither of them will
result in changes to the current file.
For more information on this, see the online help.

Override
Family
Historian

The
Discard
Button

We saw earlier that by default, Family Historian proposes to keep both versions of
Ian Peabody’s name. Ian Peabody will end up with 2 very similar Name fields if
you execute the merge. This might not be what you want. Let us suppose that you
happen to know that the new field is correct, and that Ian Peabody’s full name is
indeed, Ian Robert Peabody. Rather than being left with 2 very similar versions of
his name, you might decide that you only want one – the new one.
The easiest way to ensure that you are left with the field you want, is to click on the
field you don’t want, and flag it to be discarded. Do this now. Click on the Name
field in Ian Peabody’s record in the current file (left column of the Current File
Pane), and click on the Discard button. When you do this, the field name and the
field value are both displayed as ‘struckout’ (see figure 43 below). This means that
if you were to merge the files now, the Name field in the current file would be
discarded. Effectively it would have been replaced by the Name field from the new
file.
Of course you didn’t have to do this. You could choose to discard the Name field
from either file, or you could discard both of them, or you could leave things as they
are and retain both of them.
The Discard button can also be used to flag whole records from either file, to be
discarded.
If you flag a record or a field to be discarded, when it is currently shown as
matched, it will be automatically unmatched at the same time. The matching record
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or field will continue to be retained.

The Retain The Retain button is the opposite of the Discard button. If you change your mind
Button having flagged a field (or a record) to be discarded, simply select it and click on
Retain.

The Match
and
Unmatch
Buttons

If you think that Family Historian has matched 2 records or 2 fields that it should
not have matched, select either or both of them, and click on Unmatch. The 2
records or fields will cease to display in a single row, and will be moved onto 2
separate rows.
If you think that Family Historian has failed to match 2 records or 2 fields that
should be matched, select both of them and click on Match. The 2 records or fields
will now appear in the same row.
Tip: To select 2 records or fields in different panes, click on the first one to select it.
Then press and hold the Ctrl key, and click on the second to select it without
unselecting the first one.

Figure 43 – this section from the Merge/Compare Dialog shows the Current File Pane on the left and the New File
Pane on the right. Ian Peabody’s Name field in the current file has been flagged to be discarded.
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Restrict- You cannot match fields in records that are not matched. You cannot match fields if
ions their ‘parent’ fields are not matched. You cannot match fields of different types –
for example, you cannot match a Birth field with a Death field or a Date field with a
Name field.
You cannot match individual records if they both have sexes and these are different.

Only the
Merge
Button
Executes
Changes

The Discard, Retain, Match and Unmatch buttons do not change any data in the
current file. All they do is affect the way that Family Historian will merge the 2
files if you subsequently ask it to do so by clicking on the Merge button.
If you end up by clicking Cancel, no changes will be made to the current file,
irrespective of what you have done with the Discard, Retain, Match and Unmatch
buttons. Sometimes you may see references to the Discard button being used to
‘discard’ data. This is just a slightly loose way of saying that the Discard button
has been used to flag data, in such a way that it will be discarded, when (and if) the
Merge button is pressed to execute a merge.

Multiple Neither the Current File Pane nor the New File Pane support multiple selection.
Selection However the Information Pane does. If you wish to retain, discard or unmatch a

large number of records at a time, you can select them all in the information pane.
The Retain, Discard and Unmatch buttons will all accept selections, including
multiple selections, in the Information Pane. See online help for more on this.

Discarding
New Data
vs.
Discarding
Old Data

Although we use the same word, ‘discard’, when we talk of discarding records and
fields from either the current file or the new file, the significance in practice of the 2
actions, is very different. If you flag a field or a record in the current file as
‘discarded’, you are effectively ensuring that that field or record will be deleted
when the merge occurs. If, on the other hand, you flag a field or record from the
new file as ‘discarded’, all this means is that the field or record will not be added to
the current file.
Conversely, retaining a new file field or record is a more significant action than
simply retaining a current file field or record, because the former implies that a new
field or record will be added to the current file; whereas the latter merely implies
that an existing field or record will be left as it is.

Matching
NonIdentical
Fields

What happens if you match non-identical fields? Suppose, for example, that instead
of discarding one of Ian Peabody’s Name fields, you matched them? If this were to
happen you would get 2 slightly different fields on the same line. How would they
be merged?
The short answer is that the value of the current file field would be preserved, and
the value of the new file field would be discarded. So, if you matched the 2 Name
fields for Ian Peabody, he would end up with an unchanged name – i.e. ‘Ian
/Peabody/’. The ‘Ian Robert /Peabody/’ version would have been discarded.
Does that not imply that there is no difference between matching fields, and simply
discarding the field from the new file? Where a new file field has no sub-fields, as
is the case with Name in this example, this is true – there is no difference. There
would however be a difference if the new file field did have sub-fields.

Field
Values are
Never
Merged

When we talk of merging 2 fields, what this actually means is that the entire field
branch, including all descendant sub-fields on each side, is merged. Individual field
values, however, are never merged. Where you have 2 field values on the same
row, the new field value in the New File Pane is always discarded, and the current
field value in the Current File Pane is always retained. This is why you will see
that the new field value, in these cases, is displayed with a line through it
(‘struckout’) to show that this value will be discarded.
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The only way that you can override this is to unmatch the fields. You cannot leave
2 fields matched, and force Family Historian to use the New File Pane value instead
of the Current File Pane value.

Adding,
Deleting
and
Ignoring

What this shows is that merging is actually a simpler business than it might at first
sight appear. Merging, if left up to Family Historian, is basically just a matter of
adding new records, and new fields (and sub-fields). By clicking on the Discard
button, you can additionally ensure that some records, fields or sub-fields are
deleted in the current file, or simply ignored in the new file. And that is it. To
repeat – there is no actual updating of individual field values at all.

Summary We said at the start of this chapter, that once you had learned how to interpret the
information that Family Historian shows you, you can see what the outcome of a
merge will be before it has started. We can summarise what we have learned as
follows:






Any record or field branch in the struckout font in the Current File Pane
represents data that will be deleted from the current file.
Any record or field branch in the struckout font in the New File Pane represents
data that will be ignored during the merge.
Any unmatched record or field branch (not struckout) in the Current File pane
represents data that will be retained in the current file (i.e. left unchanged in the
current file).
Any unmatched record or field branch (not struckout) in the New File pane
represents data that will be added to the current file.
Any matched record or field branch represents data that will be merged into the
current file – but a merge may be a ‘Null Merge’ that doesn’t actually change
anything. Also, where 2 fields are matched, the field values are never merged.
The current file field value is retained and the new file field value is discarded.

Execute Now click on the Merge button. When you do this, a warning dialog will appear, to
Merge warn you that not all records have been flagged as ‘checked’. This warning is
entirely for your own benefit. If you had not wished or intended to check every
record you should ignore it.

It is a useful reminder, however, that the issues we have discussed apply to all
record types, not just to Individual records; and that you should remember to check
records of all types – not just Individuals.
For now though, click on OK to proceed with the merge and ignore the warning.

Create
Source
Record to
Represent
File Being
Merged

Another dialog now appears asking if you wish to create a source record to represent
the new file being merged into the current one. If you click on Yes, a Source
Details for Merge Dialog will appear offering you various options about how to do
this.
You will be able, if you wish, to link all the new data being merged into the current
file, to the new source record. You can add source links at either the record or field
level. You can even specify whether you want data that is identical to the data you
already have to be linked to the new source record because it confirms that the data
you already have is correct. You might well wish to use this option if the new file
was created quite independently of the current file. But if the new file merely
represented someone’s corrections to the current file, it would not be appropriate to
assume that any data which was the same had necessarily been confirmed.
For more information about this, see the online help for the Source Details for
Merge Dialog.
For now, click on No. At this point, the Merge takes place. When it has completed,
a Merge Results Dialog is displayed which shows the number of updates of various
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kinds that have taken place to records of all types. Confirm that these figures tally
with what you expected, and click Close to close the dialog.

Changes
have not
yet been
saved

Merging is not an exception to the rule that changes are only saved to disk when you
opt to save them. The changes you have made to the current file have not yet been
saved persistently to file. Nor do we want to save them in this case. Look at the
Records Window and confirm that the results of the merge were as you expected,
then click on File > New to effectively close the current file. Click on No when
asked if you wish to save your changes.

Compare A good exercise is to open each of the Tutorial files in turn, and compare them to
Tutorial other tutorial files. Do they differ in the way you expect? Can you account for the
differences?
Files
Splitting Finally, we will conclude with a very brief glance at the topic of how you split a file
Files in Family Historian.
Splitting files is the opposite problem to merging them. To split a file in Family
Historian, you copy it, and then delete all the records you don’t want from the copy,
which becomes the split off file. You can make 2 copies if you wish to, and make
sure that you delete from one file all and only the records you didn’t delete from the
other – thereby partitioning your file into two. You can repeat this exercise to split
the copies again, as many times as you like.

The Split
Tree
Helper
Dialog

Family Historian provides a dialog, called the Split Tree Helper Dialog, to help
with this process. The Split Tree Helper Dialog’s full name is Split Tree Helper:
Delete Unwanted Records. You should only run this dialog when you have already
made the necessary file copies. You can do this using Windows Explorer, or using
Family Historian’s own File > Save As function.
It is very easy using the Split Tree Helper Dialog to delete a large number of
records from a file, or even all of them. So care should obviously be exercised
when using this dialog.
You don’t have to use this dialog as part of a file-splitting process. You can use it at
any time, if you want to delete a large number of records.
For more on the Split Tree Helper Dialog, see the online help.
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This step presupposes that you have...
Read the Introduction and Chapters 1 & 2

You will learn how to...
Work with Named Lists
Work with Record Flags
Use Name Lists with Queries
Use Record Flags with Queries

Preamble Like Queries, Named Lists and Record Flags both also have a useful role to play
within Family Historian. This short chapter briefly describes what they are for, and
how to use them.

What are It is often useful to be able to put together, and keep lists of records. Here are just
Named some lists you might want to keep:
Lists For?  a bookmark list as a shortcut to frequently accessed records














a list of work-in-progress records
a list of possible duplicate records you wish to check
a list of records where Family Historian ordered some aspect of the data, but
you asked it to list the updated records for you to double-check
a To-Do list of records that you plan to work on when you visit record office X
(with notes about what you plan to do)
a list of records you want to delete
a list of records that you wish to edit and have grouped together for ease of
access
a list of records you have selected for a report
a list of records you wish to send to someone
a list of pictures (Multimedia records) waiting to be linked to other records
a list of famous or infamous people
a list of relatives to invite to a reunion
a temporary list to be used in conjunction with queries, to allow you to
effectively create more complex queries than would otherwise be possible

In short, Named Lists can be used in a variety of different ways, and for a variety of
different purposes.

What are
Record
Flags For?

With some issues, you don’t want to keep a list as such – you want to put a little
mark on a person’s record itself. For example, your cousin tells you that he does not
wish to appear in a website you are creating. In that case, rather than adding him to
a list of people who must not appear, a better approach is to set a flag on X’s record
itself to show this. This is, in fact, what the ‘Private’ flag is for.
Here are just a few things that you might want to use a record flag to record:







that a person is a another genealogist
that a person is alive (the ‘Living’ flag)
that a person is a twin (or triplet)
that a person is famous or infamous
that a person is known to you personally
that a person has an occupation that you are keeping track of
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When
Should
You Use
Which?

You may notice that there is some overlap between the list of things that you might
use a Named List for, and the list of things you might use a Record Flag. For many
purposes, it may not matter which you use. You will discover that you can populate
Named Lists based on Record Flags, and you can set Record Flags based on Named
Lists; so it is easy to change your mind at any stage anyway.
In general, you should use Record Flags if you are likely to want the subject matter
to determine the appearance of boxes in diagrams, or text within boxes in diagrams.
For example, if your family contains a number of sailors, and you are interested in
the nautical history of your family, you could set a ‘Sailor’ record flag for each
relative who is a sailor. You could then arrange, say, for a little ‘Ship’ icon to
appear beneath boxes in diagrams where the box owner is a sailor.
For the purpose of excluding a person from reports or generated websites or CDs,
you must use the built-in ‘Privacy’ flag. You can also use the built-in ‘Living’ flag
to restrict how much information is output; or you can use another flag of your own.
But you must use a record flag for this – a Named List won’t do.
Record Flags can only be set on Individual records; whereas Named Lists can
contain lists of records of any type (even a mixture of types if you wish).
Where the issue is not about diagrams or privacy or record type, you should decide
which to use on the basis of which feels most convenient.

Named We will start by looking at Named Lists. Named Lists are kept in the Named List
Lists Pane Pane which is a hideable area on the right hand side of the Records Window.

Bring the Records Window into view now. The Records Window has its own
toolbar, which is only available when the Records Window is active. There are only
3 buttons on this toolbar and they all relate to Named Lists. The first button is the

Named Lists Pane button
. Click on this now, if it’s not already clicked, to
bring the Named List Pane into view. Figure 44 shows an example of what the
Records Window can look like when the Named List pane is visible. In the example
shown, eleven records have been added to the Bookmarks list.).

List Item The Named Lists Pane has 3 panels. The top panel is the complete list of Named
Notes Lists in the current file. The middle panel shows a list of items in the Named List
selected in the top panel. And the bottom panel shows a note, if there is one,
associated with whichever list item is selected in the middle panel (if any).

The partition lines between the Named List pane and the rest of the Records
Window, and between all 3 panels within the Named List pane, can all be moved.
Move your cursor over any of these partition lines and click-and-drag to reposition
them.
Every list can hold records of any type. Every item in every list can have a note
associated with it. This note is not stored in the item’s record. It is associated with
the list, and is deleted when the item is removed from the list.

Add to To add one or more records from the Records Window to a Named List, you simply
Current need to select the list in the topmost panel of the Named Lists Pane, and then select
which record or records you wish to add, and click on the Add To Current List
List
button
. You can add multiple records at a time, if you wish to. To select
multiple records in the Records Window, you can use any of the normal Windows
techniques for multiple selection. For example, you can click-and-drag on an
unused part of the window to ‘lasso’ the records you want with a stretchy box. Or
click on one record, then press-and-hold the Shift key and click on another, to select
all records in a range. Although multiple selection is supported for records
(unindented rows) it is not supported for fields (indented rows) in the Records
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Window.

Figure 44 – The Records Window with the Named List Pane showing. Eleven records have been added to the
Bookmarks List.

New To create a new Named List, click on the New Named List button
Named List the name of the new list.
Find List
Item
Record
Remove
Item From
List
AutoCreate
Named
Lists

and enter

To find a record in the left-hand side of the Records Window, if you are viewing the
record as an item in a list, simply double-click on the list item. The record will be
displayed and selected in its location on the left-hand side. Effectively this means
that you can use any Named List as a bookmark list.
To remove one or more items from a Named List, simply select the items in the
Middle panel of the Named Lists pane, and press the Delete key. When items are
removed from a list in this way, the actual records are not deleted. If the item has a
list item note (the kind that display in the bottom panel) that will be deleted.
Some lists are so convenient that you may want them to be automatically created for
you whenever you open a file, if the file doesn’t already have such a list. You may
always wish to have a Bookmark list, for example, even if empty, so that you can
easily add records to it whenever you want to. You can specify the names of up to 6
auto-create Named Lists in the Preferences Dialog, which is accessible from the
Tools menu.

Add to Although Add To Current List is easy to use and convenient, it is only available to
Named List you in the Records Window. If you want to add records to a Named List from
other windows, you should use the Add to Named List command on the Edit
menu.
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For convenience, you can also add all the selected items in the Selector Dialog used
with reports (see next chapter) to a Named List too. And you can add the result set
produced by a query to a Named List. See next.

Named
Lists and
Queries

Named Lists and Queries are designed to work well together. You can take the
output from any query and add all the records in the result set to a Named List,
using Add Result Set Records to Named List which is located on the Query Menu
(the Query Menu is the menu that drops down when you click on the Query Menu
on the Query Window toolbar). This command is only available when
button
you have run a query and are viewing the result set in the Result Set tab of the
Query Window.
Alternatively, you can do the opposite and remove from a given list, all the records
in a query result set, using the Remove Result Set Records From Named List
command, located on the same menu.
You can also use a Named List as a filter within a query. In the simplest case, you
can simply add to the result set, the records in the list. This could be useful if you
want to display a Named List using the column formatting of a query.
The Named List Members query simply returns all the Individuals who are
members of a Named List that you specify when you run the query. This means that
you can effectively use a Named List in a context where you are only allowed to use
a query. For example, the Split Tree Helper Dialog does not let you specify the
records to delete using a Named List, but you can specify them using a query. But
by using the Named List Members query you can get round this.
It could also happen that you want to create a complex query, but your filtering
requirements are too complex to be implemented using the filtering facilities
provided by a single Family Historian Query. By using Queries and Named Lists
together in multiple steps, you should be able to achieve any kind of filtering,
however complex, and end up with the result set you require. This is an advanced
topic. See the section Sequential vs. Non-Sequential Filtering in Chapter 13 above,
for an example of how this could work.

Differences
between
Queries
and Named
Lists

Although they work well together, Named Lists and Queries are actually very
different. Queries do not store any data (and hence have no overhead associated
with them). They store criteria for retrieving data (and displaying it) when required.
But they do not store the actual data. Named Lists are stored lists of data. Also,
whereas a Query is kept in a separate file and is not part of a Family Historian
(GEDCOM) file, a Named List is stored in your Family Historian file. If you have a
large number of large lists, your Family Historian file may get appreciably bigger,
and possibly also slower to load.
You can reference a Named List using a query, and run that query in files which do
not have the Named List. This is not a problem. For query purposes, it will be
treated as if it were there, but empty.
Another difference between Queries and Named Lists, is that a Query result set only
contains records of one type. But a Named List can store records of any type.

Merge
Named
Lists

There is no command as such for merging Named Lists. Nor is there a command
for extracting the overlap between 2 Named Lists, or for removing the contents of
one Named List from another. But you should be able to achieve all of these tasks,
and other similar tasks, by using List filters in queries. To merge 2 Named Lists, for
example, simply create a query that has 2 List filters and adds records to the Result
Set if they belong to either list. The Result Set can then be saved as a Named List,
using the Add Result Set Records to Named List command on the Query menu.
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Delete To delete a Named List, select the list in the Named Lists Pane and use the Delete
Named List Named List command on the Lists menu. None of the records in the deleted list
will be deleted, but any list item notes for that list will be deleted.

Empty To empty a Named List without deleting it, select the list in the Named Lists Pane
Named List and use the Empty Named List command on the Lists menu. All items will be
removed from the list. None of the actual records will be deleted, but any list item
notes for that list will be deleted.

Delete All
Records in
a Named
List

It may sometimes happen that you want to delete a number of records. Although the
Records Window will let you delete records one at time, it won’t let you delete
multiple records, even though you can select them. The Delete command is greyed
if multiple records are selected.
One way to delete multiple records is to create a list of records you want to delete.
You might call this list “Delete Pending”. You can easily add multiple records to
this list. Then select the list in the Named Lists Pane and click on the Delete All
Records in a Named List command, on the Lists menu. This time, the actual
records will be deleted. You will be required to confirm that you understand that
records will be deleted, when you do this.

List Reports will be covered in Chapter 16. There is a List Report that can be reached
Reports from the Reports menu (under More Reports) that will print out a list of items in a
given Named List, together with any notes associated with any of the items.

Keep Items in a Named List have a fixed order. This is the order that items in the list are
Current displayed in, unless you click on a column heading to re-order them. You can use
List Order the Move Up
and Move Down
buttons on the middle panel of the Named
List Pane to move items around in a list. If you do so, the new order is not
automatically preserved. If you want the displayed order to be preserved as the new
order for the list, you must click on the Keep Current List Order command on the
Lists menu.

Named List As well as a name, each Named List can have a note attached to it (this is in
Properties addition to the note that can be attached to each item in the list). To change either
the name or the note, click on Named List Properties on the Lists menu. List
Notes are printed at the top of List Reports (see above).

If you wish to edit records in a Named List, using ‘low-level editing’ (as in the
Records Window or the All tab of the Properties Dialog), check the Record Editing
Enabled flag.

Record
Flags
Dialog

We will now turn to Record Flags. Key to working with Record Flags is the
Record Flags Dialog which is accessed from the Edit menu (see Figure 45 below).
To open this dialog you must first select one or more Individual records. The dialog
will show you, for all the selected records, which flags they have. It states at the top
how many records are selected. A white box means that none of the selected
records have the flag (e.g. ‘Twin’ and ‘Genealogist’ in the example). A black tick
on a white box means that all of the selected records have the flag (e.g. ‘Private’).
Finally, if some do and some don’t, you will see a dark grey tick on a light grey
background (e.g. ‘Living’ in the example).
If you tick a flag and press OK you set that flag for all the selected records. If you
untick it and press OK you will clear that flag on all selected records.

Create New You can create as many new record flags as you want. To create a new one, simply
Record click on the ‘New’ button in the Record Flags dialog and give the new flag a name.
Flags You can also create a new record flag using ‘low-level editing’ in the Records
Window, by right-clicking on any record that you wish to have the new flag, and
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clicking on Add Flag > New Flag in the dropdown menu that appears. Again, you
have to give the new flag a name.
Once you have created a new flag, it will appear in lists of flags, and you can set it
on other Individual records.

Figure 45
The Record Flags dialog, accessible
from the Edit menu

Delete As we have seen, you can clear a record flag for a particular record, by using the
Record Record Flags dialog. But what if you want to delete an entire record flag?
Flags There is no facility to delete a record flag as such. All you need do is clear the flag
on all records (you can use the Work with Lists and Flags Dialog to do this – see
below). Then if you save that file and re-open it, the record flag will have gone.
When you open a file, the list of Record Flags (e.g. the list displayed in the Record
Flags dialog) becomes the list of flags that have been set in the file (plus the
standard Record Flags – see next). So a record flag effectively becomes deleted by
not being used.

Standard There are only 2 standard record flags: the Private record flag and the Living record
Record flag. These flags are primarily used to protect Individuals privacy when creating
websites, CDs or reports.
Flags
Viewing
Record
Flags

To see which record flags a given record has, you can either use the Record Flags
dialog, or you can expand the record in the Records Window, or the All tab of the
Property Dialog. If any flags have been set, they will be listed in the last field of the
record.

Low-level You can use low-level editing in the Records Window, and in the All tab of the
Editing Property Dialog, to set or clear records. To set a flag, simply click on the record and
select an item from the Add Flag submenu. To clear a flag, simply select the flag
(you will have to expand the Flags label) and click on the Delete key. If you select
the ‘Flags’ label and hit Delete you will delete all flags for that record. A record
with no flags will have no field labelled ‘Flags’.
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Flags and We mentioned earlier that you can set Named Lists based on flags, and vice versa.
Named The limitation on this is that Named Lists can contain records of any type, whereas
flags can only be set on Individual records.
Lists
To move data between Named Lists and Flags, use the Work with Named Lists
and Flags command on the Tools menu. This opens the Work with Lists and
Flags Dialog (see Figure 46 below).
To use this dialog, select the Named List and Flag that you wish to use, and choose
the task you want. Then click Perform Action.
You can use this dialog not just to set flags based on lists, or lists based on flags, but
also to clear all instances of a given flag, and to empty a given list.
Figure 46
The Work with Lists and Flags
Dialog

Flags and You can use flags in queries just as you can use any other field – either as a column,
Queries or as a field whose value you want to test in a filter. You can also take the output
from any query and use it to set or clear a flag on all the records in the result set,
using Set Flag on Result Set Records and Clear Flag on Result Set Records.
These commands are located on the Query Menu (the Query Menu is the menu that

drops down when you click on the Query Menu button
on the Query
Window toolbar). This command is only available when you have run a query and
are viewing the result set in the Result Set tab of the Query Window.

Add
Record
Window
Column

You can set a column in the Records Window to show either Named List
membership, or a flag state. Right-click on any Record Window column heading
and choose Configure Columns from the menu that appears.
If you wish to use Named List membership as the basis for a column, select the list
in the left column and click the
button to add the item as a column.
To add a flag as the basis for a column, select <Other…> in the list on the left and
again click the
button to add the item. In this case, the Add Column Dialog
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will appear. Set Heading to the flag name. To set the Expression field, click on
the << Insert Data Ref button. The Data Reference Assistant Dialog appears.
Expand the ‘Flags’ folder, select the flag you want and click OK. Click Add in the
Add Column Dialog to add the item, and then press OK in the Configure Columns
dialog to confirm.
The same technique can be used to configure columns for Named Lists too (in the
middle panel of the Named Lists Pane).
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This step presupposes that you have...
Read the Introduction and Chapters 1, 2 & 12

You will learn how to...
Work with Reports
Understand the difference between query reports and ordinary reports
Use the Reports Window
Save reports as web pages or word-processor documents
Create custom report types
Work with narrative reports
Use and understand the role of all types of standard reports

Reports
and Query
Reports

Family Historian is installed with 34 standard queries. As we saw in Chapter 12,
each query can be printed as a report. In addition, you can create your own custom
queries, all of which can be printed as reports too. In Query Reports, the data is laid
out in rows and columns, and you get one row for each record returned in the Result
Set.
Query reports are relatively simple. Family Historian has a ‘report engine’ which
can generate much more sophisticated reports in which data is presented in a variety
of complex and interesting layouts. It is these other kinds of report that we will be
looking at in this chapter. However, do not forget about query reports. For some
purposes they may be just what you need.
Henceforth, in this chapter, when we talk about ‘reports’, we shall always mean
these other kinds of reports. When we wish to talk about reports based on queries,
we will always refer to them as ‘query reports’. The two kinds of reports are
handled quite differently in Family Historian.

The Family
Group
Sheet

To illustrate some of the things you can do with Family Historian reports, we shall
open a tutorial file now and look at 2 standard reports. This time we will use the file
“The Munros” (or “The Munros.ged” if your computer shows file suffixes). To
open this file, click on the Help menu within Family Historian. Then click on
“Tutorial Files (referred to in the manual)”, and then “The Munros…”. Confirm
that you wish to open this file.
Steps
1.
2.

3.
4.

Click on Family Group Sheet on the Reports menu.
A dialog appears with the caption “Select Records”. This is the Record
Selector Dialog (see figure 48 below). Like many dialogs in Family Historian,
you can resize it if it is too small, and even maximize it if you wish to. Select
Michael Smith Munro in the list and click on the
button. When you do this
Family records for all of Michael Smith Munro’s marriages (in this case one
only, to Catherine Reardon) are added to the Selection List on the right hand
side. Click OK.
The Reports Window appears and displays the Family Group Sheet for the
Family of Michael Munro and Catherine Reardon – see figure 47 below.
The Reports Window has a grey side panel to the right of the report area, and 2
vertical scrollbars, one of which is just to the left of the side panel, and one
which is on the right hand side of the side panel. Family Historian can display
two pages side-by-side, but it never displays more than one page vertically.
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The leftmost of the two vertical scrollbars allows you to scroll up and down
within the current page (or two pages if you’re showing two). The rightmost
scrollbar also scrolls up and down within the current page, but will scroll across
pages too. Click on this ‘outer’ scrollbar now to browse down through the
entire report.
If you are using the default options for the Family Group Sheet you should see that
there is a picture of the whole family at the top of the report. The topmost section of
the report gives a short summary of the make up of the family. Thereafter there is a
section for each member of the family, starting with the parents. You should see
that to the right of the text, there is a picture displayed of each family member.
Notice that the picture is actually an area from the family picture at the top.
The picture is rather grainy. This is in part because the picture area shown was only
approximately 2” wide in the original photo that was scanned to create the picture
file. If your pictures are sharp (and preferably not too small if you are scanning
them) there is no reason why you should not be able to get them to appear as sharp
and clear as you want in reports.
Source citations are listed at the end of the report. If there were pictures associated
with sources (or even with individual source citations) you would be able to display
those to the right of the text in the source citation listing.

Figure 47 – the Reports Window showing a Family Group Sheet.

The Now look at an example of an Individual Summary Report.
Individual
Steps
Summary
Report 1. Click on Individual Summary Report on the Reports menu (notice that you
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2.
3.

4.

5.

don’t have to close the Reports Window first)
The Record Selector Dialog appears again. Click on the button to add all
records to the Selection List and press OK.
The Reports Window updates itself to display the Individual Summary Report
for all the records you selected. Click on the outer scrollbar to scroll down
through the report. Notice that although there are no pictures for Susan
Dowling and Julia Fish, each of them has a picture of Anthony Munro showing
him as a spouse.
Find the entry for Anthony Edward Munro (using the rightmost scrollbar – or
the arrows to the right of the current page number, at the top of the grey side
panel). His entry illustrates various features of this report. As well as a picture
of Anthony Munro, there is also a sizeable list of Events and Attributes, with
Additional Information about some of the events and attributes. There is a
section for each of his 2 marriages, and a record note about Anthony Munro,
and one each about his marriages. There is also a list of source citations for his
entry.
Now browse down to Michael Smith Munro’s entry. Notice that as well as a
photograph of him, there is also a photograph of his family (qua spouse) with
Catherine Reardon, and a separate photograph of Catherine Reardon as his
spouse. The photographs of individuals show the date of the picture and the
person’s age at the time.

You can, if you wish, use the Munros sample file, or any of the other tutorial files,
as examples to look at when reading the remainder of this chapter.
We will now look in more detail at the various components of the Reports
Window.

The
Record
Selector
Dialog

As we have seen, when you wish to print a report, you choose the report from the
Reports menu. Family Historian then displays the Record Selector Dialog (see
figure 48 below). The only exception to this is the List report which uses a List
Selector Dialog (see figure 49 below). With all reports except the List Report, you
can always display the report for multiple records, not just one.
When the Record Selector Dialog is displayed, you select the records you want and
press the OK button. If you are planning to print a report with a great many
records, you don’t have to select them all now. You might prefer to keep the report
small while you look at it initially, because you may want to make a number of
changes to the layout. You may find it more convenient to do that with a small
number of sample records than with a large number. In fact, you aren’t required to
select any records at all at this stage. You can press OK with no records selected,
and Family Historian will display the Reports Window with a blank page in dark
grey if you wish. This could be useful if, say, you didn’t want to print a report, but
just wanted to browse the options for that report.
When the Reports Window is displayed, you can click on the Records button at
any time (List button if it’s a List Report) to change the records selected for the
report.

Features of
the Record
Selector
Dialog

The right hand side of the Record Selector Dialog lists the records you want to
appear in the report. This is called the Selection List (although it is not labelled as
such). Like the Records Window, the Record Selector Dialog supports multiple
selection. If you click on the
button, all records selected on the left hand side
will be copied to the Selection List. If you click on the button, all the records
listed on the left hand side will be copied. If you click on the
button, all selected
records in the Selection List will be removed from the list; and if you click on the
button it will be emptied.
You can add descendants (and optionally their spouses), ancestors (and optionally
non-ancestral spouses), and spouses of the Individual selected in the left hand side,
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by clicking on the Add Relatives button, and following the instructions. If you
have more complex requirements, such as wanting to add all of a person’s ancestors
to the Selection List, you can do this using a query by clicking on Add Using
Query. More rarely it may be useful to be able to remove from the Selection List,
all records that match a given query. You can do this by clicking on Remove Using
Query.
The left hand side of the Record Selector Dialog normally has 2 tabs: one for
records of the required type, and one for Named Lists. When selecting records for a
Family Report, however, there are 3 tabs: one for Individuals, one for Families, and
one for Named Lists. In this case, if you click
or when an Individual record
is selected, the Family records for each of that individual’s marriages (if any) are
added to the Selection List.
You can use the Named List tab to add items from a Named List (or the entire
Named List) to the Selection List. Although all Named Lists are shown, you will
only be able to add records of the required type for the report. You will be warned
if none of the selected records are of the required type.

Figure 48 – the Record Selector Dialog

Add to You can preserve the contents of a Selection List as a Named List if you wish to by
Named List clicking on the Add All to Named List command, which appears when you click
in the top right corner of the dialog.
on the Menu toolbar button
Alternatively, you call use Add Selection to Named List.

The When you press OK on the Record Selector Dialog, the Reports Window opens
Reports and displays the report you have selected.
Window The Reports Window is the 5th and last of Family Historian’s MDI Child
Window.28 The other four were the Records Window, the Diagram Window, the
Multimedia Window and the Query Window.
In most genealogy applications, when you are viewing a report in a preview
28

If you don’t know what an MDI Child Window is, see the section “MDI Child Window”: a windowwithin-a-window in Chapter 2.
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window, there is very little you can do, apart from printing the report, without first
closing the window in which you are viewing it. That is not the case with Family
Historian. You can do whatever you like while viewing a report in the Reports
Window. You can open up a diagram, or run a query, or even open another report
in another window29 – all without closing the window you are now looking at.
As usual, to switch between MDI Child windows, you just need to click on their
Navigation Bar icon. The Navigation Bar icon for the Reports Window is shown on
the left.
Tip: To view the Online Help for the Reports Window, press the F1 key when
viewing the Reports Window. You can do this will all Family Historian windows,
not just the Reports Window.

The
Reports
Window
Side Panel

On the right hand side of the Reports Window, there is a grey Side Panel with a
number of buttons on it. The exact number of buttons displayed varies depending
on the size of the window (if you resize the window you will find that some appear
or disappear as the window changes size). If you use a small screen resolution on
your computer, you may not see all of the buttons that it can show even when your
window is full size. However, that does not matter. The same commands are all
also available from either the Reports menu or (in the case of the Print and Print
Setup commands) from the File menu.
The current page (or pages if you are showing two) is shown at the top of the Side
Panel, as well as the total number of pages in the report. To the right of the current
page are two small buttons
for stepping forwards and backwards through
pages of the report – useful if you want to jump from one page to the next without
having to scroll up and down.
Just below the page information is a list where you can specify the zoom level
(100%, 200%, 50% etc). If you select Page Width (the default), Family Historian
will change the zoom so that you can always see a full page width, whatever the
window size (or two page widths if you are showing 2 pages at once). Likewise,
Whole Page lets you see a whole page at a time.
Check Two Pages if you want to see 2 pages at a time. Odd-numbered pages are
always shown on the right, as this is standard practice in publishing.

The Side
Panel
Buttons

Using the
Mouse
Wheel

The Side Panel buttons are mostly self-explanatory. Zoom In and Zoom Out
behave as you would expect. Copy Page copies the current report page to the
clipboard – you can then paste it into another program such as a word-processor.
Go To Page jumps you to a particular page in the report. Print and Print Setup
behave as you would expect. There is no difference between these button
commands and the Print and Print Setup commands on the File menu.
If your mouse has a wheel, you will find that you can use it with most of the main
Family Historian windows. However, if you use the mouse wheel with the Reports
Window you will find that the wheel does different things depending on where the
arrow is positioned. If the arrow is over the report page you will scroll up and down
within that page. If the arrow is over the outermost scrollbar on the right-hand side,
you will scroll up and down within the whole report - not just within a page, but
across pages. And finally, if the mouse is over the two small buttons
to the
right of the Page field, it will scroll forwards and backwards through the report,
jumping from page to page, but keeping to the same relative position within each
page.

29

To do this, you first need to ‘lock’ the current window, using the Lock Window (prevent reuse)
command. The Lock Window command is described in Chapter 7 in relation to the Diagram
Window. But you can also use it with the Multimedia Window and the Reports Window.

175

Chapter 16 – Reports

Save
Report as
HTML,
Rich Text
Format, or
Text

When you click on the Save Report As button, a dropdown menu appears giving
you the choice of saving the report in the form of a Web Page (in HTML format), a
Word-processor Document (in RTF format), or an ordinary text file. All reports can
be saved in all of these formats.
Rich Text Format (RTF) is a format used by most good word-processors. Microsoft
Word, for example, supports it. By saving a report in Rich Text Format, you can
then open it in MS Word (or another word-processor) and make any further changes
that you want. This is also a useful format to save a report in if you wish to send it
to someone else.
Saving to Text format is rarely likely to be useful, unless you don’t have a wordprocessor that supports Rich Text Format.
When you save a report as either a Web Page or as a Word-processor document,
pictures and their captions are also saved. However, they may not be laid out in the
same way relative to the text as they were in the report.
Pictures are not saved in text format (by definition, text format just contains text).

Styles in
HTML and
Rich Text
Format

Although it is not possible to guarantee that every aspect of a report will be
reproduced perfectly in these various different formats, Family Historian tries to
ensure that the HTML and Rich Text Format versions are as close as possible to the
report that you see. There can however be differences. We have already mentioned
that the positioning of pictures relative to the text can be different in HTML and
Rich Text Format. Also, if the report contains additional graphics of any kind (e.g.
the connecting lines in Ancestor Outline reports or in Descendant Outline reports)
these will not be saved to these formats.
Family Historian uses heading styles and other style-based formatting (see the
Format tab of the Report Options Dialog), and these are incorporated into the
equivalent style formats in both the HTML and RTF formats. What this means is
that if you need to change the look of a Family Historian report, using a wordprocessor or an HTML editor, you should find that it is easy and convenient to do
so.30

Save as
Custom
Report
Type

As well as saving a report as a file, you can also save it as a custom report. This is
the last item on the Save Report As dropdown menu. Any report, including other
custom reports, can be used as your template, and can be saved as a new custom
report type.
Although you can do this with any report, some reports make more flexible
templates than others. The Individual Summary Report and Family Group Sheet are
both reports which make very good templates for other reports. In Create a Custom
Hobby Report below, we will walk through an example of how you might create a
custom report.

The Clicking on the Records button brings up the Record Selector Dialog (see figure
Records 47 above). You can see which records are selected for the report, in which order.
You can change the records selected, and/or their order, at any time.
Button
The List The List button is only available if you are running the List Report. It brings up the
Button List Selector Dialog so that you can select which Named List you wish to see in the
report (see Figure 49 below).

30

If you don’t use HTML editors or word-processors, or you do but don’t make use of the style-based
formatting that they offer, you may not understand what style-based formatting means. Styles are a
very powerful and useful feature of word-processors (and HTML), but beyond the scope of this
document. For more information about them see your word-processor’s documentation or Online Help.
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Figure 49
The List Selector Dialog

The
Options
Button

The Options button brings up the Report Options Dialog (see figure 50 below).
The options available vary considerably between reports. The best source of
information about the options in the Report Options Dialog is the Online Help
(click on the Help button when the Report Options Dialog is displayed), but here
is a brief list of just some of the aspects of reports that you can change using the
Report Options Dialog (not all options are available with all reports):




















The starting page number for the report
Whether each record starts on a new page or not
The information displayed in the headers and the footers
The sections displayed in the report
The actual items of data to be included in each section, and their order (in some
cases)
Whether a heading should appear if the section is empty
The formatting and style aspects of all reports – headings, labels, data etc –
including the fonts used
The gaps to leave before and after headings and around pictures
The text to display if a section is empty
The text used in headings (applies to many headings, but not all)
Whether pictures are displayed, if so how many, what kind and where
Whether pictures have captions and if so, what goes in them
Whether source citations should be listed for data shown, and if so where, and
what parts of the citation data (and source and repository data) should be
included
Whether pictures of sources and source citations should be included, and if so
at what size, and with what captions
The size of page margins required (leave a big margin if you want space to
make notes on a report)
The positions of the invisible columns that Family Historian uses to align items
of data
The size of paragraph indents, and tab widths
Whether to exclude all mention of Individuals with record flag ‘Private’
Whether to only show basic details of Individuals with another flag set
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Figure 50 – The Report Options Dialog. The options available, and even the dialog tabs, vary depending on the
report type.

Records
on this
Page

Back in the Reports Window (see figure 47 above), the Records on this Page list is,
as it says, a list of records displayed in the current page. It doesn’t include every
record that is referred to anywhere in the current page. It only includes records that
have an entry of their own (or part of one) on the current page. The Records on
this Page list is a useful way of getting quick access to the data underlying the
report that you are looking at. Select any record in the list, and click on the
Property Dialog button
on the main toolbar (or just double-click on the item)
to bring up the Property Dialog, to view the record details for the record in
question. If the record is an Individual or Family record, you could equally open a
diagram to view it, or look at its multimedia. As stated earlier, the Reports
Window is like any other Family Historian MDI Child Window in that it does not
constrain you. You do not need to close it while you open other windows.

Reports
are
Dynamic

Just as we saw earlier with diagrams that you can change almost any aspect of a
diagram, or the data underlying a diagram, ‘on the fly’ and it will immediately
update to reflect the change, the same is also true of reports. While viewing a report
in the Reports Window, you can do any of the following and the Reports Window
will immediately update itself to reflect the change:






Change the page layout (margins, portrait/landscape etc).
Change the style and formatting of the report
Change options which determine the content displayed for each record
Change the records selected for the report or the order in which they appear
Change the actual data underlying the report, that it is reporting on (but see
Rebuild Report below)

You use the Report Options Dialog to do the first three. You use the Record
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Selector Dialog (click on the Records button) to change the records selected for the
report. And you use any technique you like to change the actual data underlying the
report.

See What
You Are
Doing as
You Do It

The intention of the Family Historian design for the Reports Window is that you
should be able to see what you are doing as you do it. You can see the implications
of each decision as you make it. A good way of working is to find a good sample
page that illustrates the aspects of the report that you want to change. Then open the
Report Options Dialog and make the changes. By using the Apply button, you can
make small changes, and check the effects of each one as you make them (just move
the Report Options Dialog to one side if it covers the Reports Window so that you
can see what the effect was). This way of working is similar to the way that
diagrams work in Family Historian. It is illustrated below in the section Create a
Custom Hobby Report.

Rebuild The ability to change the data underlying a report, while browsing the report online,
Report is another useful feature. Suppose you notice that a name has been misspelled. In
simple cases, you can simply double-click on the appropriate record in the Records
on this Page list and correct the mistake in the Properties Dialog. If the record in
question does not have an entry on the current page, you may have slightly more
work to do to find the record to change. If necessary switch to other windows by
clicking on their icon in the Navigation Bar. In any case, you find the record and
change it, without closing the Reports Window and losing the context of your
work.

When you make a change to data underlying a report, the Reports Window will
immediately update itself to reflect the change. However, when it does so, for
performance reasons it does not rebuild the entire report. It will simply redisplay
the information for affected records within the area of the report that had previously
been allocated to them. Some changes may mean that a record’s entry now requires
more or less space than it did before. This can mean that gaps appear between this
record entry and the next. It can also mean that one record entry suddenly overlaps
another and you get a mess where 2 sets of text compete for the same space. This is
not an error but a deliberate policy decision. The ability to see changes immediately
reflected in a report is too useful to be dispensed with. But equally, it would take
too long to rebuild every report after every change. The policy adopted is a
compromise.
When you come to print a report, or save it to a file, or copy a page, Family
Historian will not let you do this if the data underlying it has changed, and the report
has not been rebuilt. In this situation, you will be prompted to click on the Rebuild
Report button. When the report is rebuilt, the correct space to allocate to each entry
is recalculated in the light of the new data, and any unwanted gaps between entries,
or overlapping entries, are sorted out.
Of course you don’t have to wait until prompted to do so, to rebuild a report. You
can do this at any time. If you can see that a change has left the report looking a
mess, click on the Rebuild Report button to sort it out immediately.

Create a
Custom
Hobby
Report

We will now walk through an example of how you might create a custom report. In
this example, we will assume you want a report on Individuals’ hobbies. ‘Hobby’ is
not actually a standard attribute. But it was added as a custom attribute to the “The
Munros” sample file. Re-open that file now, if you closed it earlier. To open this
file, click on the Help menu within Family Historian. Then click on “Tutorial Files
(referred to in the manual)”, and then “The Munros”. Confirm that you wish to
open this file.
Steps
1.

Click on Individual Summary Report on the Reports menu. Select Julia
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2.

3.

4.

5.

6.
7.
8.

9.
10.

11.

12.

13.
14.
15.

16.

17.

18.

Munro and click > to add her to the Selection List. Make sure she is the only
item in the Selection List (if there are any others, select them and click on the <
button to remove them). Now click OK.
Click on Save Report As and then Custom Report Type. Enter Custom
Report Name as “Hobbies”. Press OK. Notice that although nothing appears
to have changed, the Reports Window caption now says “Hobbies”.
Click on Whole Page in the list just above the Zoom In button. This isn’t of
course necessary but it may make it easier to see what you are doing. If the text
is too small to be read at this zoom level, you may prefer to switch back to
Page Width, or choose another zoom level.
Click on the Options button to bring up the Report Options Dialog. In the
Contents tab, uncheck all items in the Sections area, except for Individual
Events/Attributes. Click Apply. Notice that most of the information in the
report has disappeared.
In the Individual Events/Attributes area, click on List Only. What had been a
grey list, becomes a white one with “Empty List” showing in light grey text.
Double-click on the list (anywhere in the white area). A dialog comes up with
the caption “Edit List of Individual Events and Attributes”.
Click on the Add Custom Event/Attribute button. Another dialog appears
with the caption “Add Custom Event/Attribute for Individual”.
Click on Attribute as the item type, and enter ‘Hobby’ as the Attribute Name.
Click OK.
The “Edit List of Individual Events and Attributes” dialog should now be
showing Hobby as the sole item in its Selection List. Click OK to close this
dialog.
Click Apply in the Report Options Dialog. All rows of data about Events and
Attributes disappear except data relating to Hobby.
Let us assume that you don’t want any pictures in your Hobby report. Click
now on the Pictures tab in the Report Options Dialog and set all Max Pics
values to 0. Click Apply. The picture of Julia Munro disappears.
Let us assume that we don’t want source information. Click on the Sources tab
and uncheck Show Source Citations. All the other fields on this tab become
greyed.
At this point there is still a heading for “Individual Events and Attributes” in
the report. We don’t want this so click on the Format tab and double-click on
the text “Ind. Events & Attrs” item in the list of headings (the bottom list). A
dialog appears entitled “Heading Details”. Change Hide/Show Headings to
Hide. Press OK.
In the Report Options Dialog, click on Apply. The “Individual Events and
Attributes” heading disappears.
In the Empty Section Text field type “<No hobbies>”. This text will appear for
Individuals who have no hobbies.
Click on the Page Layout tab and uncheck Start Records on New Page. In
our report, there is not likely to be much information for each Individual so we
don’t want to give each of them a whole page.
If we wanted to get rid of the Additional Information about each person’s
hobbies, we could do this by unchecking Inc. Event/Attr Notes and Inc.
Event/Attr Addresses in the Contents tab. But presumably we do want this
information, so leave those checked and press the OK button to close the
Report Options Dialog.
Now, to test our report, click on the Records button and select all the records in
the file. Browse through the report and confirm that Julia Munro is the only
one who has any hobbies listed.
Finally close the Reports Window (click on the Close button). Click on the
Reports menu and confirm that Hobbies is now listed under Custom Reports
and behaves as you would expect when you click on it.

The custom report we created is actually a relatively simple one. You can create
more complex custom reports by adding custom fields using Data References. The
Main Section Items area of the Contents tab for the Individual Summary Report,
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allows you to do this, for example. See the Online Help for more details.

Troubleshooting
Layout
Issues

Family Historian reports can be printed on any paper size that your printer supports,
portrait or landscape. So what happens, if you choose to print on very small paper
(A5 say), and there simply isn’t room for the information to print? The answer is
that it won’t get printed (or displayed). In such a situation, you can adjust the layout
so that the report will print nicely; but it is up to you to do it. Family Historian will
not automatically reposition everything for you. If you want to print a report on
small paper, you should think seriously about adjusting any or all of the following:






the font size for all of the text, including fonts for headers and footers
the margin sizes
the column indents, paragraph indents and tab width
the size of pictures
the gaps around pictures

It can happen, even on standard page sizes, like A4, that some text does not get
printed because there is no room for it. Here’s an example of how this can occur:
Sometimes within reports Family Historian will display items of data lined up in
columns. For example, with events and attributes in the Individual Summary
Report, the event/attribute labels always line up, and so too do the event/attribute
dates (2nd column) and places (3rd column). You can control how much room is left
for each of the label, date and place, by adjusting the Column Indent values on the
Page Layout tab of the Report Options Dialog. Now suppose that your paper is
setup to print on A4 in portrait mode. That means the paper size is 210mm wide
(slightly less than 8.5”). If side margins are 0.5” each, that leaves 7.5” of usable
space. Column Indents are measured from the start of the usable area. Suppose the
3rd indent was set at 5” and you had a picture that was 2” wide displaying to its
right. Allowing for gaps round pictures, (0.15” on either side by default) you would
only have 0.2” to display the place information.
In a situation like that, Family Historian will print as many characters as it can (if
any) squeezed into the line – not many in this case. It will not ‘wrap’ the text onto
further lines, because if it did, it would produce a very large column of data
containing only a couple of characters per line.
The solution to this problem is to adjust the column indents or the picture size or
both. If need be, you might also adjust the font size.
Sometimes in a report, it may not always be obvious whether the layout is based on
column indent (and if so, which one) or on page indent or tab width. The best
solution in this case is simply to experiment by adjusting the values and see what
moves. Remember you can always reset all values back to their installation
defaults, by clicking on the Installation Settings button, so it does no harm to
experiment.
One common requirement is to print a report with a very wide margin, to leave
room to make notes. If you do this, check whether you need to adjust column
indents and other values, to leave room for the data. If you find some report settings
that you want sometimes, but not always, you might like to consider saving what
you’ve done as a custom report, so that you can reuse it whenever you want to
without having to repeat the process of adjusting the data layout.

List of The following is a complete list of standard reports, and a brief description of each
Standard one:
Reports Ancestor Outline (Outline Reports)
Ancestors in an outline format.
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Ancestors By Generation (Narrative Reports)
Ancestors in a narrative (story format) report.
Data – Groups, Castes (Special Data Reports)
Shows all the values for the ‘Group/Caste Membership’ attribute in the file, and the
number of instances of each.
Data – Occupations (Special Data Reports)
Shows all the values for the ‘Occupation’ attribute in the file, and the number of
instances of each.
Data – Origins (Special Data Reports)
Shows all the values for the ‘National or Tribal Origins’ attribute in the file, and the
number of instances of each.
Data – Places (Special Data Reports)
Shows all the places mentioned in the file, and the number of instances of each.
Data – Religions (Special Data Reports)
Shows all the values for the ‘Religion’ attribute in the file, and the number of
instances of each.
Data – Source Types (Special Data Reports)
Shows all the different types of Source Records (i.e. the different values for the
Type field on Source records), and the number of instances of each.
Descendant Outline (Outline Reports)
Descendants in an outline format.
Descendants By Generation (Narrative Reports)
Descendants in a narrative report.
Family Group Sheet (for Web or CD) (Miscellaneous Reports)
A variant on the Family Group Sheet, intended to be of use when creating websites
or family tree CDs.
Family Group Sheet
Standard report on families.
Individual Census Report (Miscellaneous Reports)
Report on census data recorded about Individuals.
Individual Narrative Report (Narrative Reports)
Individuals in a narrative report.
Individual Record Notes (Miscellaneous Reports)
Report on notes about Individuals.
Individual Summary Report (for Web or CD) (Miscellaneous Reports)
A variant on the Individual Summary Report, intended to be of use when creating
websites or family tree CDs.
Individual Summary Report
Standard report on Individuals.
LDS Ordinances (Miscellaneous Reports)
A report on LDS Church ordinances associated with Individuals. The LDS Church
is the Church of Jesus Christ of Latter-Day Saints.
List Report (Miscellaneous Reports)
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List of records in a Named List, and any notes associated with list members, or with
the list itself.
Record Details – Families (Record Details Reports)
A complete listing of all fields in Family records.
Record Details – Individuals (Record Details Reports)
A complete listing of all fields in Individual records.
Record Details – Multimedia (Record Details Reports)
A complete listing of all fields in Multimedia records.
Record Details – Notes (Record Details Reports)
A complete listing of all fields in Note records.
Record Details – Repositories (Record Details Reports)
A complete listing of all fields in Repository records.
Record Details – Sources (Record Details Reports)
A complete listing of all fields in Source records.
Record Details – Submission (Record Details Reports)
A complete listing of all fields in Submission records.
Record Details – Submitters (Record Details Reports)
A complete listing of all fields in Submitter records.
Source Summary Report (Miscellaneous Reports)
Report on sources used in the current file.

Narrative We will conclude this chapter by looking briefly at narrative reports in general, and
Reports the Descendants by Generation report in particular.
Narrative reports are reports which use ordinary English sentences to provide
information about people - as if telling a story. Family Historian has 3 narrative
reports:




Descendants by Generation
Ancestors by Generation
Individual Narrative

Sentence The sentences used are generated by Family Historian from the basic information
Templates provided about each person. You can see what kind of sentence Family Historian

will generate for any given event or attribute by looking at the Events tab of the
Property Dialog. At the bottom of the dialog is a Sentence box in which Family
Historian displays the sentence (or something very close to it) that will be generated
in a narrative report, for the currently selected event or attribute.
In order to generate these sentences Family Historian uses a sentence template for
each different type of event or attribute (whether standard or custom). You can
modify the contents of these sentence templates. To do so, click on Work with
Fact Sets on the Tools menu. This opens the Event/Attribute List Dialog. Select
the fact type (event or attribute) you wish to modify and click on the Properties
button which in turn opens the Fact Definition Dialog. Click on the Help button to
learn how to modify the sentence template to get the results you want.
As well as modifying sentence templates for an entire fact type, you can also modify
them for any given instance of a fact type (that is, any given event or attribute) by
clicking in the Sentence field in the Events tab of the Property Dialog, and making
whatever changes you require. Press the F1 key while viewing the Events tab of
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the Property Dialog to view Online Help for this tab, including help with the
Sentence field, and how to modify it.

The Descendants by
Generation
Report

Pick any individual in a Tutorial file, or in your own data file, and open the
Descendants by Generation report now to try it out. You will find that you can
control (from the Report Options dialog) the number of generations displayed, and
other aspects of the report. Click on the Help button within the Report Options
dialog to see Online Help about what these various options are for.
The first person in the Descendants by Generation report is listed as number 1. All
of their descendants are also given a number, in sequence. Their first child is
numbered 2, the next 3, and so on.
You will notice that where you can see a list of a person’s children, some of the
children will have a ‘+’ before their descendant number. E.g.
+22

John Smith (1882-1949)

The ‘+’ means that more information is provided about this person somewhere else
in the report (usually in the next generation, below). It means that the person has a
section of their own, devoted to them.
If a person does not have a section of their own, there will be no ‘+’ before their
descendant number; and such information as is held about them (typically not much)
is displayed after their name in the list itself, in italics.
Within the Main section of Report Options, the One Section Per Descendant
field is checked by default. If you uncheck this field, Family Historian will not
automatically give each descendant their own section. Instead it will use the
following rules for determining whether a descendant gets a section of their own or
not:
If the person is in the last generation of the report (e.g. you asked for 6 generations,
and this is the 6th generation), they will not get a section of their own. Otherwise,
they get a section of their own if they have one or more spouse families (i.e. either a
spouse, or children, or both), or if they have 5 events or attributes or more, or if they
have a picture that would display given the current options for this report, or if they
have a record note that would display given the current options for this report.
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This step presupposes that you have...
Read the Introduction and Chapters 1, 2 and 3

You will learn how to...
Create a website
Create a family tree CD
Do an Internet Search
Use Auto-save
Backup and Restore
Troubleshoot problems

Preamble This final chapter deals with sundry topics that do not conveniently fit into any of
the previous chapters.

Create You can easily create a website using your family tree data. The Create Website
Website Wizard walks you through the whole process in 8 simple steps. To start the wizard,
click on Create a Website on the Internet menu. When you finish, Family
Historian will have created all the files for your website in a folder that you specify.
At each step of the wizard click on the Help button for detailed context-sensitive
help explaining what the options mean and what you need to do. Once the website
files have been created, you can click on a button entitled “Learn How to Put Your
Website on the Internet”.

Create
Family
Tree CD

Creating a CD is just as easy – and indeed is very similar. The Create CD Wizard
is largely the same as the Create Website Wizard. To start it, click on Make a
Family History CD on the File menu. The Create CD Wizard creates all the files
you need for your family tree CD. To burn these files onto a CD you will need a
CD writer and CD burning software, neither of which are included with Family
Historian. CD burning software is likely to come with your CD writer though; and
if it doesn’t, Windows XP has CD burning capability built into it.
As with the Create Website Wizard, click on Help at each step for detailed help as
you go along.
The reason that creating a family tree CD is so similar to creating a website, is that
the same technologies will be used in each case. If you give someone a copy of
your family tree CD, they will use their web-browser to view it, and to explore the
CD.
Their web-browser should start automatically when they put the CD into their CD
drive; but if that isn’t working for some reason, tell them to click on their Start
button, and then click on Run to open the ‘Run’ dialog. They should type “D:\start”
into the Open field and press OK. If their CD drive is not drive D: they should
substitute the correct drive letter.

Internet To start the Internet Search tool, click on Search the Internet on the Internet
Search menu. You will need access to the Internet.
There are a huge number of websites round the world with databases that you can
search, containing important genealogical data. The list shown here does not
attempt to be comprehensive. It is a highly selective list of just some important
research sites. With each site, click on its entry in the list to see a brief description
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of what it offers, in a box below the list.
With some sites, you can type name details (and possibly a start and end year) into
the Internet Search dialog, and click Search Now to start the search from within
Family Historian. Click on Only show sites that can be searched from here to
filter out sites that cannot be searched in this way.
With all sites, click on Go To Site to direct your browser to the site.

Auto-Save It was mentioned very briefly in Chapter 1, but in case you missed it – Family
Historian has an auto-save facility. You can get it to automatically save changes
every few minutes if you wish. This is set in Preferences (see the Tools menu).

Backup It has also been mentioned before, but remembering to backup your data is very
and important. You can backup a Family Historian data file using the Backup
command on the File menu. You will also be prompted to backup your file at the
Restore end of every session (unless you opt not to be prompted). Some people back up at
the end of every session into another folder on the same hard disk. This isn’t
necessarily a bad idea. It’s easy to do, so you’re more likely to do it. And after all,
one of the best reasons to backup is to protect you against your own errors. And
having backup copies of your file on the same hard disk should help with that. But
remember that hard disks can fail too, and it’s not an uncommon thing to happen! If
yours does fail, all backup files on the same hard disk will be lost along with
everything else. And you won’t get any warning that it’s about to happen. So
whether or not you do some backups onto the same hard disk, you should definitely
also do other backups onto some other medium – such as a CD.
Think about what the implications would be if your hard disk suddenly failed now.
If you could live with losing a week’s work, you can presumably afford to backup
onto another medium only once a week. If you couldn’t face losing even a day’s
work (perhaps because the data came from an interview which you won’t be able to
repeat) backup onto another medium at the end of each day. If your genealogy
research is your life’s work and really precious, think about giving a copy to a
trusted friend to keep in case you’re burgled or the house burns down. You never
need to lose data if you’re careful.
You should have a policy on backing up, and you should back up regularly. And at
least some of those regular backups should be onto a completely different medium
so that if your hard disk fails, they aren’t lost too. When you backup onto another
medium, such as a CD, be sure to label the CD (or other item) carefully, and have a
place where you keep them, so they don’t get lost.
To restore from a backup, use the Restore command on the File menu within
Family Historian.
Note: The Backup command only backs up your family tree data file (the GEDCOM
file). It does not backup any linked multimedia, or saved charts. If you want these
to be backed up too, you cannot use Family Historian for this.

Trouble- If Family Historian does not appear to be working correctly, the two most likely
shooting explanations are that there is something wrong with your family tree data file (that
is, your GEDCOM file) or there is something wrong with your installation.

Family Historian should never cause any data corruption in your GEDCOM file; but
it is possible that corruption could have arisen if the file (or part of it) was created
by another genealogy application. In any case, the first thing to do is to run the
Validate command on the File menu. This can not only detect whether or not the
GEDCOM file is corrupt, it can often automatically fix the problem. It will produce
a report when it does this and you should keep a copy of this report if it has fixed
corrupt data; because any such corrections will usually involve simply removing the
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bad data. If a bad link (e.g. a corrupt father-son link) has been removed you will
probably want to reinstate it with a valid one. But it will be up to you to do that
from within the program. Family Historian will not do that automatically. You
need to keep the report, so that you know which links to reinstate.
If there is something wrong with your installation, you should uninstall and reinstall.
To uninstall, run Add/Remove Programs on the Control Panel. You can access
the Control Panel from your Start menu. Within Add/Remove Programs select
Family Historian and uninstall it.
When you reinstall it, re-apply your original method of installation. Remember to
reapply any upgrades.
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Appendix A – The Relatives of Cameron
Peabody
Cameron Peabody was born on Jan 3rd, 1901, in Sevenoaks, England. He had 2 wives during the
course of his life. His first wife was Sarah Marie Watts (b. 12 th December, 1907, in Durban, South
Africa). They married on July 4th, 1926 in Cape Town, South Africa. They had 2 children, Amanda
and Ian. Sarah died in 1935.
Cameron later married his cousin, Jean Clare Anderson (b. June 1917). Together they had a son,
Daniel Anderson Peabody (surname, ‘Peabody’).
Cameron’s parents were Philip Peabody and Naomi Prentice Salt (the surname being ‘Prentice Salt’).
They married in 1897. Cameron had an older sister, Mary, born on 14th February, 1898. Philip’s father
was Richard Peabody.
Cameron’s mother, Naomi was the daughter of Norman Prentice Salt. Naomi’s mother’s name was
Eliza. Her surname is not known. Naomi had a younger sister, Sally. Sally was the mother of Jean
Clare Anderson.
Cameron also had a half-brother, Nigel Peabody, through an earlier marriage of his father. Nothing is
known about his father’s first wife.
Cameron’s son, Ian did not marry, but has a life-long partner, Fiona Andrews, with whom he had one
child, Thomas Peabody. Cameron’s daughter, Amanda, had a son – Adam Wiley.
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